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 11Introduction

Introduction
Welcome to tonica  fugata! The name tonica exemplifies a German tradition of com-
puter supported chord theory, music theory and composition since 1990.

tonica fugata is able to read, display, play back and print all file formats of previous ver-
sions since version 3.0. MIDI and CapXML files can be read as well.

First things first

In this user guide you will find answers to almost all questions regarding the use of ton-
ica. It is available with identical content as pdf file and as online help system (also see
page 15). But how to find an answer?

This is how you find answers to questions about tonica

1. Search the alphabetical index at the end of this user guide for keywords that re-
late to your question. In the help system you will find it in the tab bar on the In-
dex tab.  We have taken great care to list each problem under a number of differ-
ent keywords.

2. Please do not give up your search if you cannot find a specific keyword. Look for
alternative keywords. You can look for:

• Synonyms, that is other words for the same keyword (e. g. ambitus instead
of voice range),

• Generic terms (e. g. harmony instead of tonic),

• Technical terms/foreign words, e. g. tempo instead of speed or Key instead
of change Major,

• Similar terms,  that is words that do not have the same meaning but that
belong to the same context (e. g. harmony instead of function).

3. If the keyword search is still unsuccessful you should try the content tab in the
help system to find a relevant chapter.

4. You can do a full-text search in the help text. tonica’s help system is organized as
a single file, so you can search the whole text by typing ÁÍ ÍãÍ É+ÁÍFÉ in the help text
window. It must have the keyboard focus, so simply click into it.
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The keyword index is especially helpful when you are looking for a quick answer. When you are not
working under time pressure we strongly recommend that you browse this user guide in order to learn
where to find answers when you need them later.

How to find music examples mentioned in the user guide

This user guide often refers to music examples which are available in tonica as files, e. g.
12-61.tca. You will find these examples as follows:

1. Open the start screen. If you already have files open, you must close them.

2. Click the Tab Examples above the area on the right side of the start screen. This
opens a list of folders and files installed with tonica fugata.

3. Open the folder Example. Here you will find the file mentioned in the text, e. g.
12-61.tca. Open it with a double-click.

What is new in tonica fugata 13

The most important innovation in tonica fugata 13 is that the software is now not only
Windows software but also works on Macintosh computers with the Apple macOS op-
erating system. This also involves a reimplementation of user interface and note display
which meets every need (see page 17).

Start screen

When starting tonica a friendly start screen welcomes you with...

• Information and news: You will see at once when there is something new and
have direct access to our website and several service offers.

• Open file: You select between existing files (including preview) or new score.

• In Templates you will find provided templates for common instrumentations as
well as those you create yourself over time.

• The  Examples  are particularly relevant when you are a  tonica beginner. Here
there also is a preview.

Updated note display and note entry

Note display and note entry have been adapted to capella with the following advan-
tages:

• Modern, ready to print note display

• Any number of staves, up to two voices per staff, adjustable via the SystemTem-
plate
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• Note entry options analogous to capella with some restrictions (see page 48)

• Improved rhythmic playing in analogous to capella

• Easy exchange of notes between tonica and capella via clipboard

Enhanced composition and analysis algorithms
In previous versions tonica was restricted to four voices. With the updated note dis-
played algorithms have been extended as well to more than four voices. Now you can
compose for example an eight-part score, a five-part fugue or a canon with six voices.

Sound fonts
You can now select the playback sound independent of your sound card.  tonica sup-
ports loading of sound libraries in sf2 format which are provided partially free of charge
on the Internet. Also see page 131.

Contextual presentation of composition assistant

• Composition  and  analysis  preferences are  displayed  depending  on  the  se-
lected function and can be changed directly.

• Input and evaluation of harmonies is also directly possible here.

System template

Like in capella the score structure can be established in the SystemTemplate. Changes in
the structure are immediately reflected in the score.

A word about copyright

During the last years the trend to complement classic desktop software such as tonica
by less  complex,  easily  available offers  and apps has been reinforced.  The fact  that
these apps are often offered at a rather low price frequently involves a drop in prices
which in many cases does not meet the accomplishment of the program authors. This is
especially valid for complex programs such as clever software around music notation.
Thus many years of development work were invested into the fundamentally revised
version tonica fugata 13.

capella-software always tried to offer their authors‘ products at prices that are afford-
able for non-professional musicians as well as acknowledge the authors‘ achievements.
We intend to continue this pricing policy in the years to come. By loading a trial version
you have the option to try out tonica with full functionality for a limited period of time.
We ask you not to pass on your personal license number. This will enable us to continue
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research and development of tonica and to maintain our affordable pricing policy in the
future. Thank you!

System requirements

In order to use tonica fugata 13 in the Windows world you need Windows 10, 8.1 or 7.
In the Macintosh world it‘s a Mac with macOS 10.10 (Yosemite, 2014) or younger.

Install, update, uninstall

New installation

When you have to reinstall tonica, for example because you have a new computer, your
license will remain valid. Please make sure you have your serial number at hand.

Installation from DVD: Proceed as with first installation. If needed, read the installation
instructions which you received together with the DVD. We recommend that you up-
date the software directly after installation, see below.

Installation via Download: Load tonica  fugata from our website. Pay attention to the
version number: It has to fit your serial number. Should your version be outdated and
you do not find it for download on our website, please contact the capella-software
customer service. We will provide you with the installation package for software which
is not too old.

During installation a warning message appears which you have to confirm to continue.
You have the option to decide about the program directory into which tonica will be in-
stalled.

For network administrators: To install tonica in an automated process (without installer surface) see
page 138.

Update tonica

In today‘s software world it is common to make bug fixes and program updates avail-
able via the Internet. tonica provides an automated procedure.

How to update tonica automatically

1. Select HELP → ONLINE UPDATE...

2. In the dialog box select an update interval (daily, weekly, monthly, never).

3. If you wish, press the button Search now.
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4. Close the dialog box with OK.

You can also use tonica on a computer without Internet connection. In this case, auto-
matic updates and more services will not be available.

Deinstallation

Simply drag the app icon from the program folder to the trash.

Demo version

In the demo version you cannot save or print files. The export functions are blocked.
Composition and analysis is limited to four measures.

The help system

tonica can be largely used without user guide. However, maybe you need to look up
musical terms, keyboard commands or the multiple playback options every once in a
while. The help system offers three different access options:

Via HELP → CONTENT you start the help system with open table of contents.  You find it in
the tab bar in the tab Contents.

The alphabetical keyword search can be found in the Index tab. Via HELP → KEYWORD SEARCH

you can directly access it from the program‘s main menu. When you select an index en-
try (or click on a cross-reference) you will always get to a (blue) heading. The search
term can be found in the text range between this and the next blue heading. When you
are searching a less common term in the index, you may find only a synonym or generic
term in the text range, e. g. „harmony“ instead of „tonic“.

Via HELP → PDF USER GUIDE you open the user guide which contains the same information
as the help system but can be printed as well.

When tonica is new for you

You will have the best start working through the second chapter (see page  29). Here
you will be introduced to the most important elements and features of tonica while ex-
ecuting a specific task.

More training assistance can be found on our website.
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Important terms

D7 – T or V7 – I or C7 – F?
Several  methods  of  describing chords  are  built  into  tonica fugata.  Function  Theory
which is primarily used in Germany, Roman Numeral method primarily used in Great
Britain and Chord Theory.  Should you want to compose in Jazz style we recommend
that you make tonica fugata display the harmonies in Jazz notation according to Berke-
ley standard.

This  user guide also includes a basic chapter about figured bass notation (see page
139).

The structure of a tonica score

With the following terms we describe the basic structure of a tonica score (this is what
we call documents written with tonica):

• A  score  consists of one or more systems which are automatically allocated to
pages. Each score has one key and one time signature.

• A system consists of one or more staves.

• A staff consists of one or two independent voices. Each staff has one clef which is
valid for all systems of the score.

• A voice is a compilation of note objects (notes, rests, fixed barlines). Each voice
has at most one note at a time (no chords).

• The harmony staff below each system consists of a sequence of harmonies (i. e.
harmony symbols in a certain chord notation, e. g. numerals in Roman numeral
notation) with a fixed duration.

• Each harmony in the harmony staff refers to a key which may differ from the key
signature of the score. This is called a modulation.

• Each score includes a  title and  page numbers the positioning of which can be
changed.

• For each note or rest a fermata can be added which moves with its note when
the score changes. Fermatas are used to mark important sections of the melody
(so-called phrases).

• Additional notation elements are available: Beams, ties, triplets, various barline
types and voltas.
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General information for working with
the program 

User interface

This  user guide assumes that  you are basically  familiar  with your  operating system.
Therefore  you will  find  little  information about  basic  functions,  e. g.  program start,
opening of a file etc. in here.

Your personal tonica folder

On the  very  first  program  start  tonica will  create  your  personal  tonica folder.  You
should save your own work in this folder.

The personal tonica folder can be found in Windows 10, 8.1 and 7 as well as in OS X in
the „Documents“ folder. It is named „tonica 13“ and contains several subfolders.

Works or preferences from previous program versions (e. g. „tonica 12“) can be trans-
ferred to the new tonica folder.

Please note: The folder already includes some files and folders  (e. g. the folder „networks“). Do not
modify them as they are used and may be adapted by tonica!

Set up tonica for several user accounts

When you log in on your computer with a different user account, another new personal
folder will be created automatically on the first start of tonica.

The start screen

When you start tonica the first thing you will see is the start screen. Here you can start
a new file, open an example, select a template or access information. When clicking
once on a file from the „Recently opened“, „Templates“ or “Examples” list a preview will
be displayed on the right side. Double-clicking opens this file.
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The main window

The main window is divided into two sections. The view depends on which mode you
are working in. There are two modes: Mode Setup and mode Compose. You can switch
between these modes by clicking the buttons at the center of the symbol bar above.

The mode Setup is activated automatically when you open a new empty file or a tem-
plate. Here the main window is composed of the system template on the left and the
score on which you are working. In mode Setup you establish the score structure with
the SystemTemplate and you enter the notes which will be used for your composition
(e. g. a melody in the upper staff/voice).

Switch to mode Compose when you have established the score structure and entered
the notes used for composition. The mode  Compose is activated automatically when
you open an existing score or an example file. Here the main window is composed of
the score and the composition assistant on the right.

The composition assistant provides all composition and analysis functions available in
tonica. In the upper area you select the desired function. The content of the lower area
adapts to the selected function.

The mouse piano with all preferences for note entry is positioned above the score.

At the lower edge of the window you will find the playback bar, at the top edge menu
and toolbar as usual.

Via the View menu you can open further windows in the main window or close existing
ones. We have taken great care to position these windows in a way that supports your
work flow. Please try it out before changing anything.
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1. In score view you see your score in the desired zoom size and generally in Work
mode. The blinking note cursor is positioned in front of the first note.

2. The area on the left shows the SystemTemplate.
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3. The symbol bar contains only the most important standard commands and the
two buttons for switching the mode. All specific commands can be found in the
other areas, see below.

4. All commands for note entry are positioned in the center above the mouse pi-
ano. Here you also enter harmonies in the harmony staff with the duration of
the selected note value.

5. The note editing commands are located on the left edge of the score view.
Here you can also enter modulations (key changes in the harmony staff).

6. The view of the composition assistant in the area on the right changes depend-
ing on the function selected above. If the cursor of the score is located in the
harmony staff, you can enter, change and evaluate harmonies in the right area.

7. The playback bar with slide control for playback position starts and stops play-
back and offers further preference options.

Tool bars

With the help of tool bars you can carry out important commands with one mouse
click. Note entry, SystemTemplate, note editing area and composition assistant have
their own symbol bar.

Tooltips

When you move the mouse over a symbol (don‘t click!) a text appears which explains
the symbol or the alternatively applicable keyboard command. Please pay attention to
these tooltips, they can be very useful.

Menus

For the sake of brevity we always state the menu command in this user guide when sev-
eral methods can be applied. To make things clearer, menu commands are stated in the
form MENU → COMMAND.

Example: „Select HELP → ONLINE UPDATE...“ means: „Open the Help menu and select the en-
try Online Update.

When you find that you often use a menu command, observe the following information
in the menu command to shorten the process:

Symbol to the left of the menu command: You will also find this tool in the tool bar, the
Edit area or playback bar. In future you can execute this command by clicking on the
corresponding symbol.
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When a symbol or menu command looks pale and triggers no action it is not active. As an example, this
can be the case when you need to mark notes before the action can take place.

Text to the right of the menu command: In future you can simply start this action with
the stated keyboard command.

The three dots behind the menu command tell you that this command does not start
an action right away but opens a dialog box where you can provide details (or cancel).

Mouse wheel

When you use a mouse with a wheel between the buttons you can control the vertical
scroll with it.

With pressed  ÁÍ ÍãÍ É key you can change the zoom with the mouse wheel.

Letter key combinations

Letter keys which are not used for note entry have no function (except when entering
text). To facilitate use, some of these idle letter keys – similar to the Shift key – are used
in combination with other keys. In this user guide this is abbreviated with a plus sign
between keys just as combinations with ÁÍ ÍÔÍ É, ÁÍ ÍãÍ É or ÁÍ ÍäÍ É.

Example: „Press down ÁÍZÉ+ÁÍâÉ“ means: „Keep the key ÁÍZÉ pressed down and additionally
press down the key ÁÍâÉ“.

Dialog boxes

Hints. In some dialog boxes you will find additional information. It is hidden behind the
Info symbol. It works like tooltips: Move the mouse over them, don‘t click.

Wherever you are entering  text in dialog boxes,  you can exchange these with other
programs  via  the  clipboard:  Marked  text  ranges  are  copied  to  the  clipboard  with
ÁÍ ÍãÍ É+ÁÍCÉ. With ÁÍ ÍãÍ É+ÁÍVÉ you paste the marking in a text editor by the clipboard content.

Undo command

You can undo and redo commands. Among other things this is useful when tonica has
composed a piece (e. g. a score, a canon or a fugue) and you want to let tonica recom-
pose the piece with different preferences in order to get a different result.

For single commands select UNDO and REDO in the EDIT menu.

When you open the EDIT menu, you will see short descriptions behind the commands
UNDO and REDO.  In an original or just opened or saved score it will read „not possible“.
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The same short descriptions appear in the tooltips of these symbols in the standard
symbol bar.

You can undo or redo several commands with EDIT → EDIT LOG... In one dialog box all pos-
sible commands are listed.

What can be undone? Actions which change the state of a score can be undone (even
when they have been saved before). tonica logs your actions separately for each score.
When you close a score, the protocol is deleted.

What cannot be undone? Actions which do not have an effect on the score.

Examples: You are cutting a marked area (EDIT → CUT). This has two effects: The content
in the clipboard will be replaced by the marking, and the marking will be deleted. As
the clipboard is not part of the score, only the second part of this action can be undone.
The old clipboard content is lost.

View preferences such as zoom or switching to Edit mode have no effect on the score
content, therefore the undo command cannot be applied.

Open a score

You can open digital score files in the tonica format, that is .tca. Furthermore, MIDI files
(.mid) can be read. More about these file types in page 135.

How to open a file

Here you have several options:

(a) Select FILE → OPEN... A standard dialog box to open a file appears..

(b) Mark the desired score in the Finder and drag it with the mouse in the main
window („drag and drop“).

(c) Start tonica by double-clicking the file name in the Finder.

(d) For experts: Start  tonica by handing over the file name as parameter in the
command line.
Example:  open -a  "tonica 13.app" example.tca starts  tonica and
opens the score example.tca.

(e) When you often work with the same file you can create a link, for example to
the desktop. When you double-click the symbol tonica will start and the file
will be opened.
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Save score

Please apply the commands FILE → SAVE and FILE → SAVE AS... which you know from other
software.

Score import and export

capella files (.capx) and MIDI files (.mid) can be imported with FILE → OPEN... and saved
in the current tonica format. In addition you can import individual voices from a capella
file into a tonica score template with FILE → IMPORT.…

In FILE → EXPORT you also have the option to save the file in capella format (.capx), Mu-
sicXML format (.xml) or MIDI format (.mid).

For more information about export see page 135.

Print

After having clicked on FILE → PRINT... the print dialog box appears.

Via the switch panel bottom left you can also create a PDF file as in other software.

Score views

All scores are organized in a tab bar. For each opened score you will see a tab, so you
can easily switch between different scores.

When several scores are open you can click on a score tab with the mouse and drag it
to the score: Depending on the position, the right or bottom part of the window will
show a color. This coloring shows you how the window will be split when you release
the mouse button at this position.

In the split window you can look at both scores next to each other or one below the
other. In each of these windows you can edit a score in different views and any zoom
levels. Also, you can shift the dividing line between the windows and open a third or
fourth one.

When you click on a score tab and shift it to another window the score will move to the
background.
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Zoom

You can select the scale of the screen display in the list box of the symbols list. Instead
of selecting an entry in the list box you can also enter any scale from 10% to 500% in
the text field above.

In the menu, select VIEW → REGULAR SIZE, REDUCE, ENLARGE.

With ÁÍ ÍãÍ É+ÁÍ+É and ÁÍ ÍãÍ É+ÁÍ-É you can quickly change the zoom in 10% steps. This can also
be done with the mouse wheel by clicking the  ÁÍ ÍãÍ É key.

In doing so you are not changing the print size of the notes.

Work mode

Normally tonica will display your score in Work mode (print will be in black unless you
select a different color). In VIEW → WORK MODE you can switch off Work mode. Then you
will see the score exactly as it will be on paper. However:

In Work mode you will see important additional information which is not apparent from
the score display. Therefore it is recommended that you always select Work mode when
editing a score. The following information will be displayed in color:

• Inactive voices: These are displayed in a pale color. This helps to keep the over-
view in staves with two voices.

• Triplets

• Exceeded barlines

• Filling rests

• Tempo setting

System template

With VIEW → SYSTEM TEMPLATE you switch the System template view (see page 61) on or off.
The system template is displayed in the area on the left. We recommend that you al-
ways have the system template displayed, as in there you can see and edit multiple
score properties – for example spacings, names or orchestration. Several sound proper-
ties are selected here. The system template can be displayed in broad or narrow view.
In narrow view not all properties can be reached and edited.

The two columns Function and Ambitus are important for composition, see page 64 and
page 64.
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Cursor-controlled navigation

The cursor can be easily moved with the arrow keys on the keyboard. The effect of the
single cursor keys is similar to those known from word processing programs. If neces-
sary, the displayed screen section is adapted in such a way that the cursor always re-
mains visible.

Cursor navigation in the score

Arrow keys to the right ÁÍêÉ and left ÁÍâÉ move the cursor to the next or previous note ob-
ject of the current voice, the arrow keys down ÁÍûÉ and up  ÁÍôÉ move the cursor to the
next or previous voice. This voice can be located in the same staff or in the same sys-
tem, otherwise the first voice of the following system or the last voice of the previous
system will be headed for. With the ÁÍ ÍãÍ É+ÁÍâÉ and ÁÍ ÍãÍ É+ÁÍêÉ keys you will reach the begin-
ning or the end of the current voice. When the cursor is already positioned at the end
of a voice it will be moved to the beginning of the corresponding voice in the next sys-
tem with the ÁÍêÉ key. In the same way it will move to the end of the corresponding voice
in the previous system when it is positioned at the beginning of a voice and the ÁÍâÉ key
is pressed.

With pressed ÁÍ ÍäÍ É key the cursor will move an entire measure to the right or left, and
up or down in the corresponding voice of the next or previous system. The ÁÍcÍtÍrÍlÉ+ÁÍæÉ
and ÁÍcÍtÍrÍlÉ+ÁÍçÉ keys move it to the beginning or the end of the score.

In an empty staff the cursor cannot be moved to the right unless the staff is filled with
invisible objects. These might, for example, be automatic filling rests. Switch on Work
mode (see above) to make them visible.

The composition assistant

Composition assistant structure

Switch to mode Compose (button in the center of the main symbol bar) to use the com-
position assistant. The composition assistant will be displayed in the right area of the
main window. It is composed of three areas:

• In the toolbar on top all composition and analysis functions available in tonica
are displayed. The icons may be selected and scrolled horizontally. By double-
clicking an icon the corresponding function is executed immediately.

• Below the toolbar there is a fixed area where you can define general prefer-
ences for composing or analyzing and start composition or analysis.
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• Below there is another area which shows preferences depending on the com-
position or analysis function selected above. These preferences will influence
the composition or analysis result. If the cursor of the score is placed in a har-
mony staff, this area will show properties of the harmony in front of which the
cursor is located (see page 48).

How to use the composition assistant

• First enter the notes (e. g. a melody or a subject) that shall be used for compo-
sition or analysis.

• Select the desired function in the toolbar of the composition assistant.

• Check the general preferences (composition section, melody voice, check am-
bitus).

• Push the button Compose or Analyze. Alternatively you can start the composi-
tion or analysis directly by double-clicking the icon in the toolbar.

• Below the general preferences there are many more preferences which influ-
ence the composition or analysis result. If you have selected the composition
function  Score for instance, you can change harmonization style and harmo-
nization rhythm. In some of the sections clicking on ... allows you to change ad-
ditional preferences in a dialog.

• After having changed the preferences you can undo the result with EDIT → UNDO

and again push the button Compose or Analyze.

Playback

For playback the point of orientation is the note cursor (see page  25). Start playback
with a click on the respective icon in the playback bar and the cursor will start to move
in accordance with the playback progress through the score.

Display of temporal position

The slide control in the playback bar always shows the cursor position with regard to
the entire playing time of the score, including all repetitions and repeats. To the right of
the slide control, current position and entire playing time are also displayed numeri-
cally.  You can move the slide control and thus indirectly move the note cursor. This way
you can also follow repetitions.

Determine tempo

You can set the tempo for the active score with DOCUMENT → TEMPO….
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Play back notes

You can play back any number of voices existing in the system template. Set the voice
filter or solo button, see below.

How to play back your notes

1. Make sure that you set the correct tempo for all systems and that you have se-
lected the correct instruments and volumes in the system template.

2. Position the cursor where you want to start playback.

3. Select the voices to be played back:

• When you want to play back only the cursor voice, click on the Solo icon in
the playback bar.

• When you only want to play back selected voices, first select the voice fil-
ter in the playback bar and mark the desired voices (Here you can also des-
elect the cursor voice. However, with the solo button it would still be acti-
vated in this situation, and the other selected voices would be muted.).

4. Then click the play button in the playback bar.

5. End playback by clicking the stop button in the playback bar.

6. Playback will be continued in the following system as long as you do not end it.

Playback options

With EXTRAS → SOUND CONFIGURATION... you can set preferences for playback and if needed
you can load sound fonts.

The capella-tune dialog offers numerous options for playback. For a detailed description
see page 104.

With the button Add/Remove… in the Playback Devices tab you switch to the Internet
to load additional sounds.

No sound during playback?

If you hear nothing there can be different reasons. Even the volume is dependent on
several different preferences. If you hear nothing or the volume is too low please verify
the following:

• the volume setting of your speakers (e. g. volume control on speaker),

• the sound settings of the system,

• individual instrument preferences in the system template (VIEW → SYSTEM TEMPLATE),
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• preferences in capella-tune (see page 104) on the Instruments and Dynamics &
Rhythm tabs.
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Beginning a project
With the aid of a simple project, this chapter makes you familiar with important func-
tions. While working through this chapter in the help menu you can easily switch be-
tween tonica and Help by clicking in the Dock. If your screen is large enough you can
also align tonica and Help next to each other.

Our aim is to compose a score and a fugue on „Happy Birthday“ for string quartet.
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Here you see a system consisting of four staves. All four staves contain only one voice.
More explanations of the terms note, voice, staff and system can be found in chapter
page 16. The melody of „Happy Birthday“ is in the top staff (violin 1). The harmony staff
below the notes shows the harmonies underlying the score.

Select score template

Open tonica with the start screen. There already exists a template for string quartet
which you can select in the Templates tab. Double-click the template String quar-
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tet.tca or select the template and click the button Use score template to open the
template.

Note entry preferences

Before starting to enter our melody we have a look at some preferences.

Please open the TONICA FUGATA menu and select the PREFERENCES... command. The dialog box
will appear. In the section NOTE ENTRY click on COMPUTER KEYBOARD.

In the following we will not torment you with such long descriptions any more. Instead,
we will shorten instructions like this: „Select TONICA FUGATA → PREFERENCES... → NOTE ENTRY“.

• In the section Note values you will find two different keyboard layouts for selec-
tion of the current note value. For this introduction „normal“ should be selected.

• In the section  Notes you can select in the top drop down list which keys you
want to use to enter the pitches. We will work with CDEFGAB.

More note entry preferences (not relevant for this project)  can be found in  KEYBOARD

(MOUSE/MIDI).

For our project we will use note entry with the computer keyboard. We will not use
note entry with the mouse. Please deactivate mouse note entry by clicking the Mouse
note entry icon on the right side of the note entry toolbar if applicable.

If you need more information, use the index at the end of this user guide  (or in the In-
dex tab in the Help system).

Set key and time signature

Before starting with note entry we set key and time signature of the score. For the se-
lected template the desired key C major is predefined. We still need to change the time
signature from 4/4 to 3/4.

Open DOCUMENT → OPTIONS... → TIME SIGNATURE, select „3/4“ as time signature and confirm
with OK.

Enter notes

Make sure that the cursor is positioned behind the time signature in the top staff. If it is
not, simply click on the desired spot.
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Now click on: ÁÍGÉ ÁÍGÉ ÁÍAÉ ÁÍGÉ ÁÍCÉ ÁÍHÉ ÁÍGÉ ÁÍGÉ ÁÍAÉ ÁÍGÉ ÁÍDÉ ÁÍCÉ. Position the cursor at the beginning
again (mouse click or ÁÍæÉ) and start playback via the playback bar at the bottom margin
of the window. You are now hearing the beginning of the melody „Happy Birthday“, but
rhythm and octave positions are wrong.

To correct the first note value, position the cursor in front of this note and click on ÁÍ<É.
With each click on this key the note value shortens. If it is not dotted, it switches to half
the value with dots. If it is dotted, then the dot will be deleted. To change the quarter
note into an eighth you will have to click on ÁÍ<É again. With ÁÍ>É you can extend note val-
ues accordingly. Now try to correct the second note value.

Instead of correcting all note values this way, lets start again: Mark all entered notes by
pressing down the left mouse button to the left of the first note (but to the right of the
time signature) and dragging it  behind the last note.  Now click on  ÁÍëÉ to delete the
marked notes.

The current note value was quarter. To change it to eighth, click on ÁÍ8É. Now type ÁÍGÉ for
the first note. The second note is also an eighth note – therefore type  ÁÍGÉ again. The
next notes are quarter notes. Therefore type ÁÍ4É and then ÁÍAÉ ÁÍGÉ. The fifth note is an oc-
tave higher than the preceding notes. When you keep pressed ÁÍ ÍÔÍ É on the right notes
are entered one octave higher. When you keep pressed ÁÍ ÍÔÍ É on the left notes are en-
tered one octave lower – therefore type right ÁÍ ÍÔÍ É+ÁÍCÉ. The sixth note is a half note in
the original octave – type ÁÍ2É ÁÍBÉ.

Now enter the remaining melody notes as follows (always use right shift): ÁÍ8É ÁÍGÉ ÁÍGÉ ÁÍ4É
ÁÍAÉ ÁÍGÉ ÁÍ ÍÔÍ É+ÁÍDÉ ÁÍ2É ÁÍ ÍÔÍ É+ÁÍCÉ ÁÍ8É ÁÍGÉ ÁÍGÉ ÁÍ4É ÁÍ ÍÔÍ É+ÁÍGÉ ÁÍ ÍÔÍ É+ÁÍEÉ ÁÍ8É ÁÍ ÍÔÍ É+ÁÍCÉ ÁÍ ÍÔÍ É+ÁÍCÉ ÁÍ4É ÁÍBÉ ÁÍAÉ
ÁÍ8É ÁÍ ÍÔÍ É+ÁÍFÉ ÁÍ ÍÔÍ É+ÁÍFÉ ÁÍ4É ÁÍ ÍÔÍ É+ÁÍEÉ ÁÍ ÍÔÍ É+ÁÍCÉ ÁÍ ÍÔÍ É+ÁÍDÉ ÁÍ2É ÁÍ ÍÔÍ É+ÁÍCÉ

Green and red barlines

Now the melody „Happy Birthday“ is notated correctly. But you surely realized that bar-
lines are wrongly positioned. This is because we have not considered the quarter note
upbeat.

Before we start correcting this, another small experiment: Position the cursor in front
ofthe first note and type  ÁÍ8É ÁÍSÍpÍaÍcÍeÉ to enter an eighth rest.  tonica automatically sets
barlines when a measure is filled. However, we are having a problem here: There are
more than four eighths in the measure. Now select VIEW → WORK MODE if it is not yet ac-
tive. In Work mode  tonica does not display the print colors but uses signal colors to
draw your attention to issues otherwise not visible. Now our barline is red. This shows
that the measure is incorrectly filled.
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Delete the wrong eighth rest (for example by positioning the cursor behind and typing
ÁÍ ÍîÍ É). Now the next barline is green!

Upbeat

Instead of inserting rests in the first measure we want to notate an upbeat: Position the
cursor behind the second note. Click on the arrow next to the Barlines icon in the note
editing toolbar and select the first icon in the horizontal bar – a plain barline. Now our
notes look like this:

Now move the cursor with the arrow keys through the whole voice. You will realize that
the cursor stops to the left and right of the first barline but ignores the second barline
while moving. The fixed, black barline is an object (such as notes) which you can for ex-
ample mark and delete. The second green barline is an automatic barline and does not
function as an object does.

For the upbeat change to take effect in all  systems of the score, click the  Reformat
score into systems icon in the note editing toolbar or type ÁÍÊÉ. This will trigger reformat-
ting of the score into systems. The upbeat set in the first system is adopted in all subse-
quent systems.

Set fermatas

After note entry setting fermatas is an important step to mark important sections of the
melody  (so-called  phrases).  tonica  considers  phrasing  information  during  automatic
score composition,  e. g. when adding cadences at phrase ends. You will  generally get
better results when setting fermatas in a sensible way.

The determination of phrases is ambiguous. If phrases are not notated in the melody
there are several alternatives to divide a melody into phrases. One criterion for building
phrases is the measure number – „classical“ melodies are often divided into phrases
which are two or four measures long. Also long notes or rests often indicate phrase
ends. As a rule of thumb: Put fermatas where you usually „take a breath“ when singing
or playing the melody.

In our  melody „Happy Birthday“ we set  two phrases:  One for the beginning of  the
melody (until measure 4) and one for the end (until the end of measure 8). In a slow
tempo one might also divide the melody into four phrases being two measures long,
but we will stick with two phrases in our example.
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Place the cursor before the first note in measure 4 and click the  Fermata icon in the
note editing toolbar. A fermata is set for the note behind the cursor. To delete a fermata
select it and type ÁÍ ÍîÍ É. Now set a fermata for the last note of the melody in measure 8.

Now notation of the melody is complete and we can start composing.

Composing

Before starting with the composition we switch to Compose mode by clicking the Com-
pose button in the main symbol bar. The system template on the left closest, and the
composition assistant appears on the right side.

Bach style score

We first let tonica compose a score for the melody in the J. S. Bach style.

Select the function Score in the toolbar of the composition assistant. Below the toolbar
select „All“ as section to compose and click the  Compose button next to it. It is even
easier with a double-click on the Score icon or by typing ÁÍFÍ5É.
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As as result you get a complete four-part score in Bach style. Play back the result by
clicking the play button in the playback bar.

The colored harmonies in the harmony staff below the systems indicate that tonica has
inserted cadences at both phrase ends. If you hover your mouse over one of these har-
monies, a tooltip appears displaying which composition the cadence is from and which
properties it has. The cadence information will be removed when you continue editing
the score. See page 102 for more information.

Now double-click the score title and change it to „Score "Happy Birthday" in Bach style“.
Place the cursor behind the last note of the melody and select a Final barline from the
Barlines bar  in  the note  editing  toolbar.  Now you have created the music  example
shown at the beginning of this project.

If you want to try other cadences you can check the Select cadences randomly option in
the Compose section of the composition assistant. Repeatedly press the Compose but-
ton. After each click a new score with different cadences is composed.

You will get access to more preferences by clicking on … in the right upper corner of the
Compose section. A dialog will open showing more composition preferences.

Listen to the results and choose the version that suits you best.

Reger style score

One special  feature of tonica is that the program has learned the harmonization of
melodies in various styles from examples of a composer or music epoch. Select the
„Max Reger“ style from the  Harmonization style combo box in the  Compose section.
Note that this also changes the harmonization rhythm below from „Quarter note“ to
„Eighth note“. The harmonization rhythm „Eighth note“ is preset for the Reger style and
creates a much more complex style compared to the Bach style.

Deselect the Select cadences randomly option and click the Compose button. You will
get a Reger style score.

Play back the result. If the tempo is too fast, open DOCUMENT → TEMPO... and set the de-
sired tempo.

Fugue on „Happy Birthday“

In a similar way all tonica composition and analysis functions can be used. If you want
to know more about a specific function, select it in the toolbar of the composition assis-
tant and hover the mouse over the info button right next to the toolbar. Here you get
information about the function and its usage as well as a link to further details in this
help.
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At the end of this project we will  now create an instrumental fugue on the „Happy
Birthday“ melody. The entire melody is a bit too long as fugue subject. We will there-
fore use only its first phrase for the fugue composition.

Place the cursor in front of the first note in the first staff.  Then select the function
Fugue in the composition assistant toolbar. Below select „Current phrase“. This way the
first phrase of the melody is used as a fugue subject.

Reset all changed settings in the Compose section to their default values. The easiest
way to do this is by clicking … in the right upper corner of the Compose section opening
the Compose options dialog. Click Restore Defaults in the dialog and confirm with OK.

In order to get a slightly „denser“ fugue we also want to adjust that the subject inser-
tions in the fugue overlap by one quarter note. In the input field  Subject overlap (in
16th) enter the value of „4“ – four 16th notes correspond to one quarter note. Now click
the Compose button.

After composing the fugue another window is opened showing the temporal structure
of the fugue. Further information is available via the help button in the window. Switch
back to the main window and inspect the composed fugue. Important sections of the
fugue (e. g. Exposition, Developments, Coda) are displayed. Occurrences of the subject
in the fugue are highlighted by color marking of the notes. This information which goes
beyond representation of the notes serves for analysis and orientation in the fugue and
is deleted with the next editing operation.

If you take a closer look at the fugue you will notice that in the voices there are occa-
sional pitches not playable by the corresponding instrument (e. g. the pitch F# in the
second violin is too low). Normally tonica only considers the voice range set in COMPOSE

→ VOICE RANGE... → CANON/FUGUE which can also be adjusted. However, it is easier to con-
sider the voices ranges defined in the system template by checking the „Check ambitus“
option in the upper area of the composition assistant.  Undo the fugue composition
with  EDIT → UNDO: COMPOSE FUGUE. Check the „Check ambitus“ option and click the Com-
pose button again. Now you get a fugue where the voice ranges defined in the system
template are considered for all voices.

Finally double-click the score title and change it to „Fugue on "Happy Birthday"“. The
fugue score is now complete (see the beginning):
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Print or export result

Print the result with FILE → PRINT….

Further editing of the score (e. g. adding dynamics) or creating voice extractions for in-
dividual instruments can be done with capella or with another music notation program.
Export the score with  FILE → EXPORT… and select the capella format (.capx) or the Mu-
sicXML format (.xml) for further processing in other notation programs.
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What next?

Congratulations! After having worked through this short course you are a bit of a score
expert already. Probably you will not have a hard time creating your own compositions
with tonica.

Every once in a while problems might arise which you cannot yet solve yourself. Over
time you will learn more:

To learn what can be done

Questions to the capella-software hotline show us that some users despair of problems
which are in fact dealt with in this user guide. Here are some hints which will surely
help:

• Every once in a while take a look at the index of this user guide. Probably you will
find a solution for your pressing issue.

• When there is a problem, look at the alphabetical index at the end of the user
guide and see if you can find a matching keyword. If you are then directed to an
advanced chapter you might lack some skills described in earlier chapters. For ex-
ample: When you read „Mark the note head and...“ and you do not know how to
mark a note head, then simply go back to the index again (search for „note head,
mark“ or „mark, note head“. In both cases you will find the appropriate suben-
try.).

• Go through the tables with keyboard shortcuts in the appendix to learn how to
execute frequently needed commands.

Making the impossible possible

Many apparently insoluble problems can still be solved while creatively applying ton-
ica’s options. Looking at some examples will make this easier.

On www.capella-software.com/us you will find several application hints. Visit our website from time to
time to find surprising solutions or new ideas.
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Note and harmony entry
In this chapter you will find basic information about simple note entry. You will probably
understand this  and the following chapters  better  after  having worked through the
„ Beginning a project“ chapter (see page 29).

When you want to write a new score you can start with an empty score which contains
a four-part choir template SATB notated in two staves. The upper staff contains the so-
prano and alto voice with treble clef, the lower staff contains the tenor and bass voice
with bass clef. The default time signature is 4/4. In the start screen, select „Open new
empty score“. You can also create it via FILE → NEW → EMPTY SCORE.

Score templates

When you often write scores for the same parts – for your choir, your ensemble –  you
will want to work with templates to facilitate your work.

tonica  comes  with  templates  for  the  most  common instrumentations.  You will  find
them in the Templates tab of the start screen.

Current note value
When you enter a note or rest it will receive the current note value. This is valid as long
as you do not change the current note value.

How to set the current note value

(a) Use  the  number  keys  (do  not  keep  them  pressed  down).  In  TONICA FUGATA →
PREFERENCES → NOTE ENTRY → COMPUTER KEYBOARD one of these two key assignments can
be selected:

Note value 1/1 1/2 1/4 1/8 1/16

normal ÁÍ1É ÁÍ2É ÁÍ4É ÁÍ8É ÁÍ6É

alternative („blind entry“) ÁÍ1É ÁÍ2É ÁÍ3É ÁÍ4É ÁÍ5É

(b) Mouse click in the symbol bar for note entry. If you do not see this symbol bar
you can make it visible in VIEW → NOTE ENTRY.
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Note entry with the keyboard

 If you did not change the note entry preferences (TONICA FUGATA → PREFERENCES → NOTE ENTRY

→ COMPUTER KEYBOARD) you can enter notes with the keys ÁÍCÉ, ÁÍDÉ, ÁÍEÉ, ÁÍFÉ, ÁÍGÉ, ÁÍAÉ, ÁÍBÉ (lower
cases), in treble clef in the middle octave, in alto and tenor clef in the small octave and
in bass clef in the great octave. When keeping the right shift key (ÁÍ ÍÔÍ É) pressed down
you can enter notes in the next octave up, with pressed down left shift key notes in the
next octave down. Make sure that you do not press down the caps lock key (ÁÍ ÍíÍ É)!

In TONICA FUGATA → PREFERENCES → NOTE ENTRY → COMPUTER KEYBOARD you can also select alterna-
tive letter keys for note entry (see page Fehler: Referenz nicht gefunden), for example
German with h instead of b or Romanic with do, re, mi etc. Also you can define that the
keys QWERTYU map the scale.

For notes foreign to the scale and for entering accidentals see  page 45.

Rests are entered with the space key.

You need not worry about ledger lines. tonica will set those automatically.

Note entry with the mouse

In tonica you can click notes into the score with the mouse.

This method is very useful if you have difficulties with note names or if you need to
copy notes being notated in an unusual clef.

Switch mouse entry on and off

To switch mouse entry on or off, click on the Mouse entry mode icon in the Note entry
bar.

Always switch mouse entry mode on when you want to  enter notes with the mouse.
Switch it off when you want to shift the cursor or drag a marking with the mouse.

You can work even faster by using the ÁÍ ÍãÍ É key – as long as you keep it pressed down
you go straight into mouse entry: You can click in notes even with mouse entry mode
switched off, or (the other way round) shift the cursor with mouse entry mode switched
on. This saves a lot of time.

Make sure that the switch to the left of the note entry bar is switched on. If this is not
the case, then „Tinkling mode“ is active, i.e. when you click you will hear the note but it
will not be entered into the score.
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Enter or edit notes

When you move the mouse over the score with mouse entry mode switched on you
will see a blue note head and also a character showing you what will happen when you
click in this position:

A (+) shows that you will add a new note. A small arrow informs you that you can shift
the pitch of the head.

Preselection of note value and accidentals

In the Note entry bar, select the desired note value, dots and accidental before clicking
in a new note. Also see page 39 and page 45.

Dragging pitch

To change the pitch of an existing note head click on this head with the left mouse but-
ton, keep the mouse button pressed down and drag upwards or downwards.

Chromatic dragging: Dragging is done in half step steps,  so the head will obtain differ-
ing accidentals during dragging.

You can specify whether a C sharp or a D flat (enharmonic change) is notated by click-
ing on the icon SPECIFICATIONS and then selecting ALTERATIONS. Also, you can temporarily over-
write this preference by selecting # or b in the Note Entry bar before dragging or by
pressing ÁÍ+É or ÁÍ-É during dragging.

Diatonic dragging: Alternatively you can drag the head in line positions, so it will keep
its accidental. To do so keep the ÁÍ ÍäÍ É key pressed down.

Dragging note heads can also be done (unlike insertion and deletion) with mouse entry
mode switched off.

Accidental for new notes by dragging

When entering new notes you can skip preselection of the desired accidental in the
symbol bar: Instead, keep the mouse button pressed down during clicking of notes and
slightly drag up or down. With this method you will obtain an accidental as described in
the previous section.

Sound feedback during note entry

You determine whether or not you want to get an acoustic feedback during mouse en-
try by clicking on the icon SPECIFICATIONS in the Note entry bar and selecting SOUND. The tick
„mouse click“ is decisive.
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Entry with several voices

In a staff with two voices mouse entry always works in the active voice.

To recognize the active voice, switch on  Work mode (VIEW → WORK MODE).  The active
voice will then be displayed in black, the others (inactive voices) in pale gray.

Entry in filling rest areas

Clicking in notes can also be done in areas with  filling rests (see page  44). Here, the
temporal insertion point will be highlighted by a system-wide shading.

Note entry with the mouse piano 

The mouse piano can be  displayed and hidden by clicking on  SPECIFICATIONS in the Note
entry bar and then switching the tick in MOUSE PIANO. If you also want to operate the Note
entry bar, do so via VIEW → NOTE ENTRY.

With the mouse piano you can enter notes as well as define and read the current note
value.

Notes foreign to the scale. When you enter notes which do not exist in the current key
it is not clear how they are to be notated. A keyboard cannot tell a C sharp from a D flat,
for example. The notation depends on the preferences for note entry (TONICA FUGATA →
PREFERENCES → NOTE ENTRY → KEYBOARD (MOUSE/MIDI)).

In the Note entry symbol bar you see from left to right:

• The switch „Note entry on/off“. When you switch off note entry, you can freely
„tinkle“ on the piano without anything being notated.

• The icons for selection of note values (the current note value is highlighted)

• the dot icon

• the key signature icons for alteration of notes

• a drop-down icon for octave position

• an icon for entry of rests (same effect as the space key)

• an icon for switching filling rests on/off

• on the right: an icon for switching mouse note entry on/off

• Rightmost: The Specifications icon opens more options. In → SOUND... you deter-
mine if you want to listen to the notes during note entry.
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The zebra stripe mode helps to quickly enter notes with the mouse piano. In this mode
all keys are provided with a colored middle section. When you click here, the note is en-
tered in the current value. By clicking above and below you can enter double or half the
note value. This allows you to quickly switch between different note values.

When you move over the mouse piano with the mouse the icon to switch on/off zebra
stripe mode will appear.

You can enter rests by a right mouse click on the mouse piano. In zebra stripe mode you
can therefore enter rests in three different note values. 

When you change the height of the mouse piano, more or fewer piano keys will be-
come visible.

Note entry with the MIDI keyboard

Before you use a MIDI keyboard for note entry you should check preferences in TONICA

FUGATA → PREFERENCES → NOTE ENTRY → MIDI KEYBOARD and EXTRAS → PREFERENCES → SOUND → LISTEN.

Normal note entry (Step entry)

Normal note entry with the keyboard (step entry) is only possible when Note entry is
switched on in the Note entry area.

When you switch it off you can play your keyboard without making changes to your
score.

Rhythmic playing in (real time entry)

You can also enter your music in correct rhythm („real time entry“) without having to
permanently change the current note value.

Before starting real time entry make sure that the keyboard is connected and recog-
nized. To do so, click in the Note entry area on SPECIFICATIONS. In  MIDI keyboard you will
see whether or not a keyboard is connected.

Now place the cursor at the position where your playing in is to be inserted.

With EXTRAS → RHYTHMIC PLAYING IN... you start playing in. The dialog box Rhythmic playing in
opens. Follow the instructions displayed in the Instructions tab. During playing in the
notes will be marked in color. Only when you confirm your note entry with the button
Accept notes, will notes be displayed in black and taken over into the score.
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Latency of sound during rhythmic playing in

When you are rhythmically playing in it helps to get an acoustic feedback without la-
tency.

When you use a keyboard with integrated speaker this is no problem as it will produce
the sound precisely when you press the keys.

When you use a  keyboard without integrated speaker tonica will have to create the
sound. Tick the box  MIDI keyboard (rhythmic)  in  TONICA FUGATA → PREFERENCES → SOUND →
LISTEN.

Shifting the note entry range

The note entry range can be shifted by up to two octaves up or down:

ÁÍFÍ2É one octave lower than the normal note entry range

ÁÍFÍ4É one octave higher than the normal note entry range

ÁÍ ÍÔÍ É+ÁÍFÍ2É two octaves lower than the normal note entry range

ÁÍ ÍÔÍ É+ÁÍFÍ4É two octaves higher than the normal note entry range

ÁÍFÍ3É Normal note entry range

Instead of pressing the function keys you can click on the icons in the drop-down list in
the Note entry symbol bar. The currently valid range will be displayed after the list is
closed.

So in combination with the shift keys up to seven octaves for note entry via computer
keyboard are at your disposal: From ÁÍ ÍÔÍ É+ÁÍFÍ2É and entry with left shift key to ÁÍ ÍÔÍ É+ÁÍFÍ4É
and entry with right shift key.

To avoid too many ledger lines you can also use octave shifting clefs or octave brackets.

Rests

Rests are entered with the space key or with the icon on the Note entry symbol bar.
They will be entered with the current note value.

Filling  rests can  also  be  set  and  deleted  automatically.  They  have  their  own color
(turquoise as default, and can be edited: See page 24), in normal view and print they re-
main invisible. Filling rests are to support you while editing polyphonic scores. They
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make sure that in your score the different voices remain synchronous behind the point
you are working at:

• When inserting notes in a voice,  filling rests  can be inserted in the parallel
voices.

• When inserting notes shorter voices can be topped up with filling rests.

• When deleting, notes can be replaced with filling rests.

• When inserting new voices, filling rests can be allocated to the whole voice.

Filling rests can be automatically deleted, extended, shortened or split when notes or
visible rests are entered in their place. You can turn common invisible rests into filling
rests and vice versa.  Also, you can delete filling rests manually when Work mode is
switched on. Be aware that then the remaining voice will move up from the right so
that another filling rest might take the place of the deleted one.

Cursor movement

The keyboard commands for cursor movement can be found in the appendix.

Simply click on the desired position with the mouse. For staves with two voices it is rec-
ommended to switch on Work mode (VIEW → WORK MODE). In this view inactive voices are
displayed in a pale color.

When mouse entry is active (see page 40), keep the ÁÍ ÍãÍ É key pressed down.

Accidentals

When you enter notes with the keyboard or the mouse these will  be automatically
raised or lowered according to the key signature (alteration). Example: To enter F sharp
in G Major, click on the key  ÁÍFÉ (in standard preference). You need to worry about acci-
dentals only when they deviate from the key signature.

Preselect alteration

With the following keys your notes can be raised or lowered with respect to the key sig-
nature:

ÁÍ+É The next note will be raised by a half step with respect to the key signature.

ÁÍ-É The next note will be lowered by a half step with respect to the key signature.

ÁÍ*É The next note will be raised by two half steps with respect to the key signature.
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ÁÍ_É The next note will be lowered by two half steps with respect to the key signature.

ÁÍ0É Cancels a preselected alteration (also dots).

Alternatively you can click on the accidental in the Note entry symbol bar. Here you can
also see which alteration is preselected for the next note.

The # does not necessarily mean that the next note will obtain a sharp, it only means
that it will be raised by a half step. Example: When you type # and then b you will ob-
tain a b with a natural as you raised the b flat by a half step.

The selection of an alteration is valid for the next note only (If you enter for example
ÁÍ+ÉÁÍGÉÁÍGÉ in C Major, you will obtain a G sharp and a G). Do not keep the keys pressed
down for the alteration.

So raising and lowering of notes correspond to the key signature valid at the cursor po-
sition. If it already has an alteration, this might lead to situations not allowed in music
notation.

Example: When you click on ÁÍ*É and then ÁÍGÉ in G Major, a G double sharp will appear.
However, if you enter ÁÍ*É and ÁÍFÉ, then a „F triple sharp“ will appear. You will recognize it
by the combination of sharp and double sharp. Triple flats may happen as well.

More examples

Key  signa-
ture: F Major

Key signature: G Major

Entry Visible  acci-
dental

Note Visible  acci-
dental

Note

ÁÍFÉ - F - F sharp

ÁÍBÉ - B flat - B

ÁÍ+É ÁÍFÉ [] F sharp [] F double sharp

ÁÍ+É ÁÍBÉ [] B [] B sharp

ÁÍ-É ÁÍFÉ [] F flat [] F

ÁÍ-É ÁÍBÉ [] B double flat [] B flat

ÁÍ*É ÁÍBÉ [] B sharp [] B double sharp

ÁÍ_É ÁÍFÉ [] F double flat [] F flat
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Dotted notes (and rests)

tonica supports only simple punctuations. The following keyboard commands have an
effect only on the next (i. e. the following) note. Do not keep the key pressed down.

ÁÍ.É The next note is dotted. 16ths cannot be dotted.

ÁÍ0É Cancels a preset dotting (also alteration).

The dotting of the next note will be displayed in the Note entry symbol bar.

Clef, key, time signature

In tonica clefs, key and time signature are valid for the entire score – it is not possible to
change them during the piece.

Clef

A clef is valid for all voices of a staff.

To change a clef, open the system template (e. g. by switching to mode Setup). Double-
click the clef of the staff you want to change and select the desired clef.

Octave shifting instruments. When selecting the clef you can set the preferred octave
shifting in the dialog box. This will be indicated by a small figure 8 above or below the
clef.

Key

The key is valid for the entire score. Only in the harmony staff changes of the key in the
form of modulations are possible (see page 58).

To change the key, open  DOCUMENT → OPTIONS... → KEY or click the key icon in the note
editing toolbar.

Automatic  transposition  with  key  change.  In  the  Transposition section  of  the  key
change dialog you can choose whether and how notes shall be transposed to the de-
fined key.

Time signature

The time signature is valid for the entire score.

To change the time signature, open  DOCUMENT → OPTIONS... → TIME SIGNATURE or click the
time signature icon in the note editing toolbar and select the desired time signature.



tonica fugata 1348 

When inserting a 2/2 or 4/2 time signature you can select in the dialog box if this is to
be indicated with the alla breve sign. In 4/4 time signature you can select the  symbol.

tonica automatically sets barlines when the measure is full. For an upbeat (anacrusis)
simply set a fixed barline using the barline icon in the note editing toolbar.

Upbeats are not included with automatic measure numbering.

Note entry restrictions

If you are used to work with capella you will notice that note entry in tonica has some
restrictions compared to capella. Here are the main differences:

• There are at most two voices per staff. The stem directions are defined by the
voice:  For  single-voice  staves  notes  below the center  line  have their  stems
pointing upwards, otherwise they point downwards. For two-voice staves notes
in the upper voice have their stems pointing upwards, notes in the lower voice
have stems pointing downwards.

• All systems in the score are complete, i. e. they contain all staves defined in the
system template.

• There are no manual system breaks. Systems are divided automatically or by
using the Reformat score into systems icon in the note editing toolbar.

• There are no clef, key or time signature changes.

• There is no chord entry,  i. e. each voice has at most one note at a time.

• The longest note value is a dotted whole note, the shortest a 16th note (might
be a triplet).

• Only simple punctuations are supported. It is possible however to notate multi-
ple dotted notes using ties.

• Only triplets are supported as irregular divisions.

Enter Harmonies

Entering harmonies is an important feature in tonica. Normally tonica produces har-
monies on its own when creating a composition (e. g. a score). However, you can also
enter harmonies yourself and have them evaluated or realize chords from them. Har-
monies have different representations, some more powerful than others, which means
that there are harmonies which can be notated in one representation but not in an-
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other representation. See  page  50 for more information about harmony representa-
tions.

Before entering harmonies in a score you should set the harmony representation.

How to set harmony representation for the active score

Select the desired representation (e. g. Roman numeral) from the  DOCUMENT menu for
the active score.

How to insert harmonies

Harmonies are entered and displayed in their own staff without lines (harmony staff)
below each system.

1. Place the cursor at the position in the harmony staff where the harmony is to
start.

2. In the note entry toolbar select the note value with the desired duration of the
harmony and click the Harmony icon to insert a harmony.

3. In the composition assistant on the right side a Harmony section opens for enter-
ing the harmony in the selected harmony representation. Here you can enter the
harmony (e. g. the numeral I for the first degree in Roman numeral representa-
tion). Display of the harmony in the score is automatically adapted.

How to evaluate a harmony

Evaluation of a harmony means to determine which notes are part of the harmony and
in which voices they occur in the score at the time of the harmony.

1. Place the cursor at the position in the harmony staff where the harmony should
be evaluated.

2. Open the Harmony evaluation section in the composition assistant. In a tabular
representation, harmony notes are displayed and their occurrence in the score.
Notes foreign to harmony are displayed below the table.

How to realize a harmony as a chord

Realizing harmonies as chords means distributing the harmony notes in such a way that
a harmonious score is created.

1. At the time of the harmony enter appropriate notes in the voices that are to be
used for chord realization.

2. Evaluate the harmony as described above to check chord realization (e. g. to
avoid notes foreign to harmony).
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Note: tonica is able to realize chords automatically observing common voice-leading
rules (see page 67).

Harmony representations

Harmony representations are built of combinations of letters, numbers and other char-
acters. They are notated in the harmony staff below the system and represent the har-
mony of the chord in question. Harmony representations are an important feature in
tonica.

Harmony representations are entered in the Harmony section of the composition assis-
tant.

Harmony entry depends on the selected representation and includes several input fields. tonica ac-
cepts only valid inputs or corrects them accordingly.

[Harmony representation:Function theory]Function theory

The harmony representation Function theory is mainly used in German-speaking coun-
tries. It has the following input fields:

• Function: The function according to function theory (e. g. dominant D for the
root chord on the fifth degree of given key)

• Added notes: Notes added to the function, sometimes with alterations (e. g.
dominant seventh ninth chord D79> = dominant with added seventh and low-
ered ninth)

• Secondary dominant: Function to which the function in input field „Function“
is referring if this function has a (sub)dominant character (e. g. secondary dom-
inant to a tonic parallel (D)Tp)

• Bass note: Degree of bass note if it differs from the root of the harmony (e. g. 3
for third in the bass)

• Rootless: Determines whether the harmony root will be part of the chord (e. g.
rootless dominant seventh ninth chord \D79> does not contain the root note)

Roman numeral

This harmony representation Roman numeral has the following input fields:

• Numeral: Is composed of three input fields. In the field on the left an optional
alteration of the root can be selected. The field in the middle contains the de-
gree of the harmony root as a roman numeral. In the field on the right an op-
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tional alteration of the harmony third can be selected. Example: VI# means a
major root chord on the sixth degree of given key.

• Added notes: Notes added to the chord, sometimes with alterations (e. g. V7 =
dominant with added seventh)

• Inversion: Denotes the harmony inversion if it differs from root position  (b =
first inversion; c = second inversion; d = third inversion; e = fourth inversion)

• Rootless: Determines whether the harmony root will be part of the chord (e. g.
rootless dominant seventh chord \V7 does not contain the root note)

Chord theory

This  harmony representation  Chord theory is  less  powerful  than function theory.  In
chord theory only harmonies built on roots proper to given key can be represented. It
has the following input fields:

• Degree: Is composed of two input fields. The field on the left includes the de-
gree of the harmony root as a roman numeral – uppercase numeral for major
chord and lowercase numeral for minor chord. In the field on the right an op-
tional alteration of the harmony third can be selected. Example: ii means a mi-
nor root chord on the second degree of given key.

• Added notes: Notes added to the chord or modifying chord position, some-
times with alterations (e. g. ii6 = first inversion of minor chord on second de-
gree)

Jazz

The harmony representation  Jazz is based on Berkeley notation used in Jazz music. It
has the following input fields:

• Root: Root note of harmony, sometimes with alteration (e. g. D# means a D#
major chord)

• Modifications: One  or  two  possible  modifications  to  change  the  harmony
structure. In the field on the left the chord type can be selected. In the field on
the right more chord notes can be added (Example: D#m7(b5) means a minor
seventh chord with lowered fifth and root note D#).

• Bass note: Bass  note  if  it  differs  from the root of  the harmony (e. g.  A/C#
means an A major chord with the third C# in the bass)
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Edit notes and harmonies

Delete and copy notes

In  tonica a staff consists of one or two voices. Each voice is a string of timed objects
(notes, rests). For the sake of simplicity we call all objects that are strung along one
voice note objects.

You can delete note objects with the following commands:

ÁÍ ÍîÍ É Delete single note object (if no range is marked) or marked note objects to
the left of the cursor.

ÁÍëÉ Delete single note object (if no range is marked) or marked note objects to
the right of the cursor.

Block operations

A Block (mark) is an area of the score that is not empty. Blocks can be marked with the
mouse or the computer keyboard. You see a flashing cursor when no block is marked.
tonica distinguishes between different types of blocks. The following commands can be
applied to all blocks:

Delete. All objects included in a block are deleted. To delete a marked block press ÁÍëÉ.

Edit. Depending on the type of block, different editing options are available. They apply
to all or some of the marked objects.

Blocks of note objects or system blocks can be cut/copied/inserted via the clipboard. To
do so apply the common commands CUT, COPY and INSERT in the EDIT menu and the context
menu. The  capella-specific format used in these operations cannot be interpreted by
other standard programs e. g. you can only insert blocks via the clipboard to programs
understanding this format (capella, tonica).

Note: tonica supports fewer notation elements than capella (see  page  48). When copying blocks of
notes from capella to tonica, only notation elements known to tonica are copied. A warning will be
shown if the block includes note values which can not be represented in tonica (e. g. a 32nd note).

Here are the different types of blocks.
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Notes

One or more notes or rests in a voice. The block may contain modifiers.

Marking with the mouse: Drag the mouse across the notes without deviating from the
voice. As usual, do this with pressed left mouse button. This will not be specified from
now on.

Marking with the computer keyboard: Position the cursor in front of the first note.
Keep ÁÍ ÍÔÍ É pressed down and move the cursor with ÁÍêÉ behind the last required note to
extend the marking. Then let go of the shift key.

Copy: You can copy a marked block of notes to the clipboard with the EDIT → COPY menu.

Paste: Any block of notes that has been copied to the clipboard can be inserted into the
score at the current cursor position with EDIT → INSERT menu.

Voice

A voice in a staff.

Marking with the computer keyboard: Position the cursor anywhere in the first staff
and mark it or apply EDIT → MARK → VOICE (ÁÍ ÍÔÍ É+ÁÍ ÍãÍ É+ÁÍDÉ).

Staves

One or more staves in a system.

Marking with the mouse: Drag the mouse over the staves.

Marking with the computer keyboard: Position the cursor anywhere in the first staff
and mark it with EDIT → MARK → VOICE (ÁÍ ÍÔÍ É+ÁÍ ÍãÍ É+ÁÍDÉ). While holding down the shift key,
move the cursor to the last voice of the block.

Entire system template staff

The cursor staff is marked across all systems.

Mark entire system template staff: Position the cursor anywhere in the staff and select
EDIT → MARK → ENTIRE SYSTEM TEMPLATE STAFF (ÁÍ ÍÔÍ É+ÁÍ ÍãÍ É+ÁÍAÉ).

Systems

One or more systems of a score.

Mark a single system: Position the cursor anywhere in the system and select  EDIT →
MARK → SYSTEM (ÁÍ ÍãÍ É+ÁÍDÉ).
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Marking several systems with the mouse: If the entire block that you want to mark is
visible on screen you can drag the mouse across the systems. If the entire block is not
visible, position the cursor at the beginning of the block, make the block end visible
with the scroll bar and while holding down the shift key click into the last system of the
block.

Mark several systems with the Computer keyboard: Position the cursor anywhere in
the first system and while holding down the shift key move the cursor to the last system
of the block.

Mark the entire score: To mark all systems of the score use menu EDIT → MARK → ALL

(ÁÍ ÍãÍ É+ÁÍAÉ).

Copy: A system block can be copied to the clipboard with EDIT → COPY.

Paste: Any system block that has been copied to the clipboard can be inserted into the
score at the current cursor position with menu EDIT → INSERT.

When you want to paste a copied system block to another tonica score you must consider the system
template allocation of the single staves. tonica will try to allocate the staves in the clipboard to those
staves in the target score which have the same „description“. This way you can also insert score sec -
tions with fewer instruments correctly into scores with more instruments. However, if in one of the
scores the same names are given in a different order, for example unnamed2, unnamed1, then this will
result in a changed staff order of the inserted system in the target score. In this situation you can
change the staff descriptions before copying.

System range

A chronologically limited block of note objects all voices/staves deep within a system.
Starting and ending points must be synchronous across all voices in the block.

Marking with the mouse: Press ÁÍ ÍäÍ É and drag the mouse over the staves.

Marking with the computer keyboard: Position the cursor in front of the first note ob-
ject of a voice. Keep ÁÍ ÍÔÍ É pressed down and move the cursor behind the last note ob-
ject of another voice of the system.

System cursor: A system range without any note objects across the entire system (sys-
tem cursor) allowing you to insert modifiers in all voices of the system.

System range

A chronologically limited range across several voices of a system. Starting and ending
points must be synchronous across all voices.

Marking  with  the  mouse:  Drag  the  mouse  from  a  position  to  the  left  of  the  first
note object of a voice to behind the last note object of another voice in the system.
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Note display

Note value

Change. Individual note values can be shortened or lengthened with ÁÍ<É or ÁÍ>É. When a
range was marked the value will be halved or doubled. If the cursor is positioned in
front of a note its value will be modified in smaller steps, alternating between dotted
and non-dotted values.

Beams and flags

Eighths  and  shorter  notes  are  displayed  either  with  a  flag  or  combined  in  [Beam]
beamed groups. Eighth and shorter rests can be integrated in beamed groups. You can
influence beaming as follows:

Local correction: Mark the relevant gaps between notes (the cursor itself marks one
gap!) and select the icon Split beam or Connect beams in the note editing toolbar.

Ties

Ties connect two notes of the same pitch to a unit played back without interruption.

Ties can always be automatically created with the following note.

How to create a tie

1. Position the cursor to the right of the note (or the chord) that will be the first of
the tied notes.

2. If needed select the required value of the tied note.

3.  Press ÁÍ=É. The chord will be repeated and both will be connected with ties.

This action is very fast and efficient, directly inserting ties while writing notes.

Alternatively you can mark the notes to be connected with a tie and select the Set tie
icon in the note editing toolbar. Within the marking ties are set in all places where con-
secutive notes with identical pitch are positioned, even across system breaks.

How to delete a tie: Delete one of the two tied notes. The tie at the other note will be
automatically deleted as long as it is positioned in the same staff.

Alternatively you can mark notes connected with a tie and select the Remove tie icon in
the note editing toolbar.  Within the marking all ties will be deleted, even across system
breaks.
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Ties between two systems. When you split a system between two tied notes, a tie at
the end of the old and a tie at the beginning of the new system will be created.

This  also means:  When a tie coincides with a system break, first  write beyond that
point, then position the cursor between the tied notes and reformat the score into sys-
tems.

Alternatively you can later mark the notes to be connected with a tie in the relevant
voices and then select the ties using the icon in the note editing toolbar.

Ties are considered during playback.

Triplets

tonica supports triplets as irregular divisions.

How to create a triplet

1. Enter the notes as usual.

2. Mark the notes of the group that will form the irregular division.

3. Click the Create triplet icon in the note editing toolbar.

Triplets within triplets are not possible. In Work mode (VIEW → WORK MODE) irregular divisions will be
shown in blue.

Cancelling irregular divisions

To cancel a triplet follow the steps above to create one, and in step 3 select  Delete
triplet in the note editing toolbar. You can also cancel multiple marked triplets this way.

Barlines

Under normal circumstances you do not need to enter barlines, as tonica will set them
automatically according to the selected time signature. You just have to make sure that
you fill all measures correctly: In correct music notation no note value may exceed the
limits of a measure (syncopes exceeding the measure have to be separated into single
notes with ties!).

If the measure is not correctly filled (the last note is too long for the measure)  tonica
shows this with red barlines in Work mode (View → WORK MODE). Correct barlines are dis-
played in green.

There are two exceptions where the automatic barline does not do what you want:
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• A measure is not completely filled (e. g. upbeat or anacrusis).

• A special barline is required (e. g. final barline or repeated barline).

For these two cases tonica provides fixed barlines.

How to enter a fixed barline

1. Position the cursor at the point where you want to insert the barline.

2. Open the Barlines icon in the note editing toolbar.

3. Click on one of the available barlines. The barline will be entered only in those
staves which contain notes or rests at the same position as the cursor.

Tips and tricks

Delete fixed barlines.  Fixed barlines (also special shapes such as final or repeat bar-
lines) can be deleted like notes, for example with ÁÍëÉ or ÁÍ ÍîÍ É.

Voltas

Voltas (repeat boxes) are used to indicate which section of a repetition is played the
first time and the second time.

How to insert voltas

1. Select the section to be played the first time.

2. Click the Repeat sign (prima volta) icon in the note editing toolbar.

3. Repeat steps 1. and 2. for the second time with Repeat sign (secunda volta).

How to delete a volta

1. Select the volta.

2. Delete the volta with ÁÍëÉ or ÁÍ ÍîÍ É.

Fermatas

Fermatas are used to divide a melody into sections (so-called phrases).  It  is  recom-
mended to mark important sections of the melody with fermatas during note entry. The
phrase information will be considered during automatic score composition and gener-
ally yield better results.
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Each fermata refers to a note object. When copying the note object the fermata will be
copied as well.

How to add a fermata to a note object

1. Place the cursor in front of the note object to which the fermata is to be added.

2. Click the Fermata icon in the note editing toolbar.

How to delete a fermata

1. Select the fermata.

2. Delete the fermata with ÁÍëÉ or ÁÍ ÍîÍ É.

Edit harmonies

Harmonies are edited in the  Harmony section of the composition assistant. Here you
can change duration and representation of harmonies.

How to change the duration of harmonies

You can change the duration of a single harmony or of marked harmonies.

1. Place the cursor in front of the harmony or mark the harmonies.

2. Select the desired note value of the harmonies in the Duration input area.

How to change the harmony representation

Change the input values in the Harmony section according to the selected harmony rep-
resentation (see page 50).

Modulations

In general a harmony in the harmony staff refers to the key of the score. Modulations
are used to refer a harmony or a sequence of harmonies to a new key  (which may dif-
fer from the key of the score).

A modulation is indicated by a bold pitch name followed by a colon. The pitch name
stands for a modulation key,  e. g. A: for A major or c: for C minor. All harmonies after
the colon refer to this key.

How to insert or change a modulation key

1. Place the cursor in front of the harmony where the modulation is to be started.
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2. Click the Modulation icon in the note editing toolbar. 

3. A dialog will appear in which you can select the modulation key.

4. Select the desired key and confirm with OK.

How to delete a modulation

1. Place the cursor in front of or behind the modulation in the harmony staff.

2. Delete the modulation with ÁÍëÉ or ÁÍ ÍîÍ É.

Split and merge systems

[Systems:Split] Click the Reformat score into systems icon in the note editing toolbar or
click ÁÍÊÉ to split the active score into systems. This reformats the score into systems with
optimal  filling.  Place  the  check  mark  Automatic  reformatting next  to  the  Reformat
score into systems icon to automatically reformat the score into systems.

In contrast to capella tonica does not support a manual system break at cursor position.

[Systems:Merge]Sometimes copying and pasting selected sections is easier when all
notes are displayed in one system. Click the  Merge systems icon in the note editing
toolbar or click ÁÍ ÍãÍ É+ÁÍ ÍîÍ É to merge all notes of the active score in one system.
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Text

Title and page numbers

Each score has a title and shows page numbers. Both text elements are freely placeable
and are stored in the tonica document.

To change the title double-click the text or use DOCUMENT → OPTIONS... → TITLE.

To provide space for a title access the system template and adapt the „Space above first
system“.

Instrument names

Instrument names are entered in the system template. They will be displayed automati-
cally in all relevant staves. The left margin will be adjusted automatically.

Temporary score elements

Some composition and analysis functions in tonica create explanatory texts, tooltips or
marks. These score elements are only shown temporarily and will be deleted with the
next editing operation. They are not stored in the tonica document.

After composing a fugue tonica displays important sections of fugue (e. g. Exposition,
Developments, Coda). Occurrences of the subject in the fugue are highlighted by color
marking of the notes.

After running a score check conspicuous passages (notes, harmonies) are marked in the
score. Voice leading parallels are displayed by lines. Blue color indicates warnings, red
color indicates errors.
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How to create a score

The system template

The system template is the center for your score. It is a kind of pattern, the basic struc-
ture for your score. Many preferences which are globally valid for the entire score are
set in the system template, therefore it is worth the effort to invest some time in the
setup of a suitable system template.

Among other things, in the system template you determine 

• who is playing – the maximum number of instruments,

• what the staves look like,

• how they are named,

• which staves are connected with brackets,

• which clefs are valid,

• which sounds are assigned and much more.

Information such as time signature and key signature cannot be found in the system
template but can be changed in the document options.

While working on your score you can change the system template at any time. Please
note, however, that in doing so not only the section that you are working at but the
whole score changes, for example when you edit spaces in the system template. The
system template only shows the basic structure.

The system template view

In  VIEW → SYSTEM TEMPLATE you switch the system template view on and off. The system
template is situated in the left area of the screen. This way both system template and
score can be looked at simultaneously. By clicking on the right margin (arrows indicate
it) you can fully display the system template.

Normally there is no need to switch the system template on or off as this can be better achieved by
switching the mode.
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In the system template you see the structure of a complete system with all staves which
appear in your score.

Mark a staff by clicking with the mouse in the desired staff. The staff the cursor is posi-
tioned in will be automatically pre-marked. When you keep ÁÍ ÍÔÍ É pressed and click on
another staff, all staves between the first and the second click will be marked.

When you keep  ÁÍ ÍãÍ É pressed you can mark staves not being positioned next to each
other or exclude staves from the marking. One staff will always remain marked.

Contrary to what you are used to, you cannot mark several staves by dragging with the
mouse, as this action is used in other commands (see below).

Extend or regroup – the system template icons

Extend the system template. With the icons NEW STAFF you can extend the system tem-
plate when only one staff  is  marked. You select whether the new staff is  to appear
above or below the marked one. The new staff obtains all properties of the previously
marked one. When now the two staves have the same name you will see a warning
(yellow triangle). You should change one of the names as otherwise problems might
arise, for example when selecting the melody voice in the composition assistant.

Newly inserted staves are directly taken over to the score.

You can change the allocation of staves any time in the system template. These changes
will be taken over to all systems already existing in the score.

How to shift one or more staves in the system template

1. In the system template mark the staff or staff range to be shifted

2. Click on one of the icons SHIFT STAVE(S) UPWARDS/DOWNWARDS

Example: In a tonica score the string instruments are positioned above the wind instru-
ments. You want to create the common order. To do so mark all string instruments in
the system template and repeatedly click on the icon until they appear below the wind
instruments. This order is directly changed in the score as well.

When you shift entire instrument groups as in this example, tonica will move the system brackets ac-
cordingly. In some cases you will have to correct brackets afterwards.

The DELETE STAVE(S) icon deletes the marked stave(s) from the system template and from
the score. Please observe the warning!

You can  leave the system template view  by clicking with the mouse in the score or
pressing ÁÍeÍsÍcÉ. You switch off Setup mode and the system template view by clicking the
Compose button in the main symbol bar.
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Formatting staves in the system template

Now lets take a look at the system template in detail: Staves are displayed schemati-
cally, as in a table. This way you can see most of them at a glance and can edit them di -
rectly. The table header contains abbreviations and symbols for the single columns (ob-
serve the tooltips) which are now explained one by one:

Column 1: Spacing

Gray beams show how much space is allocated to a staff as well as the space above the
first system. Move these beams with the mouse to obtain more or less space for the
staff. Exactly at the interface between two beams there is a small drag point which you
can use to set additional group spacing.

To the left of this drag point between two beams there is another drag point. You use it
to define how the entire spacing is divided between below and above.

A staff containing many notes with ledger lines needs more space. This space should be
assigned to this staff and not to the neighboring one.

To enlarge the space between systems, do not enlarge the space above the first staff or
below the last staff, as these spaces might be canceled. Drag the gray beam below the
last staff.

Column 2: Name

This column is meant for the complete instrument name which normally appears in the
first system of the score, for example „Trumpet in b flat“. When you move vertically
across this column with the mouse, input fields appear. There is a field in front of each
staff and one between two staves (for example for piano). Double-click the field to label
it.

You can also enter these instrument names in several lines.  ÁÍ ÍãÍ É+ÁÍÊÉ moves the cursor to a second
line.

Column 3: Abbrev = Abbreviation

This column is meant for the abbreviation which normally appears in each system of
the score except the first one, for example „Tpt.“ When you move vertically across this
column with the mouse, input fields appear. There is a field in front of each staff and
one between two staves (for example for piano). Double-click the field to label it.

Column 4: Square bracket

Click  with  the mouse in  this  column and drag vertically,  holding the mouse button
down, across the staves you want to join with a brace. You can also shorten or delete
existing braces, but always from the end of the brace, only. Double-clicking the brace
deletes it.
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You can also join staves with braces by double-clicking this column. Keep an eye on the
mouse pointer which changes into a „+“ sign when you arrived at the correct position.

Column 5: Default clef

Double-click or right-mouse click the clef or its position. A dialog box opens where you
select the default clef. The default clef will appear when you add the staff to the score.

Column 6: Description respectively internal description

In this field the same entry as in Name may be stated, but also a different description
helping you identify this staff. This description is not editable.

Via the context menu (right mouse button) you can have the selected staff replaced by
a template. The selected template changes the preference for this staff in all columns
and takes it over directly to the score.

By clicking between two staves you can insert a new staff.

Column 7: Voices of staff

This column is needed for inserting a second voice into a staff or for deleting a voice in
a staff.  Double-click or right-mouse click the small encircled number. Then select the
desired action in the context menu.

The action will automatically insert a voice into or delete a voice from the score.

Column 8: Function

This column determines which voices are used for composition and which voice is the
melody voice. If you select „Not used“ as a function the corresponding voice will not be
considered,  i. e.  it  will  remain  unchanged during composition.  Defining the melody
voice is important so that tonica knows in which voice to find the source material (e. g.
a melody or a subject) of the composition. There can only be one melody voice. The
melody voice can be selected in the upper area of the composition assistant.

Double-click an entry in the column to change the function of the corresponding voice.

Column 9: Ambitus

In this column you can define the voice ranges of each voice. If you have activated the
Check ambitus option in the upper area of the composition assistant tonica takes care
that the voices composed will not leave their voice ranges. This will ensure that only
notes are composed which can be sung by a singing voice or played by an instrument.

Double-click an entry in the column. A dialog appears in which you can set the ambitus
of the corresponding voice. You can either shift the lowest or highest pitch with the
mouse, or you can change the values in the input fields on the right. Keep ÁÍ ÍãÍ É pressed
if you want to shift the pitch diatonically instead of chromatically.
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The voice range must be at least one octave.

Column 10: Device

The term device is not to be taken in the literal sense. The device  can be your sound
card, i. e. really a device you can touch, or a sound font or sound library, i. e. software.

Initially it will say „Unspecified“. Change this only when you want to apply different de-
vices for different sounds. When the same device is to deliver the different sounds for
all staves and voices, select this device in EXTRAS → SOUND CONFIGURATION..., see page 104.

Column 11: Sound

Double-click or right mouse click the word in the staff. Here you select the sound with
which the staff or voice is to be played back. If you are not sure that your device sup-
ports  the selected sounds,   select  MIDI  instruments  first  and  then  one  of  the 128
sounds from the list.

Column 12: Vol = Volume

Here you have the option to balance staves and voices by setting differing volumes.
Double-click or right mouse click the number and change the appearing input field or
the slide control. You can select from values 0-127.

Score properties

Page setup

Page orientation (portrait or landscape), page margins and page format are set in FILE →
PAGE SETUP.

It is advisable to set these parameters before you start editing a score because these
settings have a bearing on the appearance of the score, in particular on justification.

These preferences are recorded in the score and are not dependent on the printer. The
score’s appearance remains unchanged if you set for example a different page size in
your printer driver. The page orientation (portrait or landscape) is automatically syn-
chronized between score and printer driver. In landscape format staff lines are vertically
aligned to the printer line, in portrait format parallelly.
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Composition and analysis
tonica is a computer program with the unique ability to compose and analyze music
pieces. This ability was learned with the help of artificial neural networks created by
tonica from music examples given to it (e. g. chorales composed by Johann Sebastian
Bach). You can use this feature to playfully learn the basics of composition and music
analysis and use tonica as a tool to create your own compositions.

Automatic composition

All composition functions available in tonica can be selected in the composition assis-
tant toolbar.

Compose score
Arranges notes in a composition with several parts. The arrangement of notes for a
melody results in a multi-part score.

Use case: Add voices to a given melody. tonica adds harmonies that conform to a musi-
cal style and realizes them as chords that result in a multi-part score.

How to compose a score

• Enter the melody in the arbitrary voice used for composition. Mark important
sections  of  the  melody  with  fermatas.  You  will  generally  get  better  results
when setting fermatas in a sensible way (also see page 57).

• Switch to mode Compose and select the function Score in the composition as-
sistant toolbar.

• In the area below the toolbar select the voice where you have entered the
melody as melody voice.

• Click the Compose button.

• Listen to the composition and assess the result.

• To get a different result, first undo the result with the undo command. Then
change the composition preferences (e. g. the harmonization style) and click
the Compose button again.
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If you want to change individual harmonies or chords, you can simply modify the harmonies below the
system and then use the composition functions Realize chords and Add passing notes. In this way you
can realize your own harmonic ideas.

Harmonize
Harmonization is the process of constructing harmony which is the simultaneous occur-
rence of notes in a composition.

Use case: Add harmonies to a given melody. tonica adds harmonies that conform to the
selected musical style.

How to harmonize a melody

• Enter the melody in the arbitrary voice used for composition. Mark important
sections  of  the  melody  with  fermatas.  You  will  generally  get  better  results
when setting fermatas in a sensible way (also see page 57).

• Switch to mode  Compose and select the function  Harmonize in the composi-
tion assistant toolbar.

• In the area below the toolbar select the voice where you have entered the
melody as melody voice.

• Click the Compose button.

• Find out which notes belong to a harmony in the harmony staff by placing the
cursor in front of this harmony and opening section Harmony evaluation in the
composition assistant.

• To get a different result, first undo the result with the undo command. Then
change the composition preferences (e. g. the harmonization style) and click
the Compose button again.

Realize chords
Chord realization means the construction of chords for a harmonization.

The arrangement of chord notes in a score is subject to rules which are called voice-
leading rules (see page 94).

Use case: Frequently, harmonies are already given with a melody, e. g. in a leadsheet or
in figured bass. Then tonica creates chords that conform to these harmonies. tonica can
also realize chords from harmonies without a given melody.

How to realize chords
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• If you have a given melody: Enter the melody in the arbitrary voice used for
composition. Mark important sections of the melody with fermatas. You will
generally get better results when setting fermatas in a sensible way (see also
page 57).

• Enter the given harmonies with their duration in the harmony staff.

• Switch to mode Compose and select the function Realize chords in the compo-
sition assistant toolbar.

• In the area below the toolbar select the voice where you have entered the
melody as melody voice. If you have not entered a melody, select „none“.

• Click the Compose button.

• Listen to the composition and assess the result.

• To get a different result, first undo the result with the undo command. Then
change the composition preferences (e. g. the harmonization style) and click
the Compose button again.

Add passing notes
Adds passing or changing notes to a chord structure.
Use case: Add passing and changing notes to the score. tonica adds passing and chang-
ing notes in the selected musical style to create a smooth and elegant score.

How to add passing notes to a score

• Enter the score or let tonica create it. Enter the harmonies that belong to the
score or let tonica analyze them using the Harmonic analysis function.

• Switch to mode  Compose and select  the function  Add passing notes in  the
composition assistant toolbar.

• In the area below the toolbar select the voice where you have entered the
melody as melody voice.

• Click the Compose button.

• Listen to the composition and assess the result.

• To get a different result, first undo the result with the undo command. Then
change the composition preferences (e. g. the harmonization style) and click
the Compose button again.
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Variation
A variation is a part of a composition which modifies a melody or subject melodically,
harmonically or rhythmically.

Use case: Create a variation of a given melody by adding simple ornamentations to the
melody or to the accompanying voices.

Examples of this type of variation can be found in baroque compositions, e. g. in partitas of Johann
Pachelbel and preludes of Johann Sebastian Bach.

How to create a variation

• Enter the melody in the arbitrary voice used for composition. Mark important
sections  of  the  melody  with  fermatas.  You  will  generally  get  better  results
when setting fermatas in a sensible way (see also page 57).

• Switch to mode Compose and select the function Variation in the composition
assistant toolbar.

• In the area below the toolbar select the voice where you have entered the
melody as melody voice.

• Click the Compose button.

• Listen to the composition and assess the result.

• To get a different result, first undo the result with the undo command. Then
change the composition preferences  (e. g. the variation style)  and click  the
Compose button again.

Vary
Varying means creating a variation of a composition.

Use case: Create a variation of a score by adding simple ornamentations in the melody
voice or in the accompanying voices.

How to vary a score

• Enter the score or let tonica create it. Enter the harmonies that belong to the
score or let tonica analyze them using the Harmonic analysis function.

• Switch to mode Compose and select the function Vary in the composition assis-
tant toolbar.

• In the area below the toolbar select the voice where you have entered the
melody as melody voice.
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• Click the Compose button.

• Listen to the composition and assess the result.

• To get a different result, first undo the result with the undo command. Then
change the composition preferences  (e. g. the variation style)  and click  the
Compose button again.

Patterns
Accompanying patterns are repetitive rhythmic and harmonic structures typical of spe-
cific style. They are mainly used in popular music.

tonica composes patterns in various rock, pop and dance styles. This function can be
used in two ways: Firstly tonica creates a pattern as a template for adding or improvis-
ing a melody. Secondly tonica creates a pattern for a given melody.

If desired tonica adapts harmonization rhythm, tempo and instrumentation of the ac-
companying voices to the selected style.

Use case 1: Create accompanying patterns for a harmonization (e. g. given as a lead-
sheet template).

How to create a pattern as a template

• Define the structure of the leadsheet template and enter the harmonies with
their duration in the harmony staff.

• Switch to mode Compose and select the function Patterns in the composition
assistant toolbar.

• Click the Compose button.

• Listen to the composition and assess the result.

• To get a different result, first undo the result with the undo command. Then
change the composition preferences (e. g. the accompanying style) and click
the Compose button again.

Use case 2: Create accompanying patterns for a given melody.

How to create patterns for a melody

• Enter the melody in the arbitrary voice used for composition. Mark important
sections  of  the  melody  with  fermatas.  You  will  generally  get  better  results
when setting fermatas in a sensible way (see also page 57).

• Switch to mode Compose and select the function Patterns in the composition
assistant toolbar.
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• In the area below the toolbar select the voice where you have entered the
melody as melody voice.

• Click the Compose button.

• Listen to the composition and assess the result.

• To get a different result, first undo the result with the undo command. Then
change the composition preferences (e. g. the accompanying style) and click
the Compose button again.

Canon
A canon is a polyphonic composition in which one voice follows the other. The first
voice is copied by the other voices.
Circular canons are characterized by the fact that voices are repeated after a certain
number of bars. This has the effect that the canon can be continued at will. You can
choose a  strict or a  free canon. With a strict canon each entering voice in its original
form is (apart from the pitch) an exact imitation of the previous voice. You will obtain a
free canon if you select a subject form (rectus, inversus, retrograde and inverse retro-
grade) which differs from the original form for one or several entering voices. Subject
form and accompaniment of the entering voices will then differ. 

tonica is able to compose circular canons on any subject and for several voices and will
consider the selected harmonization and variation style. You can define the entrance
order  of  voices  and  whether  accompanying  voices  are  to  be  varied.  You  can  even
change the cue interval of the voice entrances.

Use case: Create a canon on a short subject.

How to create a canon on a subject

• Enter the subject in an arbitrary voice.

• Switch to mode Compose and select the function Canon in the composition as-
sistant toolbar.

• In the area below the toolbar select the voice where you have entered the sub-
ject as melody voice.

• Click the Compose button.

• Listen to the composition and assess the result.

• To get a different result, first undo the result with the undo command. Then
change the composition preferences (e. g. the harmonization style) and click
the Compose button again.
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Fugue
A fugue is a polyphonic composition built on a musical subject that is introduced at the
beginning in imitation (repetition at different pitches) and which recurs frequently in
the course of the composition.
tonica is able to compose fugues on any subject and for several voices and will consider
the selected harmonization and variation style.

The special feature of a fugue is its complex treatment of the subject. A fugue begins
with an exposition when the main theme is heard. The main theme is called the subject
or Dux (Latin:  leader),  the transposed version is called the answer or Comes (Latin:
companion). When in the key motif of the Dux the fifth note appears above the key
note, then this key note will be changed to a fifth in the Comes. This is in order to en-
sure the identity of the key. Alternatively the subject will be transposed true to the in-
terval. This is called a „real fugue”. Further voices can be added according to this princi-
ple until the entire number of voices is reached. Further on in the fugue there will al-
ways be parts where the subject is executed in different voices. These parts are called
„developments“. In these developments the subject can be varied in different ways or
can be combined with itself. Such combinations can be stretto (overlap of two or more
entering subjects), inversions, retrogrations of the subject or augmentations (statement
of a melody in longer note values). The entering subjects are connected with each other
by interludes. These interludes are used for modulation and are generally composed
from sequences or canons. 

tonica offers several form schemes, most of them derived from the fugues of the Well-
Tempered Clavier by J. S. Bach (see page 82).

When choosing a fugue subject you should pay attention to a focused melodic content.
The subject should have a distinctive character. It should not fall apart into two equal
halves, as many themes of the Viennese classic do. The subject should not exceed the
range of an octave. It should stay in its key and may only switch to the upper dominant
when being modulated.

In  tonica you will find the fugue subjects of the Well-Tempered Clavier by J. S. Bach. They are good
demonstration material.

Use case: Create a fugue about a short subject. Various fugue schemes are available
(e. g. from Well-Tempered Clavier).

How to create a fugue on a subject

• Enter the subject in an arbitrary voice.

• Switch to mode Compose and select the function Fugue in the composition as-
sistant toolbar.
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• In the area below the toolbar select the voice where you have entered the sub-
ject as melody voice.

• Click the Compose button.

• Listen to the composition and assess the result.

• To get a different result, first undo the result with the undo command. Then
change the composition preferences  (e. g. the fugue scheme)  and click  the
Compose button again.

Form scheme representation of a composed fugue

After composing the fugue a window is opened showing the temporal structure of the
fugue in a graphic.

The x axis displays the temporal structure with important sections of the fugue (e. g. Ex-
position, First Development etc.). The y axis displays the involved voices. The building
blocks of the fugue (e. g. subject, sequence or counterpoint) are visualized with sym-
bols (see legend below the fugue structure). The numbers in upper left corner of the
blocks are measure numbers. You can also see which voices are active in which periods.

If you click on a symbol (except the counterpoint symbol), the cursor in the score jumps
to the corresponding position. When clicking the play button a cursor in the graphics
window follows the temporal structure of the fugue.

tonica also displays important sections of fugue (e. g. Exposition, Developments, Coda)
in the score. Occurrences of the subject in the fugue are highlighted by color marking of
the notes. When you hover over a colored note a tooltip provides more information
about the subject properties.

Figured bass
Figured bass is a notation used in baroque music to indicate harmonies and chords in
relation to bass notes.

An overview of figured bass notation in tonica can be found in chapter page 139.

Use case: Create a score from a figured bass voice.

How to realize a figured bass

• Enter the bass notes in the lowest voice used for composition. Mark important
sections of the bass voice with fermatas. You will generally get better results
when setting fermatas in a sensible way (see also page 57).

• Select the harmony representation Figured bass from the document menu and
save the document. This will automatically add empty harmonies into the har-
mony staff.
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• Switch to mode  Compose and add figures in figured bass notation below the
corresponding bass  notes.  The figures  describe the interval  distance of  the
chord notes to the bass note. Alterations from the given key are notated with
an accidental or with „+“. Write „0“ or „-“ for bass notes in the given harmo-
nization rhythm that should not be realized as chords or as new chords.

• Select the function Figured bass in the composition assistant toolbar.

• In the area below the toolbar select the figured bass voice as melody voice.

• Click the Compose button.

• Listen to the composition and assess the result.

• To get a different result, first undo the result with the undo command. Then
change the composition preferences (e. g. the harmonization style) and click
the Compose button again.

Double voice
Voice doubling means adding an accompanying voice to an existing melody in a speci-
fied interval distance (e. g. an octave, a third or a sixth).

The most frequent form of voice duplication is octaving: As an example the cellos in an
orchestra are often duplicated by the double basses playing one octave lower. Another
form of voice duplication was the parallel leading in fifths and fourths („Quartal har-
mony“) in medieval times. With increasing development of Major-Minor tonality, thirds
and sixths prevailed against the fourth which was perceived as dissonance to be re-
solved. Only 20th century music liberated the use and thus the parallel leading of disso-
nant intervals. In today’s easy listening music which still has tonal characteristics voice
duplication in thirds and sixths is often used to enrich the sound of a voice („back-
ground singing“).

tonica is able to add a parallel accompanying voice to any existing voice. Both accompa-
nying voice and interval to be applied for duplication can be selected freely. When the
main voice is to be duplicated the voice range set for the accompanying voice will be
considered. Accompanying tones are octaved if necessary.

Given  harmonies  will  also  be  considered  for  the  selection  of  accompanying  tones.
These tones are always selected to go with the corresponding harmonies. The accom-
panying interval will be adapted if necessary: If for example the third is selected as in-
terval, but the accompanying tone in the third interval does not go with the harmony,
then the next tone going with the harmony will be selected, for example the tone in
fourth interval.

Use case: Add a parallel  accompanying voice to a given voice.  If  a harmonization is
given, the accompanying voice is adapted to the harmonies.
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How to double a voice

• Enter the voice to be doubled.

• If a harmonization is given: Enter the harmonies with their duration in the har-
mony staff.

• Switch to mode Compose and select the function Double in the composition as-
sistant toolbar.

• Click the Compose button.

• Listen to the composition and assess the result.

• To get a different result, first undo the result with the undo command. Then
change the composition preferences (e. g. the double voice) and click the Com-
pose button again.

Automatic analysis

All analysis functions available in tonica can be selected in the composition assistant
toolbar.

Check score
Checks the voices of a score for rule violations.

The arrangement of chord notes in a score is subject to rules which are called voice-
leading rules (see page 94).

Use this function to check a score. Notes or harmonies colored in red or blue indicate
errors or warnings.

Use case: A given score is checked for voice-leading errors.

How to check a score

• Open the score to be checked.

• If a harmonization is given, enter the harmonies with their duration in the har-
mony staff. Otherwise the harmonies are determined automatically.

• Switch to mode Compose and select the function Check in the composition as-
sistant toolbar.

• Click the Analyze button.

• Examine markings (warnings, errors) of the analysis and assess the result.
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• To get a different result, first undo the result with the undo command. Then
change the composition preferences (e. g. the chord scheme) and click the An-
alyze button again.

After the examination of the composition move the mouse over a note or harmony col-
ored in red or blue. The error or warning text will be displayed. With notes, the relevant
voices will also be stated in the error or warning text. In case of a chord progression er-
ror, it will additionally be stated if the note or harmony belongs to the first or second
chord of the chord progression.

How to show a voice-leading error

• Right mouse click on a colored note or harmony and select Info in the context
menu.

• The error or warning text is displayed in a message window. Click the Help link
to obtain details about the rules in question.

How to correct a voice-leading error

• In the upper area of the composition assistant select which section of the score
shall be corrected: „All“, „Current phrase“ or „Marked section“ with the error
to be corrected.

• If necessary repeat the process until all errors are corrected.

Note: The notes in the melody voice will  not be altered during voice leading correction. Therefore
please make sure that the correct melody voice has been selected.

Harmonic analysis
Harmonic analysis is the determination of harmonies of a composition.

Use case: A given score is analyzed harmonically.

How to analyze a score harmonically

• Open the score to be analyzed.

• Switch to mode  Compose and select  the function  Harmonic  analysis in  the
composition assistant toolbar.

• Click the Analyze button.

• Examine the analysis and assess the result.

• To get a different result, first undo the result with the undo command. Then
change the composition preferences (e. g. the chord scheme) and click the An-
alyze button again.
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Composition and analysis options

For the composition and analysis functions, composition options are available in the
composition assistant with which the result can be influenced. Experiment with the
preferences to get to know all options and to find the right values for your desired re-
sult!

The preferences are divided into sections that can be opened or closed. Only those sec-
tions that are relevant for the selected composition or analysis function are displayed.

In each section only the most important preferences are displayed. If there are more
than the displayed preferences, this is indicated by dots … in the upper right corner of
the section. Click … to be able to edit all preferences in a dialog.

General options

In the upper area of the composition assistant general preferences are displayed which
are always visible.

Section: Select the section used for composition or analysis:

• Choose „All“ if the composition or analysis is to be created for the entire score.

• Choose „Current phrase“  if the phrase is to be composed or analyzed where
the cursor is currently positioned. Phrase ends are marked by fermatas. If there
is no fermata, then this corresponds with compose „All“.

• Choose „Marked section“ if you want a previously marked section to be com-
posed or analyzed.

Melody voice: Voice in which the melody is located.

Check ambitus: When composing tonica observes the voice ranges defined in the sys-
tem template for the voices involved in composition.

Section Compose

Harmonization style: Determines the harmonization style tonica uses for composition.

Harmonization rhythm: Determines the rhythm of the harmonization (such as quarter
notes or dotted rhythms).

Strategy: Generally  tonica will  determine a composition by choosing the most likely
harmony. For alternatives to this click „Permit alternative solutions“.

Prefer narrow range: tonica prefers a linear proceeding of the accompanying voices.
This sometimes produces chords with notes in distant positions which are difficult to
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play on a keyboard instrument. By clicking Prefer narrow range tonica will pick chords
whose upper voices can be played with the right hand.

Insert cadences: In this field you determine if or where tonica may insert cadences. You
can choose between „Everywhere“  and „At phrase ends“. Phrase ends are marked by
fermatas.

Select cadences randomly: Normally the cadences determined by tonica are unambigu-
ous. Check this option if you want to permit alternative cadences.

Section Analysis

Distance for harmonic analysis: Determines the distance of the harmonic analysis (such
as quarter notes).

Chord scheme: Determines the style on which the analysis is based.

Section Variation model

Variation style: Sets the style tonica will apply to vary the phrase (e. g. Pachelbel Partita
I). Each entry in the combo box has a tooltip with a short description of the variation
style.

Variation rhythm:  Determines the duration of a variation motif (e. g.  quarter notes).
Here you can set the harmonization rhythm (see page 77). You can also choose values
differing from the harmonization rhythm.

Determine first motif tone: Usually each variation motif starts with the first note in the
voice to be varied, so the variation follows the movement of the voice. Checking Deter-
mine first motif  tone creates variations with the first motif  note differing from the
voice to be varied. This gives you a „flowing“ characteristic.

Section Varying voices

Determines which variation is to be created in which voice:

• If you wish to have the variation always in the same voice, tick „Fixed“ and en-
ter the desired voice.

• If your variation is to be created in different voices, tick  „Random alternation
between“  and tick all  voices which may be varied.  tonica will pick a random
variation motif in one of the chosen voices. If you also tick „No variation“, then
it might happen that no variation motif appears at a time. 

• If you want to decide yourself when a voice is to be varied, tick „Alternation
pattern“ and enter the order of voices to be varied like this: „03 012“ for exam-
ple means that the first variation motif is to be in the first used voice, the sec-
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ond in the fourth voice, the next motif is not varied (Space), then again the
first, second and third voice. This sequence will be repeated until the end of
the variation.

Section Patterns

Accompanying style: Select the desired accompanying style  (e. g. „Walzer” or  „Slow-
fox”).

Harmonization rhythm: When you tick the box Adapt harmonization rhythm, the har-
monization rhythm is adapted to the accompanying style or can be adapted in the drop-
down list. Otherwise the preset harmonization rhythm is applied for the selected har-
monization style.

Tempo: When you tick the box Adapt tempo (quarter notes), the tempo of the score
will be adapted to the accompanying style or can be edited in the input field.

Accompanying instruments: When you tick the box Adapt accompanying instruments,
the instrument of the accompanying voices is adapted to the accompanying style or can
be edited via the selection button.

Section Canon

In the subsection Canon material you can define the setting which is to be considered
for the creation of the canon’s musical material (harmonization, accompaniment). Click
the button Determine rhythm settings globally to automatically determine the settings
based on the entered subject.

Vary accompaniment: Select this option if the accompanying voices of the canon shall
be varied. The selected variation style will be considered when varying the accompani-
ment.

In the subsection Circular canon you can define the canon’s structure. With a circular
canon the voices enter one after another until the canon is repeated.

Order  of  entry: Defines the order  in which the voices enter.  In  Entrance  voice the
voices used are listed in their order of entry. This order of entry can be changed by
clicking up and down. Single marked voices can be deselected with >. To select marked
voices you must mark them in the list Unused voice and then click <.

Modify subject: Additionally, you can determine a subject form for each entering voice.
This  can be original  form (Rectus),  inverted (Inversus),  Retrograde or  Inverse  Retro-
grade. When all entering voices are in their original form a strict canon is created. This
means that each entering voice is (except for the octave pitch) an exact imitation of the
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previous voice. You can change the subject form for the marked voice via the button
Modify subject.

Cue interval: Determines how many semitones away from the previous voice a voice
shall  enter.  When  you  select  an  entering  interval  other  than  prime the  canon  will
change keys with each entering voice, depending on the entering interval. This is done
until the keys repeat.

Maximum length: Determines the canon’s maximum duration (number of bars). Leave
the predefined value unchanged if you do not want to restrict the length.

Section Fugue

In the subsection Fugue material you can define the preference which is to be consid-
ered for the creation of  the fugue’s musical  material  (harmonization,  counterpoint).
Click the button  Determine rhythm preferences globally to automatically determine
the preferences based on the entered subject.

Vary accompaniment: The counterpoint of the subject is composed from the fugue’s
accompanying voices. If you wish to vary these accompanying voices tick Vary accom-
paniment. The selected variation style will be considered when varying the accompani-
ment.

Subject overlap: Generally the fugue subject ends harmonically before the next cue (no
overlap of entering subjects), however sometimes the new subject enters together with
the last note of the (initial) subject. In this case please click  Subject overlap (in 16th)
where you can define the overlap duration in sixteenth notes.

In the subsection Fugue you can determine the fugue’s structure. A fugue begins with
voices entering one after another with the subject (which forms the exposition). Fol-
lowing this the subject will be altered in one or several sections (developments).

Form scheme: Determines the fugue’s basic form, i. e. the character of exposition and
developments. With Form scheme you also determine the order of entering voices. For
example, in the standard fugue predefined by tonica the voices enter in the order [2, 1,
4, 3]: 2nd voice, 1st voice, 4th voice, 3rd voice.

Voice allocation: Determines how the voices of the selected form scheme are to be al-
located to the voices of the fugue to be composed. If you choose soprano as the first
voice and then alto, tenor and bass for a standard four-part fugue for mixed choir the
voices will enter in that order: alto, soprano, bass, tenor. You can modify the order of
entry by changing the voice allocation. For example, if you exchange alto for soprano
and bass for tenor, then the order of entry will change as follows: soprano, alto, tenor,
bass. You can even allocate two or more voices of the form scheme to one voice of the
fugue. If you choose the soprano for all voices then you will obtain a fugue with a four-
part structure, but for only one melody instrument, such as in J. S. Bach’s sonata for vio-
lin solo (BWV 1001).
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Section Figured bass

Early BC-Style (open position):  Chords are normally realized in close position to be
played with the right hand. In the early days figured bass composition was closely re-
lated to instrumental or vocal parts to be accompanied. Voices were equally distributed
on both hands. Check this option if you prefer this behavior.

Section Double voice

Double voice: Voice in which the doubled accompanying tones are to be created.

Interval: Distance between the parallel accompanying voice to the melody voice.

Section Voice leading

Parallels display: Determines which parallels are considered during score check:

• Select „Do not show” if parallels should not be displayed.

• Select „Only show genuine parallels” if only genuine parallels (e. g. fifth or oc-
tave parallels) should be displayed.  Genuine parallels are marked by red lines.

• Select „Show hidden parallels in outer voices” if hidden parallels between the
highest and lowest voice should be displayed. Hidden parallels are character-
ized by two voices that proceed into the same direction and the interval in the
second chord is a perfect consonance (prime, octave, fifth). Hidden parallels
are marked by blue lines.

• Select  „Show hidden  parallels  in  all  voices”  if  hidden parallels  in  all  voices
should be displayed.

Newly analyze harmonies: Check this option if you have not entered any harmonies or
you do not want to use the entered harmonies for checking the score, but want the
harmonies to be analyzed by tonica.

Set duration

For some input fields a duration has to be entered in 16th notes. If you click … next to
the input field you can specify the duration in number of measures,  beats  (quarter
notes) and additional 16th notes. Enter the appropriate values and click OK to get the
total duration in 16th notes.
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The fugue composition kit

With the fugue composition kit you can graphically edit and create fugue schemes (=
form schemes of a fugue). Open the fugue composition kit via COMPOSE → FUGUE SCHEMA....

The dialog shows all fugue schemes in a tree structure, reflecting the hierarchic compo-
sition of the fugue: 

• Level 1: Fugue scheme (for example standard fugue)

• Level 2: Form section (exposition, development or coda)

• Level 3: Form component (subject, canon interlude, sequence interlude or fer-
mata interlude).

In  levels  1 and 3  you can change properties  of  a  fugue scheme (name,  number of
voices, measures and duration of subject) or of a form section.

Edit fugue schemes

Click Export to export fugue schemes as a file.

Click Import to import fugue schemes. A dialog will let you select the fugue schemes to
import.

With  Restore Defaults the predefined fugue schemes will be restored. All changed or
newly set fugue schemes will be deleted.

Click Graphic to turn on or off a graphic description of the selected fugue scheme. 

Finish with OK to save the changes you made. If you click  Cancel all changes are can-
celed.

The fugue’s time flow which is defined by the form scheme you chose is shown in a sep-
arate window. This is described in section page 73.

The form section you chose is outlined in black. If you click on any symbol except the
counterpoint the cursor will jump to the respective form section in the tree structure.

Change a fugue scheme

Click on a tree node to edit its properties. Use the context menu (right mouse click) to
edit or create new fugue schemes.

The following properties can be defined for a fugue scheme or a form section:
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Properties of a fugue scheme

Description: Name of the fugue scheme

Number of voices: Number of voices of the fugue

Time signature: Time signature of the fugue

Duration of subject: The form scheme is based on this duration. Click ... to set the dura-
tion in number of measures, beats and sixteenth notes (see page 81). If a fugue is com-
posed whose duration does not comply with the stated duration stated all durations are
adapted accordingly. 

Properties of a subject

Subject voice: Voice with entering subject

Leading: Determines if the subject voice is leading. If the entering subject is leading
tonica will  try to maintain the initial  form of the subject  excluding clearly indicated
changes (such as inversions). Not leading entering subjects may be adapted to leading
entering subjects. If a subject enters in two or more voices at the same time the voices
not leading will be harmonically adapted to the leading ones. 

Mode: Mode of the entering subject can be either direct (major, minor) or related to
the subject (unchanged, change between major/minor). If you enter a minor subject
and then choose „Change between major/minor“ the subject will appear in the corre-
sponding major mode.

Comes: Determines if the subject is to enter as Comes or Dux (original form). 

Transposition: Determines the number of semitone steps for the transposition of the
subject.

Inversion: Determines if the subject is to enter as inversion (horizontal reflection).

Change of note value: Determines if the subject is to be augmented. If it is to be aug-
mented all note durations will be doubled in length.

Duration: Duration of the entering subject in relation to beginning or end of the sub-
ject. Click ... to set the duration in number of measures, beats and sixteenth notes (see
page 81). The duration of the entering subject can be stated in relation to the beginning
of the subject (such as „eight sixteenth notes from the beginning of the subject“) or in
relation to the end of the subject (such as „eight sixteenth notes until the end of the
subject“). This means that the subject will be reduced by the final eight sixteenth notes.

Stretto: This means that there is a subject overlap so that the subject appears in two
voices at a time. Here you set the duration of the stretto in relation to the beginning or
end of the previously entering subject.  If  you set  the stretto to start  zero sixteenth
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notes before end of the previously entering subject, then the subject will begin directly
after the end of it (no overlap).

Position: Here you set the subject’s position. Contrary to transposition this means that
the subject will begin on a different interval level of the scale without being transposed
into another key.

Pedal point: Semitone pitch of the pedal point, if existing. A pedal point is an extended
note in the lowest voice (usually the bass voice).

Active Voices: Determines which voices are to be active for this form section.

Properties of a sequence (sequencing interlude)

In a sequencing interlude a part of the subject is repeated and it ascends or descends
on different levels of the scale.

Main voice: Voice of the sequence on which the subject is based.

Mode: Mode of the sequence either direct (major, minor) or related to the subject (un-
changed, change between major/minor). If you enter a minor subject and then choose
„Change between major/minor“ the sequence will appear in the corresponding major
mode.

Comes: Determines if the sequence is to enter as Comes or Dux (original form). 

Transposition: Determines the number of semitone steps for the transposition of the
sequence.

Initial degree: Degree on which the sequence is to start.

Orientation: Number of ascending or descending degrees.

Number of cues: Number of sequence repetitions. If you set „1“, then you will obtain a
simple interlude.

Inversion: Determines if the sequence is to be based on the inverted subject (horizontal
reflection).

Change of note value: Determines if the sequence is to be based on the augmented
subject. Augmentation means doubling of all note lengths.

Duration: Duration of a sequence repetition relating to the beginning or end of a sub-
ject. Click ... to set the duration in number of measures, beats and sixteenth notes (see
page 81). The sequence is based either on the beginning or the end of the subject. The
duration can also be set relative to the beginning of the subject (for example eight six-
teenth notes after the beginning of the subject) or the end of the subject (for example
starting eight sixteenth notes before the end of the subject).
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Position: Position of the subject on which the sequence is based. Contrary to transposi-
tion, this means that the subject will begin on a different interval level of the scale,
without being transposed into another key.

Pedal point: Semitone pitch of the pedal point, if existing. A pedal point is an extended
note in the lowest voice (usually the bass voice).

Active Voices: Determines which voices are to be active for this form section.

Properties of a canon (canon interlude)

In a canon interlude a part of the subject is repeated and transposed, one after another
and in different voices.

Initial voice: Starting voice based on the subject.

Mode: Mode of the canon either direct (major, minor) or related to the subject (un-
changed, change between major/minor). If you enter a minor subject and then choose
„Change  between  major/minor“  the  canon  will  appear  in  the  corresponding  major
mode.

Comes: Determines if the canon is to enter as Comes or Dux (original form).

Initial interval: Semitone starting interval of the canon.

Cue interval: Determines how the new canon entry is to be transposed. If you choose
fifth, then each new entry will start a fifth up.

Number of cues:  Number of cues of the canon. If you set „1“, then you will obtain a
simple interlude.

Inversion: Determines if the canon is to be based on the inverted subject (horizontal re-
flection).

Change of note value: Determines if the canon is to be based on the augmented sub-
ject. Augmentation means doubling of all note lengths.

Duration: Duration of a canon entry relating to the beginning or end of a subject. Click
... to set the duration in number of measures, beats and sixteenth notes (see page 81).
The canon is based either on the beginning or the end of the subject. The duration can
also be set relative to the beginning of the subject (for example eight sixteenth notes
after the beginning of the subject) or the end of the subject (for example starting eight
sixteenth notes before the end of the subject).

Position: Position of the subject on which the canon is based.

Pedal point: Semitone pitch of the pedal point, if existing. A pedal point is an extended
note in the lowest voice (usually the bass voice).
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Active Voices: Determines which voices are to be active for this form section.

Properties of a  fermata (interlude)

Lasting chord with fermata at the end of an interlude.

Root: Root of the chord.

Mode: Mode of the chord either direct (major, minor) or related to the subject (un-
changed, change between major/minor). If you enter a minor subject and then choose
„Change  between  major/minor“  the  canon  will  appear  in  the  corresponding  major
mode.

Duration: Duration of the chord. Click  ... to set the duration in number of measures,
beats and sixteenth notes (see page 81).

Set the voice ranges
tonica offers two options to influence the voice ranges in the score:

• You can set the voice range of each voice in the Ambitus column of the tem-
plate system (see page 64).

• You can use COMPOSE → VOICE RANGE… to set the voice ranges used for  composi-
tion.

Voice ranges are set individually for each score and stored in the tonica document.

It is important to know the difference between the two options:

Normally setting voice ranges in the system template does not have an influence on
composition. However if you set the Check ambitus option in the composition assistant,
tonica will take care that the composed voices do not leave their voice ranges. Use this
option to ensure that all composed notes are singable by singers or playable by instru-
ments.

When you call COMPOSE → VOICE RANGE… a dialog appears which lets you change the voice
ranges for scores, variations and canons/fugues. This is especially useful if you want the
voice ranges for a specific instrumentation (e. g. a men’s choir or a string quartet) to be
completely filled.

You can achieve this by defining for the composition function in question the lowest
and highest pitch of each voice in the Tabs Score, Variation and Canon/Fugue. Click the
dots  … next to the voice range to change it. See page 64 for more information about
changing the ambitus.
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When you click the Restore Defaults button the voice ranges are reset to their default
values. tonica considers these voice ranges when composing scores, variations, canons
and fugues.

Since variations  are  typically  composed for  instrumental  rather  than vocal  ensembles,  tonica uses
larger voice ranges for variations by default which have the voice range of instruments.
Important: Note that changing the voice ranges for composition may have a significant effect on ton-
ica’s composition performance (especially for scores). The larger the voice ranges the longer the dura -
tion for computing all possible composition variants. Therefore do not make the voice ranges for com-
position too large!

Creating a harmonization style
tonica has a procedure for learning new harmonization styles. It uses a sophisticated
neural network technique, but in a way that is very simple to apply. You simply provide
tonica with characteristic examples of the style and the software will extract the rules
behind the style. The most important job for the user is to carefully select pieces of mu-
sic that are typical for the style. The more typical pieces of music are available the bet-
ter the results will be.

The features

tonica provides an automatic,  parametrizable system to create harmonization styles.
These styles can be added to the Bach, Max Reger and Jazz styles available in tonica. To
create a new style you give tonica a quantity of music examples in the form of  tonica
files. The program automatically analyzes the examples, using a technique called Neural
Network Analysis. Creating a set of style rules this way is referred to as  „training the
network”. Because it can take some time if you supply a lot of examples (20+) and ask
for a high probability of the predicted result matching a real example when setting the
learning parameters, the process runs in the background while you use tonica for some-
thing else. The trained styles are available immediately.

There  is  a  comprehensive  range  of  facilities  to  edit  styles.  Styles  can  be  copied,
changed, deleted, imported and exported.

There are also options that can be applied when using the harmonization style.

The Style assistant makes it simple to create and import harmonization styles.

Style production is limited to example scores that contain chords covered in tonica’s analyzable chord
repertoire, therefore it is not suitable for styles which use unusual harmonies. The present repertoire
of approximately 50 chord types nevertheless covers a large proportion of potential harmonies.
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The style assistant for harmonization styles – a brief introduction

Use HARMONIZATION STYLES → STYLE ASSISTANT...  to start the style assistant which assists you in
creating a new style or importing an existing style. For importing a style see page 90.

Example: Use the following example to see how you can create a new harmonization style from a sim -
ple cadence in tonica. The result may not be particularly original, but the procedure is the same as with
creating a new style.

Decide on the tonica files from which a new style is to be created

This is the most important step and might require some effort and time to get it right.
The sample files from which you want to create the style must be available in  tonica
format (examples for Bach style and Scheidt style are available in the start screen). If
your source file is only available in capella format you can open or import it in tonica
and then save it as a tonica file.

Preparation: In the following we are using two files:  03-11.tca und  03-51.tca.
You will find them in the Examples tab of the start screen when you click the Example
folder. Open these files and save them with the same names in your personal tonica
folder before using them for style creation.

Now open file 03-11.tca from your personal tonica folder. It contains a phrase con-
sisting of four chords that constitute a complete cadence (tonic, subdominant, domi-
nant, tonic). tonica will learn the harmonies upon which this score is based.

Examination of the harmonization style via harmonic analysis

This step is not essential to creating a new style, however we recommend it as a means
of confirming the quality of the new style.

In our current example you will note that no harmony (or chord description) is indicated
below the last chord. To find out how tonica analyzes the score you need to do a har-
monic analysis (ANALYZE → HARMONIC ANALYSIS). As a result the last chord will also be shown
as tonic. We can evaluate the result of harmonic analysis by realizing chords from the
analyzed harmonies (COMPOSE → REALIZE CHORDS).

Selection and analysis of sample files

The first two steps were used to prepare the style creation. Now you need to start the
style assistant (HARMONIZATION STYLES → STYLE ASSISTANT...) and click on Continue. You have now
reached the first step of the actual tonica style creation. Click Add to select the file 03-
11.tca located  in  your  personal  folder.  From  the  same  folder  add  the  file  03-
51.tca, click the file name and click the Test button (more about Test later). Enter a
name for the style, e. g. „Cadence style”. Click on Next. Both files will automatically be
analyzed (one training file and one test file). Confirm the analysis by clicking OK.
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Determination of the learning parameters

In step 2 of the style assistant we just use the predefined values and click OK. See page
91 for more information about the learning parameters.

Determination of the composition options

In step 3 of the style assistant we select the composition options which are used as de-
fault values for the harmonization style. In our case we do not modify the composition
options. See page 77 for more information about the composition options.

Training of the harmonization style

Click Finish to leave the style assistant. This will automatically initiate the style training.
Once completed the training report window will display a statistical summary of the re-
sult. The figures should be interpreted as follows: Classification grade of 100% for train-
ing indicates that all harmonies have been learned successfully. Classification grade of
75% in the test column of harmonic function indicates that only ¾ of the functions from
the test sample  03-51.tca would have been determined in the same way by the
trained style.

A  high  classification  grade  for  training  indicates  that  the  training  data  have  been
learned well. A high classification grade for test indicates that the learned function is
capable of predicting test data that have not been learned. This means that it is not
necessarily desirable to reach 100% classification grade on the training samples, but
rather aim for a well balanced grade between training and test data. In our example
75% is the maximum attainable grade for the test data.

Click Apply to accept the result and close the training report.

Examination of the training result

Once the training of  the new style has been completed successfully  open file  03-
11.tca. In the composition assistant select the function Score and the newly created
style from the  Harmonization style drop-down list. Now click the  Compose button for
creating a score in the new style. tonica creates the learned harmonies. The chords do
not correspond to the original phrase because tonica has only learned the harmonies
but not the chord notes.

You can now use this newly created cadence style to generate simple phrases for new
melodies. Due to the short training sample this cadence style will generate only rela-
tively simple phrases, consisting of tonic, subdominant and dominant. To create a gen-
uine new style you need to employ more examples, although there is no standard rule
as to how many might be required. From our example you can see that even very few
examples can help to create a new style. However, to create a more complex style, like 
Bach for example, you would have to use 10 – 20 examples, each with a duration of an
average Bach chorale. The more characteristic examples you use the better the result.
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Importing a harmonization style

Use HARMONIZATION STYLES → STYLE ASSISTANT...  to start the style assistant which assists you in
importing an existing style.

How to import a harmonization style

• Select the tonica style file which has the extension (*.tsf).

• Define the style import options. When you import tonica files (if available) you
can continue working on the imported style.

Editing harmonization styles

Use  HARMONIZATION STYLES → STYLE EDITOR... to open the window for editing harmonization
styles. Here you can create, copy, change, delete, train, import and export styles.

The standard styles that come with tonica can not be edited. Styles for which no list of
tonica files is defined (see page 91), but only have the networks for composing, can not
be changed or trained.

How to create a new style

• Click the New button to create a new style.

• Click the Import button to import a style from a tonica style file.

How to edit a style selected in the style list

• Click the Copy button to create a new style from the one selected in the list.

• Click the Edit button (or double-click) to change the properties of the selected
style.

• Click the Delete button to delete the selected style.

• Click the Train button to start the style training process for the selected style.
Neural networks are trained that reliably mimic the harmonization style of the
given example files.

• Click the Export button to export the selected style.

• Click the Info button to get information about the selected style. This includes
the number of analyzed files and a training statistics which shows the classifica-
tion rates of the trained networks.

Click the Close button to close the style editing window.
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Creating, copying and changing a harmonization style

When creating, copying or changing a harmonization style, a dialog opens which lets
you define properties of the harmonization style. These include

• the Style name of the harmonization style

• a File list with training and testing files used to create the style

• the Learning parameters (button) for training the style

• the composition  Options (button)  which are  used as  default  values  for  the
style.

In order to be able to define a style meaningfully you need at least 10 - 20 example files. There are but -
tons in the dialog box for adding and deleting files from the file list.  When you have entered a style
name and copied example files to the file list you have done all that is necessary to create a style.

In order to be able to better judge the results of the style training you can define some
files as test files with the "Test" button. These test files are then not used for training,
but only to test the results of the style production. They are examined to see how well
style characteristics from the trained network compare with examples that have not
been part of the training process.

Learning parameters for style training

This dialog box lets you specify the learning parameters for style training. It is advisable
to train initially with the preset values. Changing the learning parameters can lead to an
improvement of the learning results. This is because it is not possible to automatically
determine a set  of  optimal  learning parameters,  since these are  dependent  on the
learning example files that are used.

The following learning parameters can be set:

• Number of learning iterations: The number of times tonica tries new rules and
compares them to the example and test files. The range is 1 to 500. The larger
the number the smaller the learning error, but the longer the process.

• Variable network size: This can be between 0 and 100%. In the case of 0% no
additional processing elements (called neurons in neural network techniques)
can be added to the network by  tonica (this compares to logistic regression).
More neurons means that more data can be compared and more processing
can be done. This can improve accuracy but will take more time.

• Style complexity: This can be set between (0,0) and (5,0). (0,0) tells tonica that
the complexity of the harmonization is not constrained. If you go to the other
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extreme of (5,0) you will get more conservative and less original harmoniza-
tions.

Automatic style analysis

Automatic style analysis is started if you change any of the files in the list of example
scores or if you change any of the analysis program preferences.

During style analysis all  the training and test files are analyzed harmonically and the
learning patterns for training the neural networks are created. The value set for  Dis-
tance for harmonic analysis for the harmonization style is used for the harmonic analy-
sis.

You are informed about any errors in the analysis protocol. At the end of the process
you can accept or reject the result.

Automatic style training

Automatic style training is started by the style assistant or by clicking the Train button in
the style editing window. The training process runs in the background, allowing you to
either continue using tonica for other purposes or follow the training process. During
style training all neural networks of the chosen style are trained. The following pieces of
information are learned by a separate network each:

• Harmonic function: This corresponds to the combo box „Function“ in the har-
mony input of the harmony representation Function theory.

• Harmonic Bass note:  This corresponds to the combo box „Bass note“ in the
harmony input of the harmony representation Function theory.

• Harmonic additions:  This corresponds to the combo boxes „Added notes“ in
the harmony input of the harmony representation Function theory.

• Passing notes: Learns the passing notes in the accompanying voices.

Different networks are used for major and minor keys, therefore each of the above
have major and minor networks created if there are major and minor scores in the ex-
ample score list. 

Progress of training is shown in minutes and a progress bar is displayed. After the train-
ing process you will see an analysis of the results. This compares the harmonies pre-
dicted by the trained networks with the actual harmonies. 100% would mean that the
actual harmonies were predicted completely accurately. The most important networks
are the ones that  predict  the harmonic function (the first  of  the four  groups listed
above).
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There is a difference in the predicted accuracy against the training scores and those
scores  designated by  you as  test  scores.  A high percent  against  the training scores
means that the network has learned well from the training pieces, whilst a high per-
centage against the test scores means that the networks can predict well when given
new pieces to harmonize. It is not effective to spend a lot of time trying to get the per-
formance against the training scores up to 100 %. The best use of time is to get similarly
high percentages against the test and training scores.

You can decide to abandon the trained networks if the results are poor.

Major and minor keys are usually left together in the examples file list. However,you can optimize the
networks separately if you wish by modifying the  Learning parameters. You will need to create two
styles with separate file lists, one with major and one with minor examples, to do this.

[style-import][Style import]Importing a harmonization style

You can import existing harmonization styles from other users of tonica and previous
versions of tonica. The Import button is available in both the style assistant dialog and
the style editing window. Both of these can be found in the Harmonization styles menu.

Select the tonica style file which has the extension (*.tsf). In the following dialog you
can select the options for importing the style.

Style import options

Select the style import options in this dialog. These are:

The Style name of the harmonization style to be imported.

If the tonica files for training the style are included in the style file: The  Destination
folder for tonica files to which these files should be copied. When you import tonica
files (if available) you can continue working on the imported style.

Exporting a harmonization style

You can export a style so that it can be used by other tonica users or in future versions
of tonica. The Export button is in the style editing window.

Select the name of the tonica style file to be exported. It will have the (*.tsf) extension.
You have the choice of exporting the file on its own or with the associated example
scores used to create it.

• Click Yes to copy all the example files along with the style. A future user will be
able to revise the style using the example scores.
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• Click  No to export the style file on its own. This is the set of neural networks
and is all that is needed to use the style to harmonize melodies. However the
recipient will not be able to modify the style.

Automatic harmonic analysis

tonica can automatically create chord descriptions for notes in a score. This is a useful
tool to understand what your input is and also for analyzing the great composers.

Harmonic analysis is based on the key of the score (i. e. modulations are not recog-
nized).  Using the interval  structure  of  the notes  in  the score  tonica recognizes  five
classes of chords:

• Major triads (sometimes with added seventh) 

• Minor triads (sometimes with added sixth) 

• Major triads with added sixth and/or minor triads with added seventh 

• Diminished chords (sometimes with added ninth) 

• Other chords (e. g. secondary chords)

Automatic examination of scores

The arrangement of notes in a composition is subject to rules being called composition
or voice-leading rules. Respecting these rules is to ensure that a smooth composition is
created which pays attention to the harmony of the voices as well as to a vocal and in-
dependent continuation of each single voice.

A distinction is made between rules for chord creation and rules for chord progression.
For example, a chord should generally be made of at least three notes (root, third and
fifth). The most well-known rule for chord progression is the interdiction of fifth and oc-
tave parallels i. e. the parallel  voice leading of two voices in fifth or octave distance
which would affect the independence of both voices. When checking a composition in
tonica, fifth and octave parallels are displayed with red lines. When tonica automatically
composes, it will consider the most important composition rules.

The importance of voice-leading rules in tonal music was often subject to change in mu-
sic history. In this respect these rules are to be seen as recommendations and not as
dogma. Nonetheless they help the student to understand why certain passages of a
composition just „don’t sound well“.

tonica is able to automatically examine voice-leading rules for a composition. You can
use this feature to have your own or foreign compositions controlled as to the observa-
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tion of these rules.  tonica will distinguish between errors when an important rule has
been violated and warnings when it is merely recommended to observe a certain rule.

As result of the examination note heads or harmonies where errors or warnings oc-
curred will be colored in red or blue. If you move the mouse over one of these note
heads or harmonies, a tooltip will  appear which displays the exact error or warning.
Multiple errors or warnings per note or harmony are possible. If you wish you can have
tonica correct voice-leading errors by right mouse clicking on a colored note or har-
mony.

Voice-leading rules in tonica

Here you will find an overview of voice leading rules applied in tonica. They are sepa-
rated into chord realization rules (apply to a single chord only) and chord progression
rules (apply to the transition from one chord to the next).

Important hint:  tonica will determine chords with the help of those harmonies which
were identified during harmonic analysis. Erroneously or not analyzed harmonies will
lead to errors in the examination of the composition. With intermediate chords which
may result from passing or changing tones between two chord functions, the chord
progression rules will be examined without taking these intermediate chords into con-
sideration. This is because often, such passing or changing tones only hide but not re-
ally fix rule violations. However, in case an independent intermediate chord is created, a
rule violation indicated by tonica might be invalidated. In this case it is recommended to
give the intermediate chord its own harmony either by entering the respective har-
mony or by harmonic analysis.

The following example will explain the problem:

The left image shows a rule violation (chromatic cross-relation of tone F in the Soprano
versus tone F sharp in the Bass). However, this is not really an error because the chord
transition is bridged over with an independent intermediate chord (fourth-sixth chord)
on the second eighth note. If you have this passage examined in eighth note intervals
after having selected „eighth note“ as a distance for the harmonic analysis, then the re-
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sult shown in the image on the right will be displayed for the same chord sequence.
Here, no rule violation but merely a warning is displayed telling you that in the interme-
diate chord, the bass tone was not duplicated.

Chord realization rules

Voice crossing rule (warning): Voices are not to cross i. e. within a chord, a lower voice
should not have a higher tone than in a higher voice.

Example:

Voice distance rule (error): The distance between Soprano and Alto is not to exceed
one octave. In close position the distance between Soprano and Tenor is not to exceed
one octave.

Example:

Dissonance rule (error): In neighboring voices within a a chord, tones in semitone dis-
tance are not allowed. Tones in whole tone distance should occur only once.
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Example:

Rule: Completeness regarding chord notes (error): In three-part chords, at least root
and third have to be present. In four-part chords, at least three chord notes have to be
present, especially the third.

Example:

Rule:  Completeness  regarding  chord dissonances  (warning): With  four-part  chords,
characteristic dissonances (such as the seventh with seventh chords) should be present.

Example:

Rule correctness (error): A chord may not contain tones not belonging to the harmony
(except for the characteristic dissonances specified in the harmony).
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Example:

Rule: Completeness regarding figured bass (error): In figured bass chords, all  chord
notes must be present.

Example:

Rule: Figured bass position name (error): With figured bass chords, position names
(numbers larger than 7) in the upper voices have to be considered, i. e. the added notes
have to appear in the Soprano or Alto (in the correct order).

Example:

Rule: Dissonance duplication (warning): Characteristic dissonances (for example the
seventh in seventh chords) should not be duplicated.
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Example:

Rule: Bass note duplication (warning): In fourth-sixth chords, the bass note should be
duplicated.

Example:

Rule: Third note duplication (warning): The third in the chord should not be dupli-
cated.

Example:

Note: In many textbooks you will find the claim not to duplicate the third (especially in
sixth chords). However, Diether de la Motte shows in his textbook „Harmonielehre“
with  appropriate  compositions  that  a  general  interdiction to  duplicate  thirds  is  not
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valid.  Statistically seen it strongly depends on the style you look at whether or not third
duplications are used: Samuel Scheidt rarely applies them in his chorales whereas you
will find them rather often with J. S. Bach. Thus this rule is to not be seen as a com-
mand but as a suggestion to reconsider voice leading.

Chord progression rules

Rule: Leaps (error): In a chord transition you are not to have too many large leaps, es-
pecially within one phrase.

Example:

Rule: Parallels (error): The parallel leading of two voices in perfect fifth or octave dis-
tance is forbidden. The same applies when during opposed movement in the same in-
terval, the distance between voices is plus or minus one octave (antiparallels). Also for-
bidden is the interval course from a diminished fifth to a perfect fifth.  The opposite in-
terval course is allowed.

Examples:

The first example contains several parallels:

• Fifth parallel in Soprano and Tenor

• Anti fifth parallel in Soprano and Bass
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• Anti octave parallel in Tenor and Bass

Please note that the rule (same as all other chord progression rules) is not invalidated
by intermediate notes (for example passing or changing eighth notes) even if you will
not see any red lines in the composition any more (in this example due to the interme-
diate note D in the Soprano).

The second example contains the fifth course diminished-perfect in Soprano and Tenor.

Rule: Resolve dissonances (error or warning): Characteristic dissonances (for example
the seventh in seventh chords) have to be resolved stepwise in the same voice. You will
receive a warning when the dissonance is resolved in a different voice.

Examples:

Note: In some textbooks you will find the demand that in dominant seventh chords, the
third is always to be resolved stepwise upwards and the seventh stepwise downwards.
When analyzing appropriate compositions (for example Bach chorales) you will find that
this demand is permanently violated and that the direction of resolution is less impor-
tant than the requirement to always resolve dissonances stepwise (upwards or down-
wards).

Rule: Cross-relation (error): Cross-relation means a semitone or tritone interval allo-
cated to two voices. The chromatic cross-relation is forbidden, i. e. the chromatic suc-
cession of notes of two chords in separate voices (for example when suspensions are
resolved).
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Example:

Automatic cadences

The tension and movement of a composition comes in large part from carefully con-
structed chord sequences which are called cadences. tonica will fit predefined cadences
into your score if requested. These are derived from the styles libraries and therefore
will allow you to benefit from cadences created by past great composers. They will be
inserted at obvious phrase ends and other places  tonica feels are appropriate. In this
way a more flowing composition is created, and you can learn how cadences can be
used as a structural element of a score.

The chord descriptions for the inserted chords of the cadence are colored and if you
rest the pointer over them or right mouse click on them you will see the following infor-
mation on the origin of the cadence:

• Composer

• Title of work

• Text line of the cadence

• Score line number

• Start position in sixteenth notes; for partial cadences this is the position of the
inserted piece

• Classification Perfect or Imperfect 

• Type of cadence (G = perfect cadence, HD = imperfect cadence, HDD = imper-
fect cadence ending on the double dominant, HS = half close on the sub-dom-
inant, HZ = half close on the secondary dominant, T = interrupted cadence)

• Idiom (A = authentic, ADW = authentic double idiom, AE = authentic introduc-
tion, AP = authentic pendulum, APHR = authentic phrygian half conclusion, OV
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= without usual preparation, P = plagal, PE = introductory plagal, PP = plagal
pendulum)

• Chord immediately  preceding the cadence (S  = subdominant,  Dd =  double-
dominant, Z = secondary dominant)

• Penultimate, i.e. characterisation of the next to last harmony of the cadence,
i.e. the first chord of the cadence

• Editor of the cadence

Note: You will also get the cadence information if you right click one of the cadence harmonies with
the mouse and then select the Info command from the context menu.
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capella-tune
capella-tune is used by  capella and other programs in the  capella suite to play back
capella scores and to convert them into MIDI files. This process takes into account nu-
merous settings from within the  capella file, e. g. accidentals, dynamics, piano pedal
marks,  trills  and  ornaments,  repeats,  swinging  rhythms,  historic  tunings  and  many
more. These features are configured on the various tabs of the capella-tune dialog.

Furthermore capella-tune provides an interface to Soundfonts and VST plug-ins. This in-
terface provides you with access to the wide world of sample libraries like capella Vi-
enna orchestra.  Sample libraries contain the recorded sounds of genuine instruments.
Soundfonts are a special type of sample libraries that can be used directly by capella-
tune. Both methods improve the quality of playback substantially. Sample libraries also
include special sounds for different performance marks, e. g. legato/staccato, sforzato,
pizzicato/arco, tremolo, with/without damper, drum roll etc. capella-tune can evaluate
the performance instructions and automatically assign the correct sounds from the lib-
rary. For more details about the VST interface see page 131.

Use of capella-tune in the different programs

➔ How to open the capella-tune  dialog ➔ How  to  select  the  playback
device

capella 
reader 8

• EXTRAS → SOUND CONFIGURATION...

• Keyboard shortcut: 
ÁÍ ÍÔÍ É+ÁÍ ÍãÍ É+ÁÍJÉ

• capella-tune  dialog →
INSTRUMENTS → PROFILES

capella 8 • EXTRAS → PLAYBACK → SOUND 
CONFIGURATION...

• Keyboard  shortcut:
ÁÍ ÍÔÍ É+ÁÍ ÍãÍ É+ÁÍJÉ

NB: MIDI sound cards as well as VST plug-ins and Soundfonts can be selected as playback device.

NB: On the capella-tune tab INSTRUMENTS you can assign a different playback device and sound to each in-
strument of your capella score. By selecting a device as PROFILE, all instruments will be set to this sound
card or sample library.
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➔ How to select the playback device in capella:

With capella 7 and the capella file format CapXML 2.0 you can already select the device
and sound for each individual voice in the System Template of the capella score. There
you have two options:

• Set the DEVICE to UNSPECIFIED and select an instrument in SOUND. This way the capella
score remains independent from the sound libraries and sound cards installed on
a  specific  computer.  The  actual  sounds  during  playback  are  taken  from  the
INSTRUMENTS tab. 

• Alternatively, select a specific device and a specific sound already in the System
Template. These settings will be saved in the capella file. If you transfer the file to
another computer the specified sounds may not be available. In this case the
INSTRUMENTS tab will be searched for adequate substitutions.

Tabs of the capella-tune dialog and chapters of capella-tune user guide

• Playback Devices: Install and configure your VST plug-ins. See page 106.

• Instruments: Define  which  instruments  have  which  articulations  and  which
sounds must be used for these. For sounds you can assign those of your MIDI
sound card and those from your VST plug-ins and Soundfonts. See page 110.

• Articulations: Define how the various articulations are represented in the score.
See page 112.

• Dynamics & Rhythm: Define the volume for various dynamics and tone duration
for various articulations. Define special rhythms e. g. swing or Viennese Waltz.
See page 114.

• Repeats: Repeats and jumps (like da-capo) are defined directly in the score. De-
tails are explained here: page 117. There are no further configuration options in
the capella-tune dialog. Repeats and jumps can be turned on and off globally in
the playback options of the main program.

• Trills & Ornaments: Define how the various trills and ornaments are to be played
back. See page 121.

• Tunings: Activate and sample various historic tunings or switch on Hermode Tun-
ing. The latter is a special method that automatically tunes chords for just intona-
tion. See page 125.

• MIDI options: Define various parameters which are mainly relevant for the MIDI
file export. See  page 129.

• VST plug-ins and Soundfonts: Information on setting up VST libraries and Sound-
fonts can be found here: page 131. 
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Playback Devices 

capella-tune  dialog, Tab  PLAYBACK DEVICES

This dialog box assists you in administering VST plug-ins and Soundfonts. In order to se-
lect any of these for playback please refer to the tab INSTRUMENTS, see page 104.

MIDI Output Devices

This section lists all MIDI output devices of your PC.

State

The State column shows which devices are opened at the moment. For VST plug-ins and
Soundfonts it is indicated if they are already loaded into memory. You can close the
devices and free the memory by context menu. 

Delay

With every MIDI or VST device there is a delay between a note being touched and the
sound being played back. This delay usually amounts to only a few milliseconds and
should not pose a problem. However, as soon as you use several playback devices sim-
ultaneously for separate voices of a capella score you may find that some voices drag
behind others, if the delay of the different devices is not identical. To synchronize all
devices you can modify the delay. There are no known rules to this, only trial and error
will lead you to an acceptable result.

Wave Output Device for VST/SF2

Soundfonts and VST plug-ins are virtual devices that compute the sound wave. Once
computed, a sound is sent to a real Wave-out device which you can select here.

CPU: The ratio between calculation time and duration of the calculated sound is indic-
ated.

THREADS: This setting determines the number of threads that are deployed to calculate a
data packet. Using more than one thread allows parallel calculation of voices/instru-
ments.  This  can be an advantage with multi  core processors and with streaming
based plug-ins that continuously load samples from the hard disk.

BLOCKS AND BLOCK SIZE:  The sound is calculated in blocks corresponding to a certain dura-
tion. While one block is sent to the speaker the next samples are already prepared
in another block. Therefore, at least two blocks are required. The blocks should be
small  in order to minimize the time lag between calculation and output.  On the
other hand, some calculations might take a bit  more time, e.g.  because samples
have to be loaded from the disk, and such delay can be better tolerated with larger
blocks. In short, choose a block size as small as possible. If the sound is crackling se-
lect a larger block size.
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VOLUME: Use this slider to control the volume of all Soundfonts and VST plug-ins, which
allows in particular to adjust it to the volume of MIDI devices.

VST Plug-Ins and SF2 Soundfonts

This  section  lists  all  VST  plug-ins  and  Soundfonts  that  have  been  registered  with
capella-tune, see below how to add and remove them. 

VST Effects

VST effects are filters that can – for example – apply cathedral type acoustics to the oth-
erwise dry studio recordings of the sample library.  VST effects will  always affect the
overall sound, i. e. all voices of your score.

NB: VST effects are only applied if you play back using your sample library or soundfonts. If you play
back via your MIDI sound card the VST effects will not be utilized.

VST effects will be applied in the sequence in which they are listed. You can re-arrange
this sequence via the context menu where you can shift the plug-ins up or down in this
list.

In the STATE column of this list you can switch the plug-ins on or off.  

Double click the name of an effect in the list to open the effect's own control dialog,
where you can set certain parameters. If the plug-in offers a list of pre-defined settings
then these can be selected from the context menu: LOAD VST PROGRAM that opens when
you right-click the plug-in name in the VST Effects column.

Add / Remove...

Click ADD / REMOVE... to install new VST plug-ins, Soundfonts or Effects, and to remove ex-
isting ones. Another dialog will pop up, see page 108.

Configure...

Click here to set up a plug-in for capella-tune, see page 132.

Tuning Test...

Click here to analyze a plug-in's capabilities for micro tuning, see page 109.

Plug-In Dialog...

Click here to open a plug-in's own control dialog, in case the plug-in provides one.
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Close All Plug-Ins

In principle, plug-ins are kept in memory after playback, so that they can be re-used im-
mediately when the next playback starts. Click here to close them, otherwise they re-
main open until the program quits. To close individual plug-ins use the context menu of
the STATE column.

Default Sound

The default sound is used for testing playback devices. It is also used on the tabs TRILLS &
ORNAMENTS and TUNINGS to try out the settings. On the tab INSTRUMENTS it can be set as a uni-
versal sound for capella scores.

MIDI RESET: Click this button to set the playback device to its default values.

Add and Remove Plug-ins

capella-tune  dialog, Tab  PLAYBACK DEVICES → ADD / REMOVE...

The dialog is organized in three parts:

• The list on the left side shows plug-ins found on the web that are recommended
by capella-software. These plug-ins are products of other manufacturers and can
be downloaded free of charge. The latest content of this list will be downloaded
and displayed only after you have clicked DOWNLOAD LIST OF PLUG-INS, because we want
you to determine when capella-tune connects to the internet.

• The list in the middle shows files on your computer.

• The list on the right side shows plug-ins that are already registered with capella-
tune.

➔ How to register a plug-in that is already present on your computer

1. Select a plug-in in the file list (middle list).

2. Click the blue arrow between middle and right list. The plug-in will be opened
and registered. The registration won't be permanent unless you close the dialog
with OK.

NB: Define your favorite folders by clicking on the yellow star button. You can recall them easily by
the drop down list.

➔ How to download and register a plug-in

1. If necessary click DOWNLOAD LIST OF PLUG-INS in order to fill the list on the left side.
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2. Select a plug-in in the list on the left. 

3. Under FOLDER select a destination folder on your computer. 

4. Click  the blue arrow between left  and middle list.  The plug-in  will  be  down-
loaded, saved, opened and registered. The registration will not be permanent un-
less you close the dialog with OK.

➔ How to deregister a plug-in

1. Select a plug-in in the list on the right.

2. Click the red trash can above the list. The deregistration will not be permanent
unless you close the dialog with OK.

Unfortunately, it is sometimes not possible to identify the sounds provided by a plug-in.
It might be necessary to configure the plug-in for capella-tune, see page 132.

NB: The capella Vienna orchestra  is automatically registered with capella-tune and is optimally con-
figured.

Tuning Test

If you work with historic tunings or Hermode Tuning (see page 125), the pitch of each
tone has to be slightly modified. Several MIDI and VST instructions are available for this
purpose, but not all of them are equally supported by all devices. We therefore recom-
mend that you test the tuning for each device so that capella-tune knows which options
are available. You start the test from the capella-tune dialog, Tab PLAYBACK DEVICES.

The following instructions will be tested:

PITCH BEND (MIDI  COMMAND E0): This instruction should be understood by all devices. The
disadvantage  of  this  instruction  is  that  individual  notes  cannot  be  corrected.  A
device can only be tuned higher or lower in its entirety. Therefore a chord can only
be tuned properly if each note of the chord is played back on a different device.
capella-tune can circumvent this  problem on MIDI devices by splitting the notes
across separate MIDI channels.

SINGLE NOTE TUNING:  This option allows you to tune individual notes. Unfortunately very
few devices support this instruction.

VST: This option also allows you to tune individual notes. However, this instruction is
only available on VST devices, and only in the non-real-time version.

REAL-TIME:  In this context  real-time means that sounding notes can be retuned after-
wards.

NON-REAL-TIME: Notes can be struck at any pitch, but cannot be retuned afterwards. This
will be sufficient for historical tuning. Dynamic Hermode Tuning, however, requires
real-time functionality.
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Instruments

capella-tune  dialog, Tab  INSTRUMENTS

Here you can determine how the individual capella instruments will sound during play-
back by setting the playback device (see  page  111) and the sound (see  page 111) for
each instrument. Furthermore, you can create individual articulation entries (see page
110) for each instrument, to define which specific sounds should be used for the vari-
ous articulations. In columns VOL (volume) (see page 111) and PAN (panorama) (see page
Fehler: Referenz nicht gefunden) you can individually set volume and stereo position re-
spectively.

Example: You want to play back the score of a violin sonata. In the System Template of
capella, you have set the instrument to “violin”. This setting points to the entry “violin”
in the column  CAPELLA INSTRUMENT. On the same row of this instrument select a playback
device and a suitable sound for the violin. You can create additional entries via the
right-click context menu of the violin for special articulations, e. g. for pizzicato. This
way you can select a suitable sound for the plucked violin. During playback,  capella-
tune will then automatically use the pizzicato sound whenever it encounters the relev-
ant articulation symbol in the score. The ARTICULATIONS tab (see page 112) is used to define
which instruction symbol will  switch on/off the pizzicato sound. You can also define
completely new articulations there.

NB: You can already select specific sounds in the capella System Template. In this case the instrument
list of capella-tune will be ignored unless you select DEVICE = UNSPECIFIED in the System Template. The lat-
ter setting is recommended to make the capella file independent from locally installed sound cards and
sound libraries. 

➔ How to mark several fields to apply a common value

• To select several individual fields click the fields while pressing down ÁÍ ÍãÍ É.

• To select a continuous list click the first field and while pressing down ÁÍ ÍÔÍ É click
the last field.

Column: capella Instrument

Then right-click an instrument name to open a context menu which offers the following
options:

• Option NEW ARTICULATION ENTRY creates an initially blank entry for the marked instru-
ment. Right-click this new entry to select one or more articulations from the con-
text menu. The list of available articulations can be edited on the ARTICULATIONS tab
(see page 112).

• You can also remove an articulation entry via the context menu.
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• Option OPTIMIZE FOR resets all sounds and articulations for the marked instrument
to the optimum value of a playback device.

NB: To optimize the entire list of instruments for a particular playback device simply select the relevant
device under PROFILES at the bottom of the INSTRUMENTS tab (see page 112).

• At the bottom of the instruments list you find the percussion channel where the
context menu offers an option to ADD PERCUSSION SOUND. Here you can add your own
entries for specific percussion tones to assign your own sounds to these tones.
The main entry PERCUSSION CHANNEL determines the settings for all percussion tones
that do not have their own entries.

• If VIEW is set to GENERIC you can choose in the context menu of each instrument to
distinguish between SOLO and ENSEMBLE sound.

Column: Extent of Notation

This is the second column, labeled by the symbol  . Use the context menu to select
whether an instrument refers to an individual voice or all voices on a staff or even sev-
eral staves in a capella score. This setting determines the scope of articulations (e.g. pi-
ano pedal) and the assignment of capella voices to MIDI channels and VST instances.

Column: Playback Device

Use the context menu to select the playback device for each marked entry. You can se-
lect from all MIDI devices (sound cards) and VST plug-ins and Soundfonts (see  page
131) that are installed on your PC. You can register additional VST plug-ins with capella-
tune on the PLAYBACK DEVICES tab (see page 106).

Column: Sound
Use the context menu to select the sound for the marked entries. For MIDI devices you
have a choice of the standard MIDI sounds. For VST plug-ins and Soundfonts the choice
depends on the range of options of the plug-in.

Column: Vol
Right-click the displayed value for each instrument to access a volume slider and an edit
field. The volume setting in this column is a percentage of the volume setting in the
capella System Template, i. e. you can increase or decrease the volume of individual in-
struments. The default value is 100%. 
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Same sound for all instruments
This  setting will  deactivate the  INSTRUMENTS tab.  Use this  setting to achieve a uniform
sound for all voices without considering the different instruments and articulations. The
sound to be used is the DEFAULT SOUND on the PLAYBACK DEVICES tab (see page 108).

View: MIDI / Generic

This setting determines the sorting order of the instruments displayed in the list. The
MIDI view is common computer standard, but the range of instruments is limited and
the sorting order is not always intuitive (e. g. kettle drum with the strings). The GENERIC

view is based on capella's score wizard. It contains more instruments and is structured
in a musically more systematic way.

Preset profiles on Instruments Tab

Open the PROFILES drop-down list to load one of the preset profiles. 

Click ORGANIZE... to open a menu with options to create and administer your own profiles.

Click APPLY to save your changes of the current tab. If you have modified a standard pro-
file,  a new profile will  be created containing the addition “(modified)” in the profile
name. To return to the previous state click ORGANIZE → RESET TO PREVIOUS STATE.

Click  OK to save the current settings on all tabs, or click  CANCEL to dismiss all changes
that have not yet been saved.

Articulations

capella-tune  dialog, Tab  ARTICULATIONS

This table shows how the different articulations are identified in the score. The identi-
fication can be achieved by note attributes, capella symbols or text objects.

Some articulation signs have to be anchored to each affected note, e.g. tenuto marks,
while others can be set to indicate the beginning and end of a section, e.g.  pizzicato
(plucked) and arco (bowed).

You can define any number of identifications for each articulation. The articulation will
be activated as soon one of the identifications is present in the score.

The entries in the articulation list are required for the following features:

• Distinction of articulations on INSTRUMENTS tab (see page 110).

• Generation of special rhythms on the DYNAMICS & RHYTHM tab (see page 116).
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The settings for ATTACK INTENSITY and NOTE SHORTENING  on the tab are not affected by the ar-
ticulation list.

Column: name

Right-click any entry to open the context menu, which allows you to create, delete, re-
name and reorder articulations.

The sequence of articulations in this table is of relevance when no entry can be found
which exactly matches the identifications presented in the score. Example: Let's assume
you have created two articulation entries,  pizzicato (plucked) and marcato (emphas-
ized),  for instrument violin in the list  of instruments and you have assigned specific
sounds to both of them. As capella-tune reads a capella score it encounters an emphas-
ized pizzicato, but no specific sound has been defined for this combination.  capella-
tune therefore has to decide which of the two sounds to use. This is where the se-
quence of entries in the articulation list is of importance. In our example it is obviously
preferable to use the pizzicato sound and not the marcato sound, which is only bowed.
This is why the pizzicato setting must be higher up in the list than the marcato setting.

Column: articulation sign

Define the articulation sign that must be present at all relevant notes. You can define
several identifications per articulation via the context menu. For each entry you can
choose the type of identification marks from the context menu (see page 113).

You can also define a grouping symbol like a bracket or a wavy line. This will extend the
articulation across the entire group.

The entry BRACKET in the sub-menu GROUPING refers to both repeat box brackets and tuplet
brackets. When entering these brackets in a capella score you need to deactivate the
number.

The  context  menu option  ENTRY DEFINES EXCEPTION allows you to  exclude  specific  notes
within an articulation section.

Section Start and Section End

Set the beginning and end of an articulation section. You may define several entries via
the context menu. For each entry you can define any of the possible entry types from
the context menu (see page 113). The start and end instructions are not paired, i. e. any
type of entry may start the articulation, while any non-related type may end the in-
struction.  Simply put,  any instruction in the second column will  end any instruction
from the first column.

Types of Articulation Marks
TEXT: Enter the text that you have previously inserted as a text object into a  capella

score. You may add an underscore "_" as the last character to enable finding text ob-



tonica fugata 13114 

jects that are longer than the entry, i.e.  pizz_ will respond to text objects like  piz-
zicato, pizzikato, pizz, etc.

SPECIAL NOTE HEADS:  Select rhombus heads, triangular heads, etc.
ARTICULATION SIGNS:  Select any of the signs from the sub-menu. These can be entered into

the capella score either as note attributes or as music symbols.
ORNAMENTATION SIGNS:  Choose any symbol from the sub-menu.
ALL CAPELLA SYMBOLS:  For the sake of completeness we include this option, although all

common symbols are included in the above options.
TREMOLO BARS: Select numbers 1 to 5.

Preset Profiles on Articulations Tab

Open the PROFILES drop-down list to load one of the preset profiles. 

Click ORGANIZE... to open a menu with options to create and administer your own profiles.
You can for example save a preset profile in a file and transfer it to another computer.
Select MERGE FROM FILE to load a file and integrate the articulations into the current list. Se-
lect IMPORT FROM FILE to replace the current list.

Click APPLY to save your changes of the current tab. If you have modified a standard pro-
file a new profile will be created with the addition “(modified)” in the profile name. To
return to the previous state click ORGANIZE → RESET TO PREVIOUS STATE.

Click  OK to save the current settings on all tabs, or click  CANCEL to dismiss all changes
that have not yet been saved.

Dynamics & Rhythm

capella-tune  dialog, Tab  DYNAMICS & RHYTHM

Dynamic Levels

On the left side of the dialog you can set the attack intensity for all  dynamics from

 to . Attack intensity will also influence tone quality, contrary to the volume

 will be played back as forte at the beginning with a subsequent decrescendo to pi-

ano during the first beat.
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Articulation Sign

On the right side of the dialog you can set the ATTACK CHANGE and NOTE SHORTENING  for selec-
ted articulation signs. 

The ATTACK CHANGE is a relative value in percent referring to the current dynamic setting.
Example:

• Set ATTACK INTENSITY on the left for piano ( p) to 67 and for forte ( f ) to 110.

• Set ATTACK CHANGE for sforzato (sf) to 150%
• Now a note marked sforzato will be played back with an attack intensity of 100.5

in a piano section (67 * 150% = 100.5). In a forte section the sforzato note would
be played with an attack intensity of 165 = 110 * 150%. However, the latter value
would be reduced to 127 as this is the maximum value.

NOTE SHORTENING can be set via its right-click context menu either as a relative value or as
an absolute value. The relative value refers to the note value, while the absolute value
indicates the rest in milliseconds before the next note. This is particularly useful for
broad articulations like tenuto and portato.

At the end of the list you find the setting for arpeggio. An arpeggio sign means that the
notes of a chord will not be played back simultaneously, but in succession. The value
entered at NOTE SHORTENING indicates the time between the successive sounds. Setting the
value to “0” switches the arpeggio function off. 

crescendo and diminuendo (decrescendo)

Crescendo hairpins  and text instructions like  cresc. and  dim. will  be considered. You
may define additional instructions with the  crescendo and  diminuendo entries on the
Articulations tab. The length of the hairpin is irrelevant. De/crescendo will always be
stretched from the start of the hairpin to the next dynamic sign or to the next reverse
hairpin. In cases where no target volume is indicated in the score you can set the num-
ber of dynamic gradations required.

Changes in volume for sustained notes will be considered by capella-tune as far as the
respective instrument is capable of doing so. Naturally, changes of volume within a sus-
tained note are not possible for  pianos,  plucked instruments and percussion instru-
ments,  while  string  instruments  and wind instruments  are capable  of  changing the
volume. In cases where a sustained note contains two opposing hairpins the note will
be split into two tied halves.

Include dynamics during playback
This option switches the inclusion of dynamics control on or off.
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Preset Profiles on Dynamics & Rhythm Tab

Open the PROFILES drop-down list to load one of the preset profiles. 

Click ORGANIZE... to open a menu with options to create and administer your own profiles.

Click APPLY to save your changes of the current tab. If you have modified a standard pro-
file a new profile will be created with the addition “(modified)” in the profile name. To
return to the previous state click ORGANIZE → RESET TO PREVIOUS STATE.

Click  OK to save the current settings on all tabs, or click  CANCEL to dismiss all changes
that have not yet been saved.

Special Rhythms

Distinctive rhythms like swing or Viennese Waltz are defined in this list.

ARTICULATION: Right-click to open the context menu and select one of the articulations (see
page 112) to define how this special rhythm is indicated in the capella score. 

GROUP OF NOTES: Define the size of the group of notes whose rhythm must be modified.
Right-click the number and/or the duration of the note to pick a suitable value from
the context menu.

PROPORTION OF NOTE DURATION: For each note of the rhythm group you find a numeric value.
These values indicate the duration relationship between the individual notes, which
is also indicated by the length of the green bars. The numeric values can be edited
via their context menu or by pressing ÁÍFÍ2É. It is irrelevant whether you specify the re-
lationship as 2:1 or as 200:100. The sum of all  numeric values does not have to
amount to a specific value. If you want to compare the tone durations with their ori-
ginal duration we recommend that you start off with e. g. 100:100 and maintain the
total sum. 120:80 would then indicate that the first note will be lengthened by 20%
while the second note will be shortened by 20%.

Example: Swing Rhythms

A swing rhythm is usually notated with normal eighths, where the first eighth is played
a little longer and the second eighth is played a little shorter, approximately in a ratio of
2:1.

    

The identification of swing in the capella score is defined on the Articulations tab. You
can switch on swing rhythm with the text object  swing and switch it off with another
text object, e. g.  straight. To interpret individual pairs of eighths as swung you might
also attach a triplet bracket in the score. 
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NB: Do not format the eighth note as triplet, attach a triplet bracket as a graphic object to the notes. To
interpret  individual  pairs  of  eighths  within  a  swinging  section  as  normal  you  can  attach  a duplet
bracket. 

The ratio of the duration of the two swinging eights is defined on the tab DYNAMIC &
RHYTHM under SPECIAL RHYTHMS, column PROPORTION OF TONE DURATION. Here you see two values
which represent the length of each note. The default value of 125:75 is something in

between triplet rhythm (133:67) and regular (100:100).

Example: Viennese Waltz

With a Viennese Waltz the second beat is a little early, while the third beat is a little
late.  You will  get  usable results  with a  setting of  75:130:95 or  –  more moderate  –
85:115:100. These values have been selected to total 300. This helps to interpret each
number as a percentage in relation to a uniform 3/4 time with the values 100:100:100.

There is no specific notation for the Viennese Waltz rhythm. It is usually applied intuit-
ively, mostly in the accompaniment rather than in the melody voice. It is a lot of work
to properly set up a  capella score for this rhythm. We have defined the text objects
WrW (derived from the Austrian Wiener Walzer) and NrW (normal Waltz) on the Articu-
lations tab as on/off instructions. You can insert these text objects into your  capella
score. To hide them from view format them with text color white.

Include Special Rhythms During Playback

This option switches the inclusion of special rhythms on or off.

Repeats & Repetitions
All kinds of repeats and repetitions are controlled by musical instructions in the score,
where the guidelines of this chapter should be taken into account. Repetitions and sec-
tion repeats can be globally turned on and off in the playback options of the main pro-
gram (e. g. capella, capella-scan, …).

Repetitions

Repetitions are played back as usual. Nesting is possible. If the opening repeat sign  is
omitted, repetition starts at the beginning, or – if present – at the last final double bar-

line .

Repetitions in a da capo section are usually not repeated. If this is still  required the
jump instruction must be supplemented with  con rep. This is derived from the Italian
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“con repetizione” = with repetitions. Example:  da capo al fine con rep. = repeat from
the head (beginning) to the end with repetitions.

Repeat brackets are acknowledged. Multiple repeats can be realized with appropriate
bracket numbering. E.g.:

In order to play back a normal repeat several times you can anchor a repeat bracket dir-
ectly to the repeat measure and open the bracket on the left side. You might choose to
format it invisible. 

The scope of repeat brackets must be set to “Entire System” in capella.

If you deactivate repeats in the playback options of the main program you can decide
whether the first repeat box should be skipped. 

Section Repeats (da capo and dal segno)

There are repeat marks (e. g. segno) and repeat instructions (e. g. dal segno). Both are
defined in text objects, either as text or using music symbols. The scope of the objects
must be set to “Entire System” in capella, see capella menu DRAW → EDIT OBJECT → POSITION

→ SCOPE. In capella versions older than 7 (or capella file formats older than capXML 2.0)
the objects must be anchored to the first voice used in the current system. 

Repeat Marks
The chronological position of repeat marks corresponds to the beginning of the note to
which they are anchored.

The following repeat marks are available:

as text: capo segno coda fine

as music symbol:
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capo is usually defined as the beginning of the file or the movement but may be placed
in a different position if so required. Any system where the automatic measure number-
ing is reset is considered a new movement. The text mark segno can basically be used
for both symbols shown in the above table. If in doubt it will be identified with the first
symbol.

Repeat Instructions
The chronological position of repeat instructions corresponds to the end of the note to
which they are anchored. Therefore these instructions must be anchored to the last
note of the old section.

• Repeat instruction da <mark>: The section between <mark> and repeat instruc-
tion is repeated. The following example creates the sequence A-E, B-F.

Repeat instructions can begin as follows:

as text:
da ...
d. ...
dal ...

Abbreviation for
da capo:

d.c.

Abbreviation for
dal segno:

d.s. 

as music symbol:

• Repeat instruction da <mark1> al <mark2>: The section between <mark1> and
<mark2> is repeated. Afterwards continuation begins after the repeat instruc-
tion. The following example creates the sequence A-E, B-C, E-F.

Repeating the second repeat mark will create the following sequence: A-E, B-C,
D-F.

All parts of a repeat instruction da ... al ... must be placed inside the same text object.
Concatenation of several text objects will not be recognized. Repeat instructions which
are a combination of text and symbols therefore must have the form of a Freeform text.
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• Examples:   al ,  D.  al 

Repeat Signs

Repeat signs indicate the repetition of the last group of notes ( ), or last measure ( ),

or the last two measures ( ). In  capella these signs are text objects without note
value.  For  capella-tune to  interpret  these  correctly  during  playback  they  must  be
anchored to a rest, which is then formatted as invisible. These rests are shown in gray in
the following illustrations.

The repeat sign for the last group of notes must be attached to a rest that - through its
value - indicates the length of the group.

Measure repeat signs must be attached to a whole-measure rest.

Double measure repeat signs may be attached to the first or second whole-measure
rest.

Abbreviations

Tremolo bars are used to indicate rapid repetition of notes. The number of bars indic-
ates the note value of a single note, which will be repeated until the overall note value
is reached.

  =             =  
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Triplet note repetitions can be achieved by placing a triplet bracket above the note.

Example: A quarter with one tremolo bar and triplet bracket above will generate three
triplet  eighths.  The quarter note itself  must be either  a regular  quarter or a triplet
quarter with a dot. It depends on the context, which notation is more suitable.

  =      or      =   

NB: Tremolo bars are also used to indicate tremolos and drum rolls, see roll on the ARTICULATIONS tab. If
the roll articulation has been assigned to an instrument on the INSTRUMENTS tab (e. g. timpani for capella
Vienna orchestra), capella-tune will play back a sustained note with roll sound.

Trills & Ornaments

capella-tune dialog, Tab TRILLS & ORNAMENTS

These symbols belong to the group of trills and ornaments: , , , ,  as

well  as  grace  notes  and  passing  appoggiaturas,  i. e.  miniature  notes  without  value.
There are  certain  conventions  on how to play  these ornaments,  depending  on  the
epoch and the composer, but ultimately taste and skill of the musician will influence the
interpretation. The dialog indicates for each trill and ornament how it is played back,
e. g.:

Right click the staff to select another playing variant from the drop-down list. Click the
speaker symbol to play back. The default sound will be used which is set on the tab
PLAYBACK DEVICES.

The displayed note values should not be seen as absolute values as they depend on the
playback tempo. With faster tempos the note values will increase to avoid “unplayably”
fast trills. The note values will be shortened only if an ornament does not fit into the
value of the main note.

Tempo indicated 16th will be played as...

quarter = 40 to 80 32nd
quarter = 81 to 160 16th
quarter = 161 to 320 eighth
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Trills

Accidentals for the auxiliary note can be placed as a text symbol above the trill symbol:

                  

FULL LENGTH TRILLING: capella allows you to indicate a trill by setting either a trill symbol or a
wavy line. You can decide for both cases whether the trill should be sustained along the
entire note. Otherwise only two trill beats will be played.

TRILL FROM ABOVE: Here you select the cases which lead to trills beginning with the auxiliary
note.

• with grace note
• preceding note is higher
• preceding note has same pitch as auxiliary note
• preceding note has same pitch as principal note
• preceding note is lower

Combinations with passing appoggiaturas are also possible:

    

Upper mordent, mordent

                  

Turn, Inverted Turn
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With a normal turn the ornament is first placed above and then below the principal
note. The opposite applies to inverted turn. The inverted turn is either marked with a
single line or a mirrored symbol.

Accidentals for the upper auxiliary note are positioned above the turn symbol, accident-
als for the lower auxiliary note are placed below:

        

In this example the turn symbol is not positioned above the note, but above the gap to 
the next note. These cases are dealt with separately in the trill dialog.

Single Grace Notes

Single grace notes can have three different functions:

Acciaccatura  before  the  beat:  The  preceding  note  is
shortened. The grace note is played before the stroke.

Acciaccatura on the beat: The grace note is played on the
beat and the main note is shortened accordingly.

Passing appoggiatura: The grace note assumes half  the
value of the main note (or more if the main note is dot-
ted).

There are no general rules as to how to notate which grace note. You may therefore set
the interpretation individually for the following notations: crossed out eighth, normal
eighth (or longer note values), 16th note (or shorter note values). An acciaccatura be-
fore the beat is symbolized by a barline before the main note.

For two or more grace notes you can determine whether the notes should be played
before or on the beat.
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Single Grace Note Preceding a Trill

Single grace notes preceding a trilled note are merged into the trill according to the set-
tings at

 .

This setting is used for all notations of grace notes, whether crossed out or not. How-
ever, the following conditions apply:

• In the TRILLS dialog the function of this type of grace note must not be set to
"passing appoggiatura", see preceding section.

• In the capella score the grace note has to be formatted as  "appoggiatura" and
not "passing appoggiatura". 

Otherwise grace note and trill are interpreted separately.

Include Trills and Ornaments During Playback
This option will switch on or off the inclusion of trills and ornaments during playback.

Preset Profiles on Trills & Ornaments Tab

Open the PROFILES drop-down list to load one of the preset profiles. 

Click ORGANIZE... to open a menu with options to create and administer your own profiles.

Click APPLY to save your changes of the current tab. If you have modified a standard pro-
file, a new profile will be created with the addition “(modified)” in the profile name. To
return to the previous state click ORGANIZE → RESET TO PREVIOUS STATE.

Click  OK to save the current settings on all tabs, or click  CANCEL to dismiss all changes
that have not yet been saved.
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Tunings

capella-tune  dialog, Tab TUNINGS

What are Tunings?

Modern musical instruments (and computers) divide an octave into 12 equal half step
steps. The advantage is that any given interval or chord will always sound alike, regard-
less of the starting note. The disadvantage is that except for the octave, no interval
sounds perfect. Minor beatings will always be audible. This tuning is called equal tem-
perament tuning.

When is an Interval Perfect?

All string instruments, wind instruments and the human voice have a harmonic over-
tone spectrum. In this case harmonic means that the frequencies of the overtones are
integral multiples of the tonic. We sense an interval to be perfect when many overtones
match precisely without any friction. It follows that the frequencies of the tonics or
roots must also relate to each other in integral proportions.

Where is the Problem?
With equal temperament tuning the integral frequency proportions are relatively well
approximated, though not exactly met. To properly tune a chord the individual pitches
need to deviate slightly from the equal temperament tuning. All qualified musicians will
do this automatically as far as their instrument allows. Hermode Tuning takes this into
consideration (see page 128).

Historical Tunings

In the course of the history of musical instruments there were numerous attempts to
improve the tuning of instruments. This tuning problem was particularly pressing with
keyboard instruments as their intonation cannot be corrected during playing. Historical
tunings are working from a static tuning scale where each note of the scale has a fixed
pitch. There are twelve-part scales that correspond to a normal keyboard, and extended
enharmonic scales that differentiate between sharps and flats. The latter can really only
be accessed via the computer, although there have been instruments with split black
keys in the past.

Pitch Display
Pitch can be shown in cent or as frequency ratio.

• Frequency ratios are of special interest for natural harmonic tunings, where the
intervals are determined by integral ratios. The reference note is defined as 1:1,
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the octave as 2:1. The higher note has double the frequency of the lower note.
To add or subtract intervals you need to multiply or divide the frequencies.

• The cent display runs linear with our sense of pitch and is useful to compare dif-
ferent tunings or intervals. The reference note is defined as 0 and the octave as
1200. An equal-tempered half step step is equal to exactly 100 cent. To add or
subtract intervals you need to add or subtract the cent values.

Conversion of a frequency ratio to per value is achieved as follows:

cent value = 1200 * log(numerator / denominator) / log(2)

Conversion of cent value to frequency ratio is achieved as follows:

frequency ratio = 2^ (cent value / 1200)

There is no explicit solution to further break apart the frequency ratio into numerator
and denominator. capella-tune achieves the best result by trial and error.

TONE OF REFERENCE: Here you select which tone of the scale should be assigned the 1:1 or 0
cent pitch. Only the display is changed, not the tuning. This feature can help to read out
certain intervals within the scale.

Tuning Scale

The display of the tuning scale offers several features:

• Each tone is represented by a blue box. The pitch is indicated both by numbers
(cent or frequency ratio) and by the horizontal position of the box. In the back-
ground you see a piano keyboard for orientation.

• If flats and sharps are distinguished (depending on the mode, see below) the nat-
ural tones are displayed in the middle line, the sharps are displayed above and
the flats below.

• Depending on the mode (see below) the pitch of the tones can be edited directly
in the blue boxes. Simply click the numbers. 

• To play back a tone click the blue box (but not the numbers). The tone will sound
until you click it again. The default sound will be used which is selected on the
tab OUTPUT DEVICES.

• You can control the display size by the zoom slider on the bottom right side.
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Mode

There are different ways to define the tuning scale. The methods might be differently
suited for certain tunings, although sometimes several methods lead to the same tun-
ing.

Twelve-Part Piano Scale

There are twelve steps per octave, as on a piano keyboard. Sharps and flats are not dis-
tinguished. Each of the twelve steps can be freely edited. Under RELATION TO KEY SIGNATURE

you find the following options:

IGNORE KEY SIGNATURE: This setting corresponds to a piano. The tones have a fixed tuning, re-
gardless of which key you play in. Therefore the different keys can acquire different
characteristics depending on the tuning. 

ADAPT TUNING TO WRITTEN KEY SIGNATURE: This setting will provide the following scenario: A trum-
peter plays a c-Major piece on a c-trumpet and a b-Major piece on a b-trumpet. Util-
izing the natural harmonic tuning, in the first case the interval c – e will produce a
pure Major third, in the second case an interval b – d.

ADAPT TUNING TO SOUNDING KEY SIGNATURE: The same as above, but in case of transposing instru-
ments the sounding key is used rather than the key signature written in the (trans-
posed) score.

The  TRIAL KEY SIGNATURE is  used for testing in the dialog and does not affect the tuning
definition.

Examples can be found in the profiles  under  TWELVE-PART SCALES WITH MODIFIED FIFTHS and
TWELVE-PART SELECTIONS.

Calculate by Accidentals

The diatonic (natural) tones can be freely edited.

MAKE ACCIDENTAL EQUIDISTANT: With this options sharps and flats alter by the same amount but
in opposite directions. Without this option you can specify the alteration individually
for each type of accidental.

UNIFORM FOR ALL SCALE DEGREES:  With this option the intervals c – c#, d – d#, e – e# etc. are
equal. Without this option you can specify the alteration individually for each tone.

Calculate by Fifths

All tones are calculated by stacked fifths mapped back into the original octave. Only the
size of the fifth can be edited, not the individual tones. 

Examples can be found in the profiles under EQUALTEMPERED SCALES and JUST INTERVALS.
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Hermode Tuning

The intonation of individual notes is automatically optimized to match the musical con-
text. Therefore there is no static tuning scale and the values displayed in the scale are of
no relevance. Only if you click several tones to create a chord, or if you play back a
capella score while the capella-tune dialog is opened, you can watch how the individual
tones are adjusted in pitch.

Hermode Tuning usually provides the best sounding results. The method fits the tech-
nique of good musicians with instruments without any intonation restrictions. You can
select from the following variants:

• STRICT:  Thirds and fifths are dynamically tuned. The re-tuning of sustained notes
may be audible.

• CLASSIC: Thirds and fifths are dynamically tuned. The purity is reduced in case the
re-tuning of sustained notes would be clearly audible.

• BAROQUE:  Thirds and fifths are dynamically tuned. Chords near to the harmonic
center will be set to a higher purity than chords with more distance to this cen-
ter. Recommended for polyphonic music.

• POP/JAZZ: Thirds, fifths and natural sevenths are dynamically tuned. The re-tuning
of sustained notes may be audible. The natural seventh is mainly used in Jazz. As
it differs substantially from the equal tempered seventh, this tuning is less suited
for polyphonic music.

A slider is provided for adjusting the  PURITY. 100% means full purity, 0% means equal-
tempered tuning.

If INCLUDE MUTE VOICES is selected, all voices of the score form the harmonic context, even if
you play back only a single voice.

Absolute Tuning

This option allows you to shift the entire scale up or down. You can either enter the fre-
quency for concert pitch, e. g. 430Hz, or an interval that sets the tuning relative to the
standard concert pitch of 440Hz. 

If TONE OF REFERENCE is set to CURRENT A then indeed the tone A is kept on the desired abso-
lute pitch. Changing the A in the tuning scale will  leave the A on the same absolute
pitch and adjust all other tones. 

If TONE OF REFERENCE is set to EQUAL TEMPERED A the absolute tuning changes at first the origin of
the tuning scale, i.e. the C. Then the A is calculated according to the tuning scale and
might end up on a different pitch than specified formally as concert pitch.
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Preset Profiles on Tunings Tab

Open the PROFILES drop-down list to load one of the numerous preset tunings. 

Click ORGANIZE... to open a menu with options to create and administer your own tunings.

Click APPLY to save your changes of the current tab. If you have modified a standard tun-
ing a new tuninge will be created with the addition “(modified)” in the name. To return
to the previous state click ORGANIZE → RESET TO PREVIOUS STATE.

Click  OK to save the current settings on all tabs, or click  CANCEL to dismiss all changes
that have not yet been saved.

MIDI Options

capella-tune  dialog, Tab  MIDI OPTIONS

General
DON'T TRANSPOSE PERCUSSION: Percussion voices are usually not transposed since the pitch has

no melodic meaning but defines the percussion instrument in the MIDI percussion
channel. Deactivate this option if you nevertheless want to use the transposition
given in the System Template to shift the standard instrument assignment in the
MIDI percussion channel. This procedure is not recommended. Better use the sound
maps in the capella System Template.

DETERMINE VOLUME FROM: The following parameters can be taken into account for calculating
the MIDI volume:
• CAPELLA BASIC VOLUME: This parameter is set in the main program, e. g. in capella un-

der EXTRAS → OPTIONS → SOUND → OUTPUT. 

• SYSTEM TEMPLATE: With the volume setting in the System Template of a capella score
you can balance the volume between voices of the score.

• TAB INSTRUMENTS, COLUMN VOL%: With this  capella-tune setting you can globally bal-
ance the volume between certain instruments for all capella scores.

• PLUG-IN CONFIGURATION FILE (*_CAPTUNE.INI): With the volume setting in the plug-in config-
uration file (cf. page 132) you can balance the volume of instruments and articu-
lation sounds within a VST sound library.

MIDI File Export

Assignment of capella voices to MIDI tracks
COMBINE VOICES OF THE SAME INSTRUMENT: Some instruments need two staves in the score (e. g.

piano and harp) while in other cases two instruments share the same staff (e. g.
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trumpet 1 and 2). Which kind of notation is used for which instrument can be spe-
cified on the tab INSTRUMENTS under NOTATION RANGE (second column), see  page 110. Ac-
cording to these settings  capella-tune determines which physical  instruments are
described by the score. MIDI channels and VST instances are allocated per physical
instrument rather than per capella voice, ensuring optimal playback results without
allocating more resources than necessary. In a similar way separate MIDI tracks are
created in the MIDI file for each physical instrument. With this option and the op-
tion below you can enforce a different track allocation mode.

SEPARATE LEFT AND RIGHT HAND PIANO STAVES: If only the audible result is important, it makes sense
to combine left  and right  hand of  a piano score to a single track,  cf.  paragraph
above. However, the information about the hand splitting is lost. Activate this option
if you want to import the MIDI file e. g. into another music notation program. 

Lyrics
SAVE LYRICS: With this option you turn the lyrics export on and off. 
END OF WORD / END OF SYLLABLE / SYLLABLE CONTINUATION CHARACTER: You can specify whether blank

characters  should be appended to word ends or  whether  syllables within words
should be hyphenated.

EVENT ORDER: You can specify whether the lyrics event precedes or succeeds the note-on
event in the MIDI file. In any case they have the same temporal position.

VERSE: You can select a particular lyrics verse for the MIDI export. The default setting is
NEXT NONEMPTY VERSE, meaning that the first verse is used for the first pass, the second
verse for the repeat etc. Empty verses are skipped, since they are sometimes used in
capella for alignment purposes.

Miscellaneous
CODE PAGE: MIDI files can contain only 8 bit characters. If you use foreign language text

like Greek or Russian you have to specify the appropriate code page. It is used for all
text elements (voice IDs, device and sound names, lyrics). 

SAVE SOUND AND DEVICE NAMES:  Sound and device names can be saved by the MIDI meta
events 08 and 09 respectively. This way you can always check which device and in-
strument a MIDI track has been optimized for.  Some older programs don't know
these meta events and cannot deal with such files. In this case you should deactiv-
ate this option. 

NOTE LENGTH: Notes are normally not fully sustained but shortened according to their ar-
ticulation. If you re-import such MIDI files into another program, a staccato played
crochet can easily be recognized as an eighth. Therefore, select  SUSTAIN in order to
preserve the full note values. 

PERCUSSION PITCH:  Let's  assume you have a  triangle  tone in the percussion voice  of  a
capella score. In the simplest case the tone is directly written with the pitch a'' as
this pitch creates the sound of a triangle in the percussion channel of a MIDI sound
card. If you play back the score with a VST sound library the note-on command is
not sent to the MIDI sound card but to the VST plug-in for the triangle sound. This
plug-in might expect a note-on command with a different pitch. E. g. the triangle
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plug-in of the capella Vienna orchestra requires a note-on command with the pitch
c'. This is defined in the plug-in configuration file and is automatically taken into ac-
count during playback. However, in the case of MIDI file export it is up to you to de-
cide which pitch is written into the file.
• ACCORDING TO MIDI PERCUSSION CHANNEL: The MIDI file is General MIDI compliant. In the

above example the tone is saved as a'' and can still be identified as a triangle.
• ACCORDING TO PLUG-IN CONFIGURATION: The MIDI events for the percussion instruments are

optimized for the VST plug-ins selected in capella and the file can be used in a
sequencer program that uses the same plug-ins.  

Preset Profiles for MIDI Options Tab

Open the PROFILES drop-down list to load one of the preset profiles. 

Click ORGANIZE... to open a menu with options to create and administer your own profiles.

Click APPLY to save your changes of the current tab. If you have modified a standard pro-
file, a new profile will be created with the addition “(modified)” in the profile name. To
return to the previous state click ORGANIZE → RESET TO PREVIOUS STATE.

Click  OK to save the current settings on all tabs, or click  CANCEL to dismiss all changes
that have not yet been saved.

VST Plug-ins and Soundfonts

capella-tune can use Soundfonts and VST plug-ins for playback. Both are denoted as
“plug-ins” and count as  “playback  devices”  equivalent  to MIDI devices.  They create
sound waves which are played back over the wave out device of the computer. Both
sound quality and the variety of instruments depend on the plug-in and are independ-
ent of the computer's MIDI synthesizer. Plug-ins can be quite demanding as CPU power,
memory size and hard drive speed are concerned.

VST stands for  Virtual  Studio Technology,  was developed by Steinberg® and is a re-
gistered trademark of Media Technologies GmbH. VST is a widespread standard for the
creation and filtering of wave sounds. A VST system consists of a host – in our case
capella-tune – and a number of plug-ins, for example capella Vienna orchestra. There
are basically two different types of VST plug-ins:

• Virtual Instruments (VIs): These receive MIDI instructions from the host and sup-
ply wave sounds in return. These wave sounds can then be forwarded to the
sound card or saved in a file. VIs can calculate the sound synthetically or utilize
recordings of true instruments (sample libraries).

• Effects: These follow the virtual instruments and can further modify the wave
sounds, e. g. add echo.
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Soundfonts are sample libraries in a certain open file format (*.sf2).  capella-tune uses
the open source synthesizer fluidsynth to transform Soundfonts into sound.

Configure Plug-ins

capella-tune dialog, tab PLAYBACK DEVICES, button CONFIGURE...

Why configure? The extent of functionality of virtual instruments can vary considerably.
Some plug-ins specialize in just one instrument while others offer a full range of instru-
ments including articulations, like capella Vienna orchestra does. Unfortunately there is
no common standard to describe the extent of sounds of a given plug-in. This is the
reason why capella-tune requires a configuration file that describes which sounds can
be generated and which MIDI and VST instructions are used to activate these sounds.

NB: capella Vienna orchestra is already fully configured for capella-tune. 

NB: capella-tune can look into Soundfonts and automatically determine the names of the sounds and
the required MIDI program and bank numbers to activate them. If the sounds correspond to the Gen-
eral MIDI instruments no further configuration is necessary. Otherwise it is recommended to structure
and classify the sounds, see below.

➔ Outline of the dialog

DEVICE: Select the plug-in you want to configure.
SOUND: The instruments contained in the plug-in.
GENERAL SETTINGS: Various parameters which affect all sounds.
SETTINGS FOR THE SOUND …: Various parameters for the currently selected sound.
➔ How to structure the sounds

• The list Sound shows all sounds in the arrangement that is used later on in the
device's sound selection menu. Open the context menu (right mouse click) to re-
arrange elements, insert new elements and sub-elements etc. 

• Each element without sub-element defines a sound. Its settings can be edited in
the lower right list. The name of each sound should be unique within the device.

• If a new element is created the settings of the previously selected element will
be copied into the new one. Therefore, if you create many new elements, you
should at first complete the configuration of the first element and then use it as
template for the other ones.  

• The individual articulations of an instrument are formally independent sounds.
However,  capella-tune assumes  that  switching  between  articulation  does  not
raise time consuming reloading of samples. Therefore the parameters  PROGRAM,
BANK, VST CHUNKFILE and VST PROGRAM should be the same for all articulations of an in-
strument.
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➔ How to edit settings

• The list on the top right shows settings which are relevant for all sounds. The list
on the bottom right shows settings for the sound that is selected in the list on
the left.

• The column  PARAMETER shows only parameters that are actually used. Open the
context menu (right mouse click) and the sub-menu ADD in order to see the com-
plete list of available parameters. Some parameters can be added only once (e.g.
VOLUME) while others can be added several times (e.g. CONTROLLER).

• The column VALUE shows the parameter's current value. Open the context menu
(right mouse click) to change it.

➔ How to classify the sounds

• capella-tune needs to know which sound represents which instrument. Other-
wise it cannot find suitable sounds for the instruments given in a capella score.
Therefore you should set one of the two following parameters to a meaningful
value.

• With USAGE (MIDI) you describe the sound by specifying an instrument from the
General MIDI standard. This standard contains only a limited selection of instru-
ments  and is  therefore  not  always  applicable.  You can specify  several  instru-
ments by adding the parameter several times. 

• With GENERIC SOUND ID you describe the sound using capella's own sound classifica-
tion. It is based on a tree-like scheme where all instruments can be sorted ac-
cording to their sound. Using this scheme capella-tune can even find a good sub-
stitution in case the desired instrument is not exactly available.

All parameters are described in detail in the technical documentation captune-VST-
config.pdf.

➔ How to configure a plug-in that provides a control dialog

1. Select the plug-in under DEVICE. If it is missing in the list you have to register it
first, see page 107.

2. Select  LOADED PLUG-INS → OPEN NEW INSTANCE. The plug-in is loaded and its control
dialog pops up.

3. Select an instrument in the plug-in's control dialog, e.g. a violin.

4. Create a new sound element for the violin as described before, see → How to
structure sounds.

5. Add the parameter VST chunk file to the violin's settings, see → How to edit
settings.
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6. Right-click the column VALUE next to the parameter VST CHUNK FILE. In the context
menu select  CREATE NEW CHUNK FILE. Type in a meaningful file name, e.g. “viol-
in.chunk” and click  SAVE.  Now all  settings from the control dialog have been
saved to this file. Later on these settings can be reloaded automatically with no
need to open the control dialog. 

7. Classify the sound as described before.

8. Repeat steps 3. to 7. for all instruments of the sample library.

➔  How to modify a chunk file

1. Select the plug-in under DEVICE. 

2. Select  LOADED PLUG-INS → OPEN NEW INSTANCE. The plug-in is loaded and its control
dialog pops up.

3. Select your sound in the dialog CONFIGURE PLUG-IN.

4. Right-click the column VALUE next to the parameter VST CHUNK FILE. In the context
menu select CREATE NEW LOAD CHUNK FILE INTO PLUG-IN.

5. Carry out your modifications in the plug-in dialog.

6. In the context menu just mentioned select OVERWRITE LOAD CHUNK NOW.

➔ How to configure a plug-in without control dialog

The same principles as before apply, but you cannot create your own chunk file. You re-
quire detailed documentation from the publisher  about which parameters  or which
chunk files activate the individual sounds. Set the required parameters for each sound
as described above.
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Import and export data

tonica file format

The preferred file format used to save all properties of a current tonica file is tca. tonica
is also able to read, play and print the older formats from version 3.0.

The current version 13 adds some extensions to the file format which are not known in
older tonica versions and therefore can not be represented. If you open new files in an
older tonica version they may not be represented correctly. Remember this when shar-
ing files with other tonica users. It is best if all users exchanging scores work with the
same – current – version.

capella file format

tonica imports scores in the capella file format CapXML (capx). You can either open the
capx file directly or extract individual voices from the capx file into a tonica score tem-
plate.

tonica exports scores in the capella file format CapXML 3.0. This way you can read ton-
ica files in the capella reader or continue editing them in capella.

capella import

Select  FILE → OPEN… to open a file  in capx format.  In the dialog select  the file  type
„capella (*.capx)” to filter the view showing only capx files.

Select FILE → IMPORT… to import voices from a file in capx format. In the dialog select a
template  into which you want  to  import  the voices.  Then  assign  the  voices  in  the
capella file to voices of the template. Choose „none“ as a tonica voice to mark voices
which you do not want to import.

capella export

To export a tonica score in capx format, activate the window of the score to be ex-
ported, select FILE→ EXPORT... and choose the file type „capella (*.capx)“ in the dialog.

Important: Always save your scores in tonica format! This is because of the compromises that have to
be made during conversion to capXML!



tonica fugata 13136 

MusicXML

MusicXML is an open file format for exchanging scores in modern Western music nota-
tion. During the last years it has been continuously supported as an exchange format by
several well known notation programs, and also tonica constantly improves export and
import. This allows you to open and edit tonica files in all notation programs supporting
MusicXML.

MusicXML export

To export a tonica score in MusicXML format, activate the window of the score to be ex-
ported, select FILE→ EXPORT... and choose the file type „MusicXML (*.xml)“ in the dialog.

Important: Always save your scores in tonica format! This is because of the compromises that have to
be made during conversion to MusicXML!

MIDI files

MIDI (Musical Instruments Digital Interface) is a widespread communication protocol
with which notes can be transferred between electronic music instruments and saved
in files.

The common file ending for MIDI files is .mid. In the MIDI formats you can import notes
from many notation and sequencer programs. However, all attributes of notation be-
yond the pure pitch information will get lost.

MIDI import

To import a file in MIDI format 1 or in MIDI format 0, select FILE → OPEN... In the dialog
box you can select the preferred file format and thus filter display so that only MIDI files
will be displayed.

MIDI export

To convert a  tonica file to MIDI format 1, activate the window with the file to be ex-
ported and select FILE → EXPORT.... Select file format: MIDI. If needed, select under which
name and to which directory the file is to be saved. During export repeats and voltas
are considered.

Options

Basically all options concerning playback also have an influence on sound and MIDI ex-
port. For MIDI files there are some additional options, see page 129.
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With the MIDI options button you switch to  capella-tune to determine all important
properties of the MIDI file to be created:

• Volume and attack intensity: See page 110 and page 114.

• Tone lengths: See page 114.

• Output device: Some VST sample libraries (e. g. capella Vienna orchestra) re-
quire specific MIDI controllers and percussion sound maps in order to acti-
vate the correct sounds. These controllers and sound maps are stored with
the MIDI file if you selected the sample library as output device (see  page
110). Such MIDI files are meant to be further edited in a sequencer with the
same sample library. If you want to create a MIDI file for general use you
should first set the Microsoft MIDI Mapper as your playback device.

• Split and join voices: 
Open the  capella-tune dialog box (ÁÍ ÍÔÍ É+ÁÍ ÍãÍ É+ÁÍJÉ)  and select the  Instruments
tab. In the column „Extent of notation“, open the context menu (right mouse
button) and select which voices are to be combined in a MIDI track. You can re-
peat this action for each MIDI instrument separately. This allows you, for exam-
ple, to split a two part trumpet staff into two separate tracks, while at the same
time combining all left-hand or right-hand piano voices – or even both hands –
into one track.

• More MIDI options: Depending on the desired use of the MIDI file more details
might possibly be of interest. These can be set in the tab MIDI options, see page
129.

When you are electronically exchanging music with other musicians, please do not forget that you can
always make the capella file directly available to them. With the free capella reader software the recip-
ient can listen to the score and – contrary to MIDI – also view and print it!
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Special functions

Automatic installation (network)

Being a network administrator you have the option to automate the installation of ton-
ica (without installer surface). Enter the following lines in a terminal:

Windows computer:

tonica_fugata_13-un-installer.exe silent=on

Mac computer:

1. Integrate DMG:

hdiutil attach -nobrowse tonica_fugata_13-un-installer.dmg

2. Run installer:

open /Volumes/tonica_fugata_13-un-installer/tonica_fugata_13-un-
installer.app --args silent=on

3. Remove DMG:

hdiutil detach /Volumes/tonica_fugata_13-un-installer/

If you want to install the CodeMeter version of tonica state „codemeter=on“ as an addi-
tion to „silent=on“. In this case tonica will install the CodeMeter support itself; you will
have to take care yourself for the installation of CodeMeter User Runtime (contrary to
non silent installation). After silent installation the CodeMeter User Runtime installer
will be available in the tonica installation directory (or in the Apple Bundle).

Automatic Uninstalling can also be done: Start the setup module in the installation di-
rectory (or in the Apple Bundle) with the parameter „action=uninstall“.
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Figured bass notation
The figured bass is a musical notation that has emerged in Baroque music. A bass-line
(bass voice) with added numbers is notated to which improvised chords were supple-
mented. Figured bass instruments were the harpsichord, organ, lute, theorbe, etc., to-
gether with a gamba, cello, double bass, bassoon or trombone playing the bass voice.

The numbers and accidentals beneath the bass voice indicate what intervals above the
bass notes should be played. Above each bass note without numbers a full diatonic
triad in root position is played. Chord notes can be doubled or played in another octave.
Common voice-leading rules apply for realizing the chords.

tonica automatically creates full chord realizations of figured basses. Chords are gener-
ally realized in close position which allows bass notes to be played with the left hand
and added chord notes with the right hand on keyboard instruments. Individually tied
chord notes result in a smooth composition which can be accompanied by a melody
voice.

Figured bass realization in tonica

The rules of figured bass notation have changed over the centuries. Even today differ-
ent ways of writing figured basses are taught. The following figure shows some exam-
ples of figures and their realization in tonica.
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The following rules apply for numberings in tonica:

• Numbers from 0 to 14 are allowed. Number 0 means "tasto solo" (no chord).
You can enter up to 3 numbers for each chord. Third (3) and fifth (5) must not
be notated but are added automatically. Example: Bass note c of first chord in
the above figure is supplemented by third (e) and fifth (g). In addition the so-
prano voice doubles the fundamental note c.

• Numbers greater than 7 are interpreted as  chord positions, i.e. they refer to
chord  notes  in  the  upper  voices  (soprano and alto  voice).  tonica considers
these chord positions during figured bass realization if they do not result in
voice-leading errors. Example: The numbering (11 9) in the figure means that
the added notes (eleventh f and ninth d) should appear in the soprano and alto
voice respectively. In the following chord with numbering (10 8) these notes
are resolved into notes e and c.

• The following replacement rule applies: If number 4 is notated, number 3 must
be notated explicitly to be considered as a chord note. If number 6 is notated,
number 5 must be notated explicitly to be considered as a chord note. Exam-
ple: In the chord with numbering (6 4) number 4 replaces 3 and number 6 re-
places 5. Therefore the third (e) and the fifth (g) do not appear.
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• The following completion rule applies: If number 2 is notated, it will be auto-
matically supplemented by numbers 4 and 6. If numbers 2 and 4 are notated,
number 6 will be supplemented (third inversion). If numbers 3 and 4 are no-
tated, number 6 will be supplemented (second inversion). Example: The first
chord with number 2 includes the second (d) but also the fourth (f) and the
sixth (a).

• All accidentals (bb, b, #, x, natural) and "+" are allowed to notate alterations.
Except for  natural,  accidentals  are interpreted  relative to  the key,  e.g.  they
raise or lower a diatonic note by one or two semitones. Like "#", a "+" raises a
diatonic note by a semitone. Example: In the chord with numbering (4+ 2), the
fourth (f) is raised by a semitone (f sharp).

• If an alteration without a number is notated, number 3 is added. Example: In
the second chord with numbering "b", the third (e) is lowered by a semitone (e
flat).

• To realize a bass note with no chord or no chord change, "0" or "-" are notated.
Example: In the above figure the last 4 bass notes are not supplemented by
chord notes because of numbering "0" and "-".

• A "/" sign indicates a chord anticipation of a following bass note. Example: The
chord with numbering "/" anticipates the added chord notes of the following
chord (b, d, and f).
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Tables and charts

Keyboard shortcuts

It is a condition for the function of the following keyboard shortcuts that they are not
already reserved for a different function by the macOS system.

Some keys do not exist on some mac types and will have to be executed by replace-
ment keyboard shortcuts.

The function keys ÁÍFÍ1É, …, ÁÍFÍ1Í2É work – depending on system setting – either directly or
by additionally pressing down the  ÁÍfÍnÉ key.

The following tables proceed from a direct operation of the function keys.

If needed, you can deactivate or redefine colliding shortcuts for system functions in the
system. We recommend that you use these options cautiously.
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Function keys

Depending on the setting of  function keys in the system the  ÁÍfÍnÉ key must also  be
pressed.

Key only ÁÍ ÍÔÍ É ÁÍ ÍãÍ É ÁÍ ÍÔÍ É+ÁÍ ÍãÍ É ÁÍ ÍäÍ É

ÁÍFÍ1É

ÁÍFÍ2É Note entry one 
octave lower

Note entry two
octaves lower

ÁÍFÍ3É Normal note en-
try

ÁÍFÍ4É Note entry one 
octave higher

Note entry two
octaves higher

Close window 
(score)

ÁÍFÍ5É Compose score

ÁÍFÍ6É Compose varia-
tion

ÁÍFÍ7É

ÁÍFÍ8É

ÁÍFÍ9É Solo playback Rhythmic 
playing in

ÁÍFÍ1Í0É Join beams Split beams

ÁÍFÍ1Í1É Show/hide 
note entry (in-
cluding mouse
piano)

ÁÍFÍ1Í2É

Letter keys

with ÁÍ ÍãÍ É with ÁÍ ÍÔÍ É+ ÁÍ ÍãÍ É with ÁÍ ÍÔÍ É+ÁÍ ÍäÍ É
ÁÍAÉ Mark all Mark entire system tem-

plate staff
ÁÍBÉ

ÁÍCÉ Copy
ÁÍDÉ Mark system Mark voice
ÁÍEÉ Preferences
ÁÍFÉ Set fermata
ÁÍGÉ

ÁÍHÉ Set tie Delete tie
ÁÍIÉ Work mode
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ÁÍJÉ Sound configuration
ÁÍKÉ

ÁÍLÉ Harmony Modulation
ÁÍMÉ System template Fold out system template
ÁÍNÉ New score
ÁÍOÉ Open
ÁÍPÉ Print
ÁÍQÉ

ÁÍRÉ Create triplet Delete triplet
ÁÍSÉ Save
ÁÍTÉ Tempo
ÁÍUÉ Composition assis-

tant
ÁÍVÉ Paste
ÁÍWÉ Close score
ÁÍXÉ Cut
ÁÍYÉ

ÁÍZÉ Undo Redo

Combinations with letter keys

While holding down the letter key also press down one of the keys in the second col-
umn. The shortcuts relate to the note to the right of the cursor. Pressing ÁÍ0É resets to
the standard attribute.

As long as you hold down the letter key all additionally pressed keys are interpreted as
one single command. For example when you select  EDIT →UNDO afterwards all  partial
commands will be undone in one go.

ÁÍOÉ ÁÍôÉ, ÁÍèÉ, 
ÁÍûÉ, ÁÍéÉ

Shift note/chord diatonically (single step/octave)

ÁÍPÉ ÁÍôÉ, ÁÍèÉ, 
ÁÍûÉ, ÁÍéÉ

Shift note/chord chromatically (single step/octave)

Number combinations

ÁÍ ÍãÍ É+ÁÍ1É Mode Setup

ÁÍ ÍãÍ É+ÁÍ2É Mode 
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Keyboard shortcuts for note entry

To  set  the  current  note  value choose  one  of  the  two  patterns  in  TONICA FUGATA →
PREFERENCES... → NOTE ENTRY:

Note value 1/1 1/2 1/4 1/8 1/16

Normal ÁÍ1É ÁÍ2É ÁÍ4É ÁÍ8É ÁÍ6É

Alternative
(useful for visually impaired users)

ÁÍ1É ÁÍ2É ÁÍ3É ÁÍ4É ÁÍ5É

For  Note Entry choose one of the following patterns in TONICA FUGATA → PREFERENCES... →
NOTE ENTRY:

Notes of the octave Alternative  shortcuts  for

ÁÍ.É

German ÁÍCÉ, ÁÍDÉ, ÁÍEÉ, ÁÍFÉ, ÁÍGÉ, ÁÍAÉ, ÁÍHÉ ÁÍQÉ, ÁÍWÉ, ÁÍRÉ, ÁÍTÉ

International ÁÍCÉ, ÁÍDÉ, ÁÍEÉ, ÁÍFÉ, ÁÍGÉ, ÁÍAÉ, ÁÍBÉ ÁÍQÉ, ÁÍWÉ, ÁÍRÉ, ÁÍTÉ

Romanic ÁÍDÉ, ÁÍRÉ, ÁÍMÉ, ÁÍFÉ, ÁÍSÉ, ÁÍLÉ, ÁÍTÉ ÁÍAÉ, ÁÍQÉ, ÁÍZÉ, ÁÍEÉ

linear 1 (German) ÁÍQÉ, ÁÍWÉ, ÁÍEÉ, ÁÍRÉ, ÁÍTÉ, ÁÍZÉ, ÁÍUÉ ÁÍAÉ, ÁÍSÉ, ÁÍDÉ, ÁÍFÉ

linear 2 (English) ÁÍQÉ, ÁÍWÉ, ÁÍEÉ, ÁÍRÉ, ÁÍTÉ, ÁÍYÉ, ÁÍUÉ ÁÍAÉ, ÁÍSÉ, ÁÍDÉ, ÁÍFÉ

linear 3 (French) ÁÍAÉ, ÁÍZÉ, ÁÍEÉ, ÁÍRÉ, ÁÍTÉ, ÁÍYÉ, ÁÍUÉ ÁÍQÉ, ÁÍSÉ, ÁÍDÉ, ÁÍFÉ

Rest ÁÍSÍpÍaÍcÍeÉ

The octave in which the notes are entered depends on the clef and any deviation from
the normal octave (see function keys ÁÍFÍ2É to ÁÍFÍ4É). Use in combination with ÁÍ ÍÔÍ É to no-
tate  one  octave  higher  or  lower  depending  on  the  preferences  in  TONICA FUGATA →
PREFERENCES... → NOTE ENTRY.
The alternative commands in the right column can be used for single-handed entry,
for example during playing in from the MIDI keyboard. This enables the user to enter
note values (best with the alternative pattern) and dottings with one hand without hav-
ing to move the second hand from the MIDI keyboard.  The meaning of these com-
mands is explained below in the Additional keyboard shortcuts table.
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Cursor movement and scrolling

Key Effect

ÁÍâÉ One note to the left

ÁÍêÉ One note to the right

ÁÍ ÍäÍ É+ÁÍâÉ To next barline to the left

ÁÍ ÍäÍ É+ÁÍêÉ To next barline to the right

ÁÍ ÍãÍ É+ÁÍâÉ To beginning of staff

ÁÍ ÍãÍ É+ÁÍêÉ To end of staff

ÁÍôÉ To next voice up

ÁÍûÉ To next voice down

ÁÍ ÍäÍ É+ÁÍôÉ To corresponding voice in neighboring system above

ÁÍ ÍäÍ É+ÁÍûÉ To corresponding voice in neighboring system below

ÁÍèÉ Scroll up by 3/4 window height. In mode „animated page turn-
ing“ with zoom set to “whole page” the previous full page is dis-
played.

ÁÍéÉ Scroll down by 3/4 window height. In mode „animated page 
turning“ with zoom set to “whole page” the next full page is dis-
played.

ÁÍ ÍãÍ É+ÁÍèÉ Previous page

ÁÍ ÍãÍ É+ÁÍéÉ Next page

ÁÍcÍtÍrÍlÉ + ÁÍæÉ Scroll to beginning of score

ÁÍcÍtÍrÍlÉ + ÁÍçÉ Scroll to end of score

All keyboard shortcuts to scroll will  reposition the cursor. Scrolling with the scrollbar
does not reposition the cursor (it will therefore scroll out of the window).

Additional keyboard shortcuts

Key Effect

ÁÍ ÍãÍ É+ÁÍ?É Help
ÁÍÊÉ Reformat score into systems
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ÁÍ ÍãÍ É+ÁÍ ÍîÍ É Merge systems
ÁÍ ÍîÍ É Delete note or marked section to left of cursor
ÁÍëÉ Delete note or marked section to right of cursor
ÁÍ+É Increase pitch of next note
ÁÍ-É Decrease pitch of next note
ÁÍ*É Double increase pitch of next note
ÁÍ_É Double decrease pitch of next note
ÁÍ.É Next note dotted
ÁÍ0É Cancel alteration and dotting
ÁÍ/É Repeat note
ÁÍ=É Repeat note with tie
ÁÍ<É Reduce note values (marked notes or note to right of cursor)
ÁÍ>É Increase note values (marked notes or note to right of cursor)

Key Effect

ÁÍ ÍãÍ É+ÁÍ0É Zoom 100 %

ÁÍ ÍãÍ É+ÁÍ+É Enlarge zoom

ÁÍ ÍãÍ É+ÁÍ-É Reduce zoom
ÁÍ ÍäÍ É+ÁÍSÍpÍaÍcÍeÉ Start/Stop playback
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Credits
tonica fugata 13 uses the following software. Thank you!

Qt

The program is based on the excellent cross-platform library Qt (www.qt.io).

Qt is under the license LGPL 2.1, see www.gnu.org/copyleft/lesser.html.

OpenSSL

For  transmission  of  license  activation  data,  tonica uses  the  OpenSSL  toolkit
(http://www.openssl.org/). Thank you!

  LICENSE ISSUES
  ==============

  The OpenSSL toolkit stays under a dual license, i.e. both the conditions of
  the OpenSSL License and the original SSLeay license apply to the toolkit.
  See below for the actual license texts. Actually both licenses are BSD-style
  Open Source licenses. In case of any license issues related to OpenSSL
  please contact openssl-core@openssl.org.

  OpenSSL License
  ---------------

/* ====================================================================
 * Copyright (c) 1998-2011 The OpenSSL Project.  All rights reserved.
 *
 * Redistribution and use in source and binary forms, with or without
 * modification, are permitted provided that the following conditions
 * are met:
 *
 * 1. Redistributions of source code must retain the above copyright
 *    notice, this list of conditions and the following disclaimer. 
 *
 * 2. Redistributions in binary form must reproduce the above copyright
 *    notice, this list of conditions and the following disclaimer in
 *    the documentation and/or other materials provided with the

http://www.gnu.org/copyleft/lesser.html
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 *    distribution.
 *
 * 3. All advertising materials mentioning features or use of this
 *    software must display the following acknowledgment:
 *    "This product includes software developed by the OpenSSL Project
 *    for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
 *
 * 4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
 *    endorse or promote products derived from this software without
 *    prior written permission. For written permission, please contact
 *    openssl-core@openssl.org.
 *
 * 5. Products derived from this software may not be called "OpenSSL"
 *    nor may "OpenSSL" appear in their names without prior written
 *    permission of the OpenSSL Project.
 *
 * 6. Redistributions of any form whatsoever must retain the following
 *    acknowledgment:
 *    "This product includes software developed by the OpenSSL Project
 *    for use in the OpenSSL Toolkit (http://www.openssl.org/)"
 *
 * THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
 * EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
 * PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR
 * ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
 * SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
 * NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
 * LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
 * STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
 * ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
 * OF THE POSSIBILITY OF SUCH DAMAGE.
 * ====================================================================
 *
 * This product includes cryptographic software written by Eric Young
 * (eay@cryptsoft.com).  This product includes software written by Tim
 * Hudson (tjh@cryptsoft.com).
 *
 */

 Original SSLeay License
 -----------------------
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/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
 * All rights reserved.
 *
 * This package is an SSL implementation written
 * by Eric Young (eay@cryptsoft.com).
 * The implementation was written so as to conform with Netscapes SSL.
 * 
 * This library is free for commercial and non-commercial use as long as
 * the following conditions are aheared to.  The following conditions
 * apply to all code found in this distribution, be it the RC4, RSA,
 * lhash, DES, etc., code; not just the SSL code.  The SSL documentation
 * included with this distribution is covered by the same copyright terms
 * except that the holder is Tim Hudson (tjh@cryptsoft.com).
 * 
 * Copyright remains Eric Young's, and as such any Copyright notices in
 * the code are not to be removed.
 * If this package is used in a product, Eric Young should be given attribution
 * as the author of the parts of the library used.
 * This can be in the form of a textual message at program startup or
 * in documentation (online or textual) provided with the package.
 * 
 * Redistribution and use in source and binary forms, with or without
 * modification, are permitted provided that the following conditions
 * are met:
 * 1. Redistributions of source code must retain the copyright
 *    notice, this list of conditions and the following disclaimer.
 * 2. Redistributions in binary form must reproduce the above copyright
 *    notice, this list of conditions and the following disclaimer in the
 *    documentation and/or other materials provided with the distribution.
 * 3. All advertising materials mentioning features or use of this software
 *    must display the following acknowledgement:
 *    "This product includes cryptographic software written by
 *     Eric Young (eay@cryptsoft.com)"
 *    The word 'cryptographic' can be left out if the rouines from the library
 *    being used are not cryptographic related :-).
 * 4. If you include any Windows specific code (or a derivative thereof) from 
 *    the apps directory (application code) you must include an acknowledgement:
 *    "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"
 * 
 * THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
 * ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PUR-
POSE
 * ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
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 * FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
 *  DAMAGES  (INCLUDING,  BUT  NOT  LIMITED  TO,  PROCUREMENT  OF  SUBSTITUTE
GOODS
 * OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,  WHETHER IN CONTRACT,
STRICT
 * LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
 * OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
 * SUCH DAMAGE.
 * 
 * The licence and distribution terms for any publically available version or
 * derivative of this code cannot be changed.  i.e. this code cannot simply be
 * copied and put under another distribution licence
 * [including the GNU Public Licence.]
 */

Zlib

zlib.h -- interface of the 'zlib' general purpose compression library

version 1.2.8, April 28th, 2013

Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event
will the authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including com-
mercial applications, and to alter it and redistribute it freely, subject to the following re-
strictions:

1. The origin of this software must not be misrepresented; you must not claim that you
wrote the original software. If you use this software in a product, an acknowledgment
in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepre-
sented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly, jloup@gzip.org

Mark Adler, madler@alumni.caltech.edu

QuaZIP

Copyright (C) 2005-2012 Sergey A. Tachenov

mailto:madler@alumni.caltech.edu
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This program is free software; you can redistribute it and/or modify it under the terms
of the GNU Lesser General Public License as published by the Free Software Founda-
tion; either version 2 of the License, or (at your option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WAR-
RANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PAR-
TICULAR PURPOSE. See the GNU Lesser General Public License for more details.

You should have received a copy of the GNU Lesser General Public License along with
this program; if not, write to the Free Software Foundation, Inc., 59 Temple Place, Suite
330, Boston, MA 02111-1307 USA

See COPYING file for the full LGPL text.

Original ZIP package is copyrighted by Gilles Vollant, see quazip/(un)zip.h files for details,
basically it's zlib license.

XMLParser

XMLParser, Copyright (c) 2002, Frank Vanden Berghen (http://www.applied-mathemat-
ics.net/tools/xmlParser.html).

 * THIS SOFTWARE IS PROVIDED BY Frank Vanden Berghen ``AS IS'' AND ANY
 * EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
 * WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
 * DISCLAIMED. IN NO EVENT SHALL <copyright holder> BE LIABLE FOR ANY
 * DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
 * (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
 * LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
 * ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
 * (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
 * SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

SingleApplication
The MIT License (MIT)

Copyright (c) Itay Grudev 2015 - 2016

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL 
THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING 
FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Note: Some of the examples include code not distributed under the terms of the
MIT License.

rtf-qt

Copyright 2008, 2010 Brad Hards  <bradh@frogmouth.net>

This library is free software; you can redistribute it and/or modify it under the terms of
the GNU Lesser General Public License as published by the Free Software Foundation;
either version 2.1 of the License, or (at your option) any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY WAR-
RANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PAR-
TICULAR PURPOSE.  See the GNU Lesser General Public License for more details.

You should have received a copy of the GNU Lesser General Public License along with
this library.  If not, see <http://www.gnu.org/licenses/>.

libemf

Copyright 2008 Brad Hards  <bradh@frogmouth.net>

Copyright 2009 Inge Wallin <inge@lysator.liu.se>

This library is free software; you can redistribute it and/or modify it under the terms of
the GNU Lesser General Public License as published by the Free Software Foundation;
either version 2.1 of the License, or (at your option) any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY WAR-
RANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PAR-
TICULAR PURPOSE.  See the GNU Lesser General Public License for more details.

You should have received a copy of the GNU Lesser General Public License along with
this library.  If not, see <http://www.gnu.org/licenses/>.
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RtMidi

http://www.music.mcgill.ca/~gary/rtmidi

VST Plugin Technology

http://www.steinberg.net

FluidSynth

http://www.fluidsynth.org

PortAudio

PortAudio Portable Real-Time Audio Library

Copyright (c) 1999-2011 Ross Bencina and Phil Burk

Permission is hereby granted, free of charge, to any person obtaining a copy of this soft-
ware and associated documentation files (the "Software"), to deal in the Software with-
out restriction, including without limitation the rights to use, copy, modify, merge, pub-
lish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.

IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTH-
ERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE
USE OR OTHER DEALINGS IN THE SOFTWARE.

LAME

http://www.lame.sourceforge.net

DejaVu-Font

Fonts are (c) Bitstream (see below). DejaVu changes are in public domain.
Glyphs imported from Arev fonts are (c) Tavmjong Bah (see below)
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Bitstream Vera Fonts Copyright
------------------------------

Copyright (c) 2003 by Bitstream, Inc. All Rights Reserved. Bitstream Vera is
a trademark of Bitstream, Inc.

Permission is hereby granted, free of charge, to any person obtaining a copy
of the fonts accompanying this license ("Fonts") and associated
documentation files (the "Font Software"), to reproduce and distribute the
Font Software, including without limitation the rights to use, copy, merge,
publish, distribute, and/or sell copies of the Font Software, and to permit
persons to whom the Font Software is furnished to do so, subject to the
following conditions:

The above copyright and trademark notices and this permission notice shall
be included in all copies of one or more of the Font Software typefaces.

The Font Software may be modified, altered, or added to, and in particular
the designs of glyphs or characters in the Fonts may be modified and
additional glyphs or characters may be added to the Fonts, only if the fonts
are renamed to names not containing either the words "Bitstream" or the word
"Vera".

This License becomes null and void to the extent applicable to Fonts or Font
Software that has been modified and is distributed under the "Bitstream
Vera" names.

The Font Software may be sold as part of a larger software package but no
copy of one or more of the Font Software typefaces may be sold by itself.

THE FONT SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EX-
PRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF MERCHANTABIL-
ITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF COPYRIGHT, 
PATENT,
TRADEMARK, OR OTHER RIGHT. IN NO EVENT SHALL BITSTREAM OR THE GNOME
FOUNDATION BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, INCLUDING
ANY GENERAL, SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF
THE USE OR INABILITY TO USE THE FONT SOFTWARE OR FROM OTHER DEALINGS IN THE
FONT SOFTWARE.

Except as contained in this notice, the names of Gnome, the Gnome
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Foundation, and Bitstream Inc., shall not be used in advertising or
otherwise to promote the sale, use or other dealings in this Font Software
without prior written authorization from the Gnome Foundation or Bitstream
Inc., respectively. For further information, contact: fonts at gnome dot
org.

Arev Fonts Copyright
------------------------------

Copyright (c) 2006 by Tavmjong Bah. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining
a copy of the fonts accompanying this license ("Fonts") and
associated documentation files (the "Font Software"), to reproduce
and distribute the modifications to the Bitstream Vera Font Software,
including without limitation the rights to use, copy, merge, publish,
distribute, and/or sell copies of the Font Software, and to permit
persons to whom the Font Software is furnished to do so, subject to
the following conditions:

The above copyright and trademark notices and this permission notice
shall be included in all copies of one or more of the Font Software
typefaces.

The Font Software may be modified, altered, or added to, and in
particular the designs of glyphs or characters in the Fonts may be
modified and additional glyphs or characters may be added to the
Fonts, only if the fonts are renamed to names not containing either
the words "Tavmjong Bah" or the word "Arev".

This License becomes null and void to the extent applicable to Fonts
or Font Software that has been modified and is distributed under the 
"Tavmjong Bah Arev" names.

The Font Software may be sold as part of a larger software package but
no copy of one or more of the Font Software typefaces may be sold by
itself.

THE FONT SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT
OF COPYRIGHT, PATENT, TRADEMARK, OR OTHER RIGHT. IN NO EVENT SHALL
TAVMJONG BAH BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
INCLUDING ANY GENERAL, SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL



 157Credits

DAMAGES, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF THE USE OR INABILITY TO USE THE FONT SOFTWARE OR FROM
OTHER DEALINGS IN THE FONT SOFTWARE.

Except as contained in this notice, the name of Tavmjong Bah shall not
be used in advertising or otherwise to promote the sale, use or other
dealings in this Font Software without prior written authorization
from Tavmjong Bah. For further information, contact: tavmjong @ free
. fr.

TeX Gyre DJV Math
-----------------
Fonts are (c) Bitstream (see below). DejaVu changes are in public domain.

Math extensions done by B. Jackowski, P. Strzelczyk and P. Pianowski
(on behalf of TeX users groups) are in public domain.

Letters imported from Euler Fraktur from AMSfonts are (c) American
Mathematical Society (see below).
Bitstream Vera Fonts Copyright
Copyright (c) 2003 by Bitstream, Inc. All Rights Reserved. Bitstream Vera
is a trademark of Bitstream, Inc.

Permission is hereby granted, free of charge, to any person obtaining a copy
of the fonts accompanying this license (“Fonts”) and associated
documentation
files (the “Font Software”), to reproduce and distribute the Font Software,
including without limitation the rights to use, copy, merge, publish,
distribute,
and/or sell copies of the Font Software, and to permit persons  to whom
the Font Software is furnished to do so, subject to the following
conditions:

The above copyright and trademark notices and this permission notice
shall be
included in all copies of one or more of the Font Software typefaces.

The Font Software may be modified, altered, or added to, and in particular
the designs of glyphs or characters in the Fonts may be modified and
additional
glyphs or characters may be added to the Fonts, only if the fonts are
renamed
to names not containing either the words “Bitstream” or the word “Vera”.
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This License becomes null and void to the extent applicable to Fonts or
Font Software
that has been modified and is distributed under the “Bitstream Vera”
names.

The Font Software may be sold as part of a larger software package but
no copy
of one or more of the Font Software typefaces may be sold by itself.

THE FONT SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EX-
PRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF MERCHANTABIL-
ITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF COPYRIGHT, 
PATENT,
TRADEMARK, OR OTHER RIGHT. IN NO EVENT SHALL BITSTREAM OR THE GNOME
FOUNDATION
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, INCLUDING ANY GENERAL,
SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER IN AN
ACTION
OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF THE USE OR
INABILITY TO USE
THE FONT SOFTWARE OR FROM OTHER DEALINGS IN THE FONT SOFTWARE.
Except as contained in this notice, the names of GNOME, the GNOME
Foundation,
and Bitstream Inc., shall not be used in advertising or otherwise to promote
the sale, use or other dealings in this Font Software without prior written
authorization from the GNOME Foundation or Bitstream Inc., respectively.
For further information, contact: fonts at gnome dot org.

AMSFonts (v. 2.2) copyright

The PostScript Type 1 implementation of the AMSFonts produced by and
previously distributed by Blue Sky Research and Y&Y, Inc. are now freely
available for general use. This has been accomplished through the
cooperation
of a consortium of scientific publishers with Blue Sky Research and Y&Y.
Members of this consortium include:

Elsevier Science IBM Corporation Society for Industrial and Applied
Mathematics (SIAM) Springer-Verlag American Mathematical Society (AMS)

In order to assure the authenticity of these fonts, copyright will be
held by
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the American Mathematical Society. This is not meant to restrict in any way
the legitimate use of the fonts, such as (but not limited to) electronic
distribution of documents containing these fonts, inclusion of these fonts
into other public domain or commercial font collections or computer
applications, use of the outline data to create derivative fonts and/or
faces, etc. However, the AMS does require that the AMS copyright notice be
removed from any derivative versions of the fonts which have been altered in
any way. In addition, to ensure the fidelity of TeX documents using Computer
Modern fonts, Professor Donald Knuth, creator of the Computer Modern faces,
has requested that any alterations which yield different font metrics be
given a different name.
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